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Symbols and Conventions 9
About This Manual

This User’s Guide contains everything you need to know to work with this product. 
The first sections introduce the product and help you get started. The remaining 
chapters are organized by subject to help you find detailed information quickly when 
you need it. 

Symbols and Conventions
The following special symbols and conventions are used throughout this guide.

Names of keys on the keyboard are shown in small capital letters such as CTRL, 
ESC, and ENTER. Key combinations are shown as CTRL-C, ALT-F, and so on. 
Remember that keys may not be labeled exactly the same on your keyboard.
Menus and commands in menus are shown in a bold font such as File. 
Notes like the paragraph below provide additional information about the current 
topic. 

NOTE: This is a sample note. You will find notes throughout the manual to draw 
your attention to areas of special interest or concern. Often, a note will 
explain a special behavior that might not seem obvious.
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11

CHAPTER
1 INTRODUCTION 

UML (Unified Modeling Language) is a standardized visual diagramming language useful 
for designing and implementing many different aspects of complex systems. Armed with 
this software and a copy of the official UML language specification, you will be able to 
create all types of UML diagrams with ease. Your system design work, organization, and 
communication will benefit greatly. Consistency and uniformity is assured by the inclusion 
of templates for the most common UML diagram formats. Power and flexibility remain 
uncompromised as well, permitting you to create custom extensions and enhancements to 
share among your colleagues.

From a simple point of view, the software will assist you in creating diagrams with nodes 
(UML’s symbols and shapes), adding text and labels, and connecting nodes with paths 
(UML’s connecting lines). It will automatically maintain relationships between paths, 
nodes, and labels as you edit and enhance your diagram. By taking care of the tedious tasks, 
this software frees you to concentrate on developing your design rather than on the process 
of creating it. 
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13

CHAPTER
2 BASICS 

Before beginning you should acquaint yourself with a number of basic concepts. This 
chapter lays the foundation for understanding the diagram model and how to work with the 
tool. It introduces some terminology used throughout the software and this manual and 
answers some of the most frequently asked introductory questions about the diagramming 
package. It also introduces you to the different parts of the workspace and the different 
functional modes.

Using The Mouse
You should understand some very basic terminology of mouse usage. Here’s a quick 
review.

Cursor

The cursor, or more accurately the mouse cursor, is a small graphic image that indicates 
where on the screen the mouse is pointing. Different shapes for the mouse cursors indicate 
different actions that result when you click the mouse. The most common mouse cursors 
and their meanings are shown below. 

Clicking

You click the mouse (press and release a mouse button) to initiate an action, usually related 
to the current location of the cursor. The LEFT mouse button is used for nearly everything. 
We might say Click the mouse button where we mean Click the left mouse button. We’ll be 
explicit if we refer to any other button.

Standard Select Cursor
(selects objects)

Reshape Cursor
(reshapes nodes)

Move Cursor
(drag selected objects)

Create Node Cursor 
(add node of this shape)

Connect Cursor
(create a path)

Connect-to Cursor
(connect path to object)

Text Cursor “Caret”
(edit node/label text)

Connection Point Cursor
(set/move connection points)

Pivot Path Cursor
(move one end of a path)

Split Cursor 
(split a path, add junction)

Zoom Cursor
(zoom in or to an area)

Resize Cursor
(resize a node)
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14 Chapter 2: Basics
Dragging

Drag by pressing the mouse button, holding it down while moving the mouse, then 
releasing it at a new location. Dragging is used to move objects and change their size.

Right mouse button (shortcuts)

If you press the right mouse button while in Select mode (modes are explained later in 
this chapter), a menu appears near the cursor. You may then choose from a number of 
frequently used commands that make sense at the time, usually regarding the object 
that you clicked on. For example, if you click the right mouse button on a node, the 
menu contains features that apply to that node.

When you press the right mouse button while in any other mode, it serves as a shortcut 
method to return to Select mode.

Special Controls
The user interface contains standard Windows controls like buttons, scroll bars, list 
boxes, and pull-down lists. If you are unfamiliar with these terms, refer to your 
Windows documentation. There are also has a few unique controls that require some 
additional explanation.

Drop menus

Drop menu buttons are special buttons that cause a menu to pop-up. You can identify a 
drop menu button by the small black triangle in the lower right corner. Drop menus 
contain a number of selections to choose from, potentially including additional 
submenus. To make a selection, move the mouse over your choice and release, or just 
click on it.

Notice the ellipsis (three dots) at the lower right corner of the menu shown above. 
Some drop menus have this symbol to indicate that there may be additional selections 
that are not shown. By selecting the ellipsis, you can access the complete list of 
selections using a dialog box.
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Special Controls 15
Measurement edit boxes

Some edit boxes have special behaviors. When entering a measurement, you can type 
“3 in.” to mean three inches, but you can also type “3.0 inches”, or just “3”; all are 
equivalent. Your entries are always assumed to be in the current measurement units 
(inches or centimeters). If the field expects inches and you enter “3 ft.” or “3 cm”, it is 
treated as three inches. The same goes for point measurements for text size and line 
thicknesses. If a point measurement is called for, you can enter “2 pts” or “2 points” or 
“2.0”, and so on. 

Point measurements are a bit confusing at first. Just remember that there are 72 points 
in an inch or that most typed text is usually 10 to 12 points tall.

Standard sizes

It can be challenging to choose sizes that look good and print attractively. For 
example, if you are creating a path with an arrowhead, should you make the arrowhead 
8 points, 15 points, 20 points? Should its width be 1/2 point of 2 points? It’s hard to 
know without spending a lot of time trying different sizes AND printing them out. To 
greatly simplify choosing the sizes of some things, we’ve defined a set of standard 
sizes that you can select very easily. For example, arrowheads can be Small, Medium, 
or Large and line widths can be Fine, Medium, Heavy, or Very Heavy.

As you can see in the following illustration, the border width for a node can be 
adjusted by selecting a standard size with a menu, selecting a standard size with a drop 
menu, typing any size you want, or using a spin control to make it bigger or smaller.

Different Methods for Selecting Standard Sizes

Edit the number here 

Spin to next/previous value 

Select from drop menu: 

Select from menu: 
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16 Chapter 2: Basics
The Diagram
A diagram is a collection of symbols connected by lines, often including arrowsheads 
to indicate flows, and annotated by text labels. The combination of these simple 
components in nearly unlimited variety leads to a very powerful and flexible model. 
With this model you can build diagrams that show complex procedures, demonstrate 
plans, express ideas, organize thoughts, present proposals, record decisions, and much 
more.

Structurally, a diagram is composed of one or more sheets. Each sheet is a portion of a 
diagram, like a page but of any size that your require. The sheet functions like a virtual 
chalkboard upon which to draw your diagram. For convenience, a sheet might 
correspond to a sheet of paper so that you can print your diagram sheet-by-sheet on 
indiivdual pages of paper. This is the simplest way to begin. But a sheet can also be 
much larger than a printed page in which case each sheet get partitioned into multiple 
pages when printed. 

Diagram Components
The basic components of a diagram are nodes, paths, labels, and junctions. 

Nodes

Nodes are the building blocks of UML diagrams. They represent any kind of logical 
entity in your design such as a process, a module, a component, a task, or a physical 
object. Nodes can be pre-defined shapes, icons, or graphics such as clip-art. When a 
node is a pre-defined shape, it may contain one or more text areas in which you can 
add descriptive text.  

DATA 

1.*

DATA 
path labels 

paths 

nodes 

THIS IS A
SAMPLE DIAGRAM 

label 

junction 

Update backup 
database cocurrently

Custom er

name: String
phone: String

add(nam e,phone)

Reservation

date: Date

FINAL STEP

node label 

flow label 

Custom er

name: String
phone: String

add(name,phone)
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Styles and Properties 17
Paths

Paths are lines that connect two nodes. They represent conceptual connections between 
nodes of your diagrams. The specific meaning of a path can vary from diagram to 
diagram. Visually, paths can be straight, curved, smoothed, rounded, or arced. Each 
end of a path can have an attached shape or terminator such as an arrowhead. 

Junctions

Junctions are the points at which multiple segments of a path meet. They often form a 
vertex for a line or a control point for a curve. Junctions make it possible for a path to 
bend around corners, wrap around nodes, and connect to other paths. 

Labels

Labels are stand-alone text objects that serve as titles, annotations, and paragraphs. 
You can place any number of labels anywhere on a diagram. You can also have a 
variety of specialty labels such as Path Labels, Node Labels, and Flow Labels each 
with unique characteristics. 

Path Labels

Path labels are special labels that attach themselves to a path and remain attached when 
you move the path. They can be in-line (as shown), or lateral (alongside) the path. 

Node Labels

Node labels are special labels that attach themselves to a node and remain attached 
when you move the node.  

Flow Labels

Flow labels are special labels that attach themselves to a flow point where a path meets 
a node. If either the node or the path moves, the flow label moves accordingly. Flow 
labels can identify conditional branches (true and false) or further describe 
relationships defined by paths.

Styles and Properties
Styles

Objects start from an object style - a set of default properties and characteristics. Styles 
are a lot like paragraph styles in word processors. Rather than describing paragraphs, 
they describe nodes, labels, and paths. 

LABEL

LABEL 

LABEL

LABEL
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18 Chapter 2: Basics
One thing to remember about styles is that they are stored in every diagram. Don’t be 
reluctant to change them out of concern that you may affect future diagrams. To make 
a style change that will affect future diagrams, you must change a template file.

Diagram templates

The purpose of diagram templates is similar to the purpose of word processor template 
files, to group together a collection of styles that form the foundation of a diagram 
type. When you create a New diagram, you start from a template that defines a 
particular type of diagram.

Node styles

Node styles contain information about the shape of the node, its color, text font, border 
width, and size.They also contain a set of rules that define how nodes of the style 
behave and interact with other objects. 

Label styles

Label styles are similar to node styles except they include only those attributes which 
apply to labels.

Path styles

Path styles contain visual information about path such as the thickness of the line, 
whether it is straight or curved, its color, and whether it has arrow heads on either end. 
Path styles also contain a set of rules that define how they behave and interact with 
other objects. Path styles usually represent various relationships between nodes in your 
diagram.

Properties

An individual object such as a node, label, or path, has its own properties which it 
initially receives from an appropriate object style. 

For example, fill color is a property of a particular node. The initial color comes from 
the node style definition used to create the node. You can change the fill color of this 
node either by changing the node style from which it was created (which also affects 
all other nodes created from that style), or by changing the fill color property of the 
particular node alone. 

Remember, each object has properties of its own. A style defines the initial properties, 
of objects of that style.
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The Workspace 19
The Workspace
The following illustration shows key components of the workspace followed by brief 
descriptions.

Title bar Shows the program name and the name of the active diagram.

Menu bar Contains menus of related commands.

Tool bar Contains buttons that provide easy access to frequently used 
commands.

Property bar A second optional toolbar that contain buttons and controls to easily 
change properties of nodes, labels, and paths.

Style bar Contains controls to access label, node, and path styles.

Status bar Shows brief help information, and shift key options.

Scroll bars Show your position in a diagram and allow you to move around.

Sheet bar Controls to change the active sheet.

Rulers Show real-life measurements of the diagram.

Scroll bars 

Title bar 

Property bar 

Menu bar Tool bar 

Rulers 

Status bar/help 
Style bar 

Sheet bar
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20 Chapter 2: Basics
The Style Bar
The style bar is the area to the left of the diagram that contains controls to access label, 
node, and path styles. The purpose of the style bar is to make it very easy to choose a 
style to create an object.

The style bar contains three main sections, one for labels, one for nodes, and one for 
paths. If the diagram contains no styles of one of these types, the section will not 
appear in the style bar.

Each of these sections contains three types of controls, all of which do the same thing 
in different ways

Style drop menu

At the top of each section is a Style Drop Menu button. Use this button to choose a 
style from a drop menu, a pop-up menu that contains a graphic representation of every 
style of the type in this section. When pressed, it expands to show the styles:

The graphic representations in the drop menu are only approximations of the styles. 
For example, they do not include line thickness. 

Style drop menu 
Style combo box 

Style bar buttons 
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The Tool Bar 21
Style combo box

Under the drop menu button is the style combo box. The style combo box displays the 
name of the currently selected style and it also allows you to change the style by 
choosing another style by name. The end result is the same as if you had used the drop 
menu to choose the style.

Style bar buttons

Under the style combo box are optional style bar buttons. Each style bar button 
represents a single style. You can choose the style by simply pressing the button.

Though style bar buttons are the easiest way to choose a style, they also take up a lot of 
room. Therefore, they typically represent only the most frequently used styles. The 
representation of the style is only approximate. For example it does not show color.

For each style, you can choose whether or not it has a style bar button. Use the Define 
Styles dialog boxes or the Style selection dialog boxes to add style bar buttons. 

Customizing the style bar

You can customize the style bar for a particular diagram or template. You can control 
its width, the size and arrangement of buttons of each type, and the styles that are 
available on buttons, plus some additional properties. The customization controls for 
the style bar are located in the Customization screen which is available in the Tools 
menu or by right-clicking on the style bar.

Collapsing the style bar

Some users may prefer to collapse the style bar leaving a less obtrusive method for 
selecting styles while freeing screen space for viewing and editing diagrams. To do so, 
click on the left-most button on the property bar (second tool bar). The style bar will 
disappear and instead three simple style drop menu buttons will appear in the property 
bar which perform the identical function as the drop menu buttons described above.

The Tool Bar

The tool bar provides convenient buttons to perform the most frequently used 
functions. The tool bar is always present. When you move the mouse over one of these 
buttons, a description of its function will appear in a small balloon or tooltip as well as 
a help message in the status bar.
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22 Chapter 2: Basics
The Property Bar

The property bar in an optional second toolbar that contains buttons and controls to 
conveniently change object properties such as fonts, text formats, colors, and so on. 
The property bar is optional and can be toggled on and off by checking Show property 
bar from the View tab in the Options dialog box. When you move the mouse over one 
of these buttons, a description of its function will appear in a small balloon called a 
tooltip as well as a help message in the status bar.

You use the property bar by selecting one or more objects, then changing their 
properties with the property bar controls. All of these properties can also be changed 
through the object property dialog boxes, for example by selecting a node and then 
choosing Properties from the Nodes menu.

The property bar is also useful when creating objects. After you’ve selected the style 
of object to create, you can use the property bar to change the properties of the objects 
that will be created without changing the style itself. This is explained in more detail 
elsewhere. 

Note that the property bar is optional and completely configurable. The descriptions 
above apply only to the default configuration.
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The Snap Grid 23
The Snap Grid
The snap grid helps you line up nodes in your diagram. The snap grid contains two 
components that you can use together or separately, the visible grid and the snap grid 
itself.

The visible grid

The visible grid is a set of horizontal and vertical grid lines or dots that appear behind 
your diagram. By itself, the visible grid is only a visual aid, it does not have an effect 
on your diagramming.

You can turn the visible grid on and off from within the Grid and Snap section of the 
Diagram Properties screen available from the Tools menu (see  Diagram Properties: 
Grid and Snap on page 219). You can control whether the grid is displayed as lines or 
dots from within the View section of the Options screen also available from the Tools 
menu.

The snap grid

The snap grid is NOT visible. However, when it is enabled it affects the construction 
of your diagrams. The snap grid automatically controls where nodes and paths can be 
placed and how large nodes can be. For example, if you set the snap spacing to a half 
inch, you can place nodes only at exactly one half inch intervals. Therefore, you know 
that if two nodes look lined up, they are lined up. If they look the same size, they are 
the same size. If a line looks straight, it is straight. When you print your diagram you 
won’t have to worry that what looked right on the screen is not right on paper.

You can turn snap on and off by pressing the tool bar button. control the snap spacing 
from within the Grid and Snap section of the Diagram Properties screen available 
from the Tools menu (see Diagram Properties: Grid and Snap on page 193).

You can use either the visible grid or the snap grid without using both. However, when 
you use both together, you get the greatest benefit. Most often, you will want to choose 
a grid spacing that is larger than your snap spacing, twice as large is the default.

Modes
While you are working on a diagram, you are always in one of several modes. There is 
a mode for selecting and moving objects, a mode for creating nodes, a mode for 
creating labels and editing text, a mode for creating paths, and a mode for zooming 
into a certain area of a diagram. Following is a brief summary of each mode.

Select mode
The default mode is select mode. In this mode you can select objects, move objects, 
size objects, and perform many other functions. You will probably spend most of your 
time in this mode since this is the mode in which most features are available.
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24 Chapter 2: Basics
To enter select mode, click on the select mode button in the tool bar or press ESC. You 
can tell that you are in select mode when the select mode tool bar button is pressed and 
the mouse cursor is the standard Windows cursor .

Text mode
You enter text mode to work with text. In this mode you can create labels, add text to 
nodes, and edit node text.

To enter text mode, click on the text mode button in the tool bar. You can tell you are 
in text mode when the text mode button in the tool bar is pressed and the text 
cursor appears.

You will also enter text mode if you select a label style from the style bar.

Seltext mode
This mode is a special combination of text mode and select mode. It is just like select 
mode except that you can also edit text as if you were in text mode. 

Using this mode rather than select mode will prevent you from having to switch modes 
as often. The trade-off is that both selection and text editing require more precise 
pointing with the mouse.

To enter seltext mode, click on the seltext mode button in the tool bar. You can tell you 
are in seltext mode when the seltext mode button is pressed and the mouse cursor is 
either a text mode cursor or a select mode cursor .

Zoom mode
You enter zoom mode to zoom in to a part of your diagram and view it in greater 
detail.

To enter zoom mode, click on the zoom mode button in the tool bar. You can tell you 
are in zoom mode when the zoom mode button is pressed and the zoom cursor  
appears. Zoom mode is described in more detail elsewhere (see  Zoom on page 42).

Node create mode
You enter node create mode to add nodes to your diagram.

To enter node create mode, select a node style from the style bar. There is no button on 
the tool bar because you must indicate the style of node you want to create. 

You can tell you are in node create mode when the cursor is in the shape of a node. If 
the node style you are creating has a button on the style bar, that button will be pressed 
as well.
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Modes 25
Connect mode
You enter connect mode to add paths to your diagram.

To enter connect mode, select a path style from the style bar. There is no button on the 
tool bar because you must indicate the style of path you want to create.

The connect cursor appears . If the path style you are creating has a button on the 
style bar, that button will be pressed as well.
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27

CHAPTER
3 GENERAL EDITING 

This chapter covers fundamental operations that are common to all object types including 
nodes, paths, and labels. Many of these operations are accessible through commands in the 
Edit menu.

Selecting and Deselecting Objects
Most features affect one or more objects, but generally not all objects in a diagram. Before 
you perform a feature, you can select one or more objects to which the feature will apply. 
This section covers the different methods of selecting and deselecting objects.

When an object is selected, its handles become visible as small red squares along the 
border of the object. Here’s how some common objects appear when selected:

There are several different methods for selecting and deselecting objects.

Lasso select
One way to select objects is to form a lasso around a group of objects. A lasso is a box that 
you form to choose a rectangular area of the diagram.

To lasso select objects
1. In Select mode, move the cursor to an area of the diagram where there are no objects. 

The cursor becomes the standard arrow shape .
2. Press the left mouse button, keep it held, and move the mouse to form a rectangular 

lasso area. The lasso area displays as a dotted box.
3. Release the mouse button. All objects that are located entirely within the lasso area 

become selected.

Custom er

name: String
phone: String

add(nam e,phone)

DIAGRAM

A selected node A selected path A selected label 
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28 Chapter 3: General Editing
Note that holding down the Alt key while performing a lasso selection causes objects 
belonging to both the foreground and background layers to be included in the resulting 
selection.

Click select
While in select mode select individual objects by clicking on the objects with the left 
mouse button. To select a particular object, move the mouse over the node, path, or 
label and click.

Select all
Select all the objects in a diagram by choosing Select All from the Edit menu.

Deselect all
To deselect all selected objects, click the left mouse button on the diagram where there 
are no objects, or press ESC, or choose Deselect All from the Edit menu.

Selecting more objects
Normally, if some objects are selected and you attempt to select objects with any of the 
prior methods, the previously selected objects become deselected before the new 
objects become selected. If you’d like the previously selected objects to remain 
selected in addition to the newly selected objects, hold down the SHIFT key while 
selecting objects with any above methods. This process is called extending a selection.

Deselecting Individual Objects
If a number of objects are selected, you can deselect individual objects by holding 
down SHIFT key while clicking on the object.

Moving Objects to the Front or Back
All objects have an order within the diagram. New objects are in front of previously 
created objects and are drawn on top of them. You can adjust an object’s order in the 
diagram, and choose which objects are in front of or in back of other objects in the 
following ways.

To move one or more selected objects to the front
1. Select one or more objects.
2. Choose Front from the Edit menu. The selected objects move in front of all other 

objects in the diagram.
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Moving Objects to the Front or Back 29
To move one or more selected objects to the back
1. Select one or more objects.
2. Choose Back from the Edit menu. The selected objects moves in back of all other 

objects in the diagram.

You can also move a single object one position toward the front of the diagram or 
towards the back of the diagram, effectively moving it in front or behind a single 
overlapping object.

To move one object in front of the next overlapping object
1. Select the object to move.
2. Choose Front One from the Edit menu. The selected object moves forward by one 

object.

To move one object behind the next overlapping object
1. Select the object to move.
2. Choose Back One from the Edit menu. The selected object moves back by one 

object.

Original order After move to front After move to back 

Original order After move front one After move back one 
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30 Chapter 3: General Editing
Deleting Objects
You can remove any objects from your diagram by deleting them. Deleting objects is a 
little different than cutting objects (see the following section) because you cannot 
Paste following Delete. Delete is also slightly faster and does not modify the Windows 
clipboard.

As a rule of thumb, use Delete to remove objects permanently, and use Cut to remove 
objects when you plan to Paste them to another location.

To delete objects from a diagram
1. Select one or more objects to delete.
2. Choose Delete from the Edit menu or press the DEL key.
When you delete selected objects, additional objects may be deleted automatically. For 
example, if you delete a path, not only will all segments of the path be deleted, but all 
path labels that were attached to those segments will also be deleted whether or not 
they were selected. 

If you delete a node to which a path is attached, that path is also deleted. If you want to 
delete a node but not delete an attached path, detach the path first.

A special exception occurs when you delete a node that is within a flow (that is it has a 
single path entering it and another of the same style leaving it). In this case, if you 
delete the node, the two paths will join into one.

Cutting Objects
Cutting is another way to remove objects from a diagram. Unlike delete, a copy of the 
deleted objects is first saved in the Windows clipboard. You can later Paste these 
objects back into the diagram or even into a different diagram.

As a rule of thumb, use Delete to remove objects permanently, and use Cut to remove 
objects when you plan to Paste them to another location.

To cut objects from a diagram
1. Select the objects you want to cut.
2. Choose Cut from the Edit menu or press CTRL-X on the keyboard.
Like Delete, when you cut selected objects, additional objects may be cut 
automatically. 

Cut or copied objects remain in the clipboard until you cut or copy more objects, leave 
Windows, turn off your computer, or cut or copy to the clipboard from another 
program.
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Copying Objects 31
Copying Objects
You can use the Windows clipboard to copy a selected set of objects within the same 
diagram or to a different diagram.

To copy objects in a diagram
1. Select one or more objects to copy.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Choose Paste from the Edit menu or press CTRL-V on the keyboard. A copy of the 

objects appears at the center of the screen selected for you.
4. Move the new objects if you want.
5. If you like, you can Paste the same objects over and over again.

To copy objects from one diagram to another
1. Select one or more objects to copy.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Open a different diagram. 
4. Choose Paste from the Edit menu or press CTRL-V on the keyboard. A copy of the 

objects appear at the center of the screen selected for you.
5. Move the new objects if you want.
6. If you like, you can Paste the same objects over and over again.

In addition to copying objects within and between diagrams, you can also copy objects 
from diagrams to documents of other programs such as Microsoft Word. Diagram 
objects can be copied to Microsoft Word and similar programs as OLE objects (see  
Object Linking and Embedding (OLE) on page 269) or simply as graphics, namely a 
Windows Metafile. When you a do a copy, both types of data are stored to the 
Windows clipboard and it is up to the program that pastes the data to choose the format 
(Object or Picture in this case). 

To copy objects from a diagram to a different program
1. Select one or more objects to copy.
2. Choose Copy from the Edit menu or press CTRL-C on the keyboard.
3. Run the target program (MS Word in our example).
4. Choose Paste in the target program.
Cut or copied objects remain in the clipboard until you cut or copy more objects, leave 
Windows, turn off your computer, or cut or copy to the clipboard from another 
program.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 31 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



32 Chapter 3: General Editing
Duplicating Objects
Another faster way to copy objects is to duplicate them. Duplicating does not use the 
Windows clipboard and therefore does not work between different diagrams or 
between this program and other Windows applications. You can, however, use this 
procedure to copy objects between one view of a diagram and another view of the 
same diagram (see  Opening an Additional View of a Diagram on page 260).

To duplicate objects in the same diagram
1. Enter select mode.
2. Move the mouse over any object or over one in a group of selected objects.
3. While holding down the CONTROL key, drag the objects. A set of duplicate objects 

appears.
4. Position the duplicate objects and release the mouse button. 

In addition, you can duplicate objects by right-clicking on them and choosing 
Duplicate from the right click menu or by selecting them and choosing Duplicate 
from the main Edit menu. You can of course select any number of objects and 
duplicate them as a group in the same way.

Pasting Objects
You can paste objects from the clipboard that were previously placed in the clipboard 
by an earlier Cut or Copy operation. Pasting is most often the second half of a Cut-and-
Paste or Copy-and-Paste operation.

To paste objects from the clipboard
1. Choose Paste from the Edit menu. If the Paste feature is grayed in the menu, it 

means that the clipboard contains no diagram data.
2. A copy of the objects in the clipboard appears at the center of the screen. 
3. Move the new objects where you want them.
Once you paste objects, they remain in the clipboard so you can paste them repeatedly 
to create multiple copies. 

Pasting graphics
You can also Paste graphics that were copied to the clipboard by other programs. After 
copying a graphic from another program, simply use Paste as described above. This 
will work as long as the other program copies its graphics to the clipboard in a format 
that this program knows (WMF, EMF, BMP, DIB).
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Copying Object Properties 33
Pasting text
Pasting text is special because it can be done in two ways. One way is to enter text 
mode, position the caret in an existing node or label at the point where you want text to 
appear, then choose Paste from the Edit menu. If you are not in text mode and you 
paste text into your diagram, a new label will automatically be created for you and 
positioned at the center of the screen with the text that was in the clipboard. The style 
of this label will be the last label style you selected.

Paste As
The clipboard can contain the same information in several different formats at once. 
Normally, when you use Paste as described above, the best format (or the one that the 
other program said was best) is chosen automatically. However, there is also a way to 
choose exactly which format to paste.

To paste objects from the clipboard in a particular format
1. Choose Paste As from the Edit menu and select one of the available formats 

“UML Diagram”, “Picture”, “Bitmap”, “Formatted Text”, or “Text”. If a format is 
grayed in the menu, it means there is no such data in the clipboard.

2. A copy of the objects in the clipboard appears at the center of the screen. 
3. Move the new objects where you want them.

Copying Object Properties
A subset of the most commonly edited diagram object properties can be copied and 
pasted to other objects of the same kind using the Copy Properties and Paste 
Properties features. These features provide a convenient alternative to the more 
cumbersome and comprehensive properties screens. The properties that can be copied 
this way are those that affect the visual appearance of the objects such as the fill, 
outline, and font.

Each object type (nodes, paths, and labels) has its own properties that can be copied 
only to objects of the same type. For example, if you copy properties of a node and 
paste properties to a label, the label will not adopt the font of the node even though 
both nodes and labels have fonts. 

There is a separate Copy Properties and Paste Properties command for each type of 
object. However there are also two more convenient universal Copy Properties and 
Paste Properties features. These properties copy from and paste to selected objects 
based on their object types. It’s these generic features that are available by shortcut 
keys and provide the main interface to these features.
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34 Chapter 3: General Editing
To copy object properties to the clipboard
1. Select an object of a particular type (node, path, or label) or select a number of 

objects of the type, or select a variety of objects of multiple types. Alternately, 
simply right click on a target object - this is most clear if done with no objects 
selected but is equally valid if clicking on an object in the selection.

2. Choose Copy Properties from the Edit menu or use the shortcut key 
Shift+Ctrl+C to copy the object properties to the clipboard. If multiple objects are 
selected, the properties belonging to the last selected object of each type will be 
copied. 

3. Or, choose Copy Properties from the right-click menu if you right-clicked on a 
particular object to copy its properties. If this case, only the properties of the type 
of object clicked on will be copies to the clipboard.

To paste object properties from the clipboard
1. Select the objects to paste the copied properties to, or right click on a target object.
2. Choose Paste Properties from the Edit menu or use the shortcut key 

Shift+Ctrl+V to paste the object properties from the clipboard. 
3. Or, choose Paste Properties from the right-click menu if you right-clicked on a 

target object. 
Note that not all objects are appropriate for all properties and will not necessarily 
acquire all of the pasted properties. For example, a graphic object will not acquired 
pasted font or fill properties. 

You can selectively control which properties of which objects are subject to these 
features. See Edit category in the Tools Options screen.

Undo
The undo feature lets you undo changes to a diagram. If you make any changes by 
mistake, you can reverse the effects of the most recent operations by using the undo 
feature. The undo menu command contains a brief description of the operation that can 
be undone. Each corresponds roughly to one operation you performed. For example, 
deleting ten selected objects can be undone in one step just as it was done in one step. 
The last fifty operations can be undone, older ones cannot.

To undo any operation
Choose Undo from the Edit menu. The undo menu item indicates exactly which 
operation will be undone.
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NOTE: Changes you make to styles cannot be undone. It is a good idea to save your 
diagram before making any changes to styles. You can assume that virtually 
all other operations can be undone. In rare cases where operations will not be 
undoable, you will be informed before the changes take place.

Moving Objects
Once you create nodes, labels, and paths in your diagram, you can use the mouse to 
move and arrange them. There are a couple methods available for moving objects.

To move a single object without selecting it first
1. Enter select mode.
2. Move the mouse over an object so that the move cursor appears
3. Press the left mouse button and hold it.
4. Move the object to another location.
5. Release the mouse button.
Objects move in accordance with their properties. If the snap grid is enabled and the 
node has the snap center to grid property, it will only move to points on the grid.

To move a group of selected objects
1. Enter select mode.
2. Select one or more objects to move.
3. Move the mouse over a selected object so that the move cursor appears.
4. Press the left mouse button and hold it.
5. Move the object to another location.
6. Release the mouse button.
You cannot drag objects from one diagram to another diagram in another window. Use 
cut/paste for that purpose. You can, however, drag objects between one view of a 
diagram and another view of the same diagram (see  Opening an Additional View of a 
Diagram on page 260).

Moving Objects with Precision (“nudge”)

To move objects with greater precision
1. Enter select mode.
2. Select one or more objects.
3. Press the up, down, right, or left arrow keys on the keyboard to move the objects a 

small increment in any direction.
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36 Chapter 3: General Editing
The amount the objects move each time you press an arrow key depends on the snap-
to-grid diagram property (the button on the tool bar that resembles a square positioned 
on a grid). With snap enabled, each press of an arrow key moves the objects by a 
distance equal to the snap grid spacing. Otherwise, the objects move by one screen 
pixel.

Finding and Replacing Text
You can use the Find and Replace features to locate nodes and labels in the currently 
open diagram that contain some particular text and to replace that text with something 
else.

To find the nodes and labels containing text
1. Change your zoom so that you can read your node text clearly and still view a 

good portion of the diagram - 100% is good to start.
2. Choose Find from the Edit menu or press the shortcut key Ctrl-F.
3. The Find dialog box will appear. Enter the search text and select the options that 

apply, then press Find Next repeatedly to locate the nodes and labels that contain 
the text. As you press Find Next, each occurrence of the text will become selected 
on the screen. If the node is not already visible, it will move into view.

The Find dialog box looks like this

Find what:

Type the text you wish to locate here.

Match whole word only

Check this box to locate only text that contains the search text as a complete word. For 
example, if your search text is “the”, it will not find the text within words like “these” 
or “other” only the word “the” by itself.

Match case

Check this box to locate only text that exactly matches the case of the search text. For 
example, if your search text is “the”, it will not find “The” or “THE”.
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Finding and Replacing Text 37
Find Next

Type the text you wish to locate here.

Cancel

Closes the dialog box.

To replace node and label text
1. Change your zoom so that you can read your node text clearly and still view a 

good portion of the diagram - 100% is good to start.
2. Choose Replace from the Edit menu or press the shortcut key Ctrl-H.
3. The Replace dialog box will appear. Enter the search text, the replacement text, 

and select the options that apply, then press either Replace All or Find Next/
Replace repeatedly to locate and replace each occurrence of the search text.

The Replace dialog box looks like this:

Find what:

Type the text you wish to locate here.

Replace with:

Type the replacement text here. You can leave this field blank to remove the search 
text.

Match whole word only

Check this box to locate only text that contains the search text as a complete word. For 
example, if your search text is “the”, it will not find the text within words like “these” 
or “other” only the word “the” by itself.
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38 Chapter 3: General Editing
Match case

Check this box to locate only text that exactly matches the case of the search text. For 
example, if your search text is “the”, it will not find “The” or “THE”.

Find Next

Type the text you wish to locate here.

Replace

After pressing Find Next to locate the next occurrence of the search text it will appear 
selected. Press the Replace button to replace the selected text with your replacement 
text. Pressing Find Next then Replace repeatedly lets you determine which 
occurrences of the search text you want to replace.

Replace All

Press this button to replace all occurrences of the search text in the current diagram 
with the replacement text.

Cancel

Closes the dialog box.

Choosing Colors
Colors place an important role in diagrams and the program user interface. The usual 
way to select a color is with a color selection menu button which presents a color 
selection drop menu when pressed.

The colors available in the color selection drop menu are those of the current color 
palette, which is simply a collection of colors available for this purpose. You can 
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Choosing Colors 39
choose from a number of different palettes containing different numbers and varieties 
of colors. Palette selection can be found in the Colors tab found in the Options screen 
(available from the Tools menu).

The color selection drop menu contains some different components:

Palette colors

The colors above the line are the colors of the color palette. They change only if you 
select a new palette as described above.

Custom diagram colors

The colors below the line are the sixteen custom colors that you can set for each 
diagram you create. You can control which colors are shown here and saved in your 
diagram using the standard Windows color dialog box described below.

Transparent color

Under some circumstances, such as when setting a fill color, the color selection drop 
menu contains an entry for transparency rather than a color. This entry appears as a 
box with an “X” in the upper right corner of the drop menu.

Ellipsis (...)

The ellipsis (three dots) is located at the bottom right of the color selection drop menu. 
Click here to access the standard Windows color dialog box to choose a color that may 
not be represented in the drop menu, or to change the custom diagram colors. 
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40 Chapter 3: General Editing
Fill Colors, Transparency, and Tinting

Fill Colors
Nearly any node in a diagram can be colored with a fill color in addition to a border 
(outline) color and text color. The fill color determines the color of the body of the 
symbol. If the symbol contains text areas, the fill color will also determine the 
background color for its text. For nodes that are graphic images, such as imported 
clipart, the fill color controls the tint color of the image (see Tinting below).

Transparency
A node with no fill color is transparent. You can remove the fill color by selecting the 
“X” from the fill color drop menu. When an ordinary geometric symbol is transparent, 
objects below it will be visible through the symbol. A side effect of a symbol with no 
fill color is that you will need to click on the border or outline of the symbol in order to 
select it. A graphic image uses the fill color as a tint color. For graphic images, no fill 
color means the image will be drawn with its original colors rather than a tint color - 
no transparency is possible (see Tinting below).

Tinting
The fill color for graphic images such as imported clip art is a tinting color. Initially an 
imported graphic will have no tint color which is the same as having a transparent fill 
color. A graphic image with no tint color is drawn with its original colors. If you 
change a graphic's fill color it will change the tint color of the image. For black and 
white images, the black portions of the image will be replaced by the tint color and the 
white portions will remain unchanged. For gray-scale or multi-colored images, each 
color in the image will be replaced by a shade of the tint color. For gray-scale images 
for example, a blue fill color will have the effect of changing the image colors from 
shades of gray to shades of blue.

There are some limitations on the ability to control tinting of graphic images. 
Attempting to control tinting by changing the fill color of certain graphics will have no 
affect on (a) imported metafiles that contain their own embedded color palettes, (b) 
imported metafiles that contain bitmaps embedded within the metafile, and (c) APM 
metafiles. If you cannot control the tinting of an imported graphic by changing the fill 
color, you may need to edit the colors of the original graphic with a paint program and 
import the result.
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CHAPTER
4 GETTING AROUND IN A DIAGRAM 

Limitations of the computer screen present the single greatest obstacle to working on a 
diagram. Typical diagrams extend well beyond the size and degree of detail that you can 
view effectively within a single window. This chapter describes the methods provided to 
overcome this obstacle. With these features, you can control precisely both the portion of 
the diagram and the degree of detail that are shown.

Using the Scroll Bars
You can use scroll bars to move your view of the diagram up-and-down and left-and-right 
without affecting the degree of detail shown.

The scroll bar buttons scroll the diagram by a small amount in the direction of the arrow. 
Clicking in the region of the scroll bar between the slider and a button scrolls by a half 
screen in the direction of the button.

Using the Arrow Keys
You can also use the shifted Up, Down, Left, and Right arrow keys on your keyboard to 
move your view of the diagram. Each key press moves the diagram by one quarter of the 
screen area in the appropriate direction. 

Drag Scrolling
One of the most convenient ways to scroll the screen is to press the middle mouse button or 
mouse wheel button and drag your view in any direction. If you don't have a mouse wheel 
or middle button, you can use the Control key plus the left mouse button, but when doing so 
be sure the mouse is not positioned above any objects because Control-drag is also how you 
duplicate objects.

Autoscroll
When you drag an object past the edge of the screen, the diagram automatically scrolls to 
follow the cursor. Autoscroll is only in effect when the current view is maximized to fill the 
entire workspace. 
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42 Chapter 4: Getting Around in a Diagram
Zoom
Zoom features allow you to move quickly between different views of the diagram and 
to increase and decrease the degree of detail displayed in the diagram window. Some 
of these features allow you to zoom-in and zoom-out your view of the diagram. By 
changing the zoom magnification, you can control how much of the diagram is visible 
and how much detail is displayed. Other zoom features let you move instantly to a 
special view of the diagram.

For all zoom features, the absolute limit of the zoom range is from 10% (one tenth 
printed size) to 1000% (ten times printed size) but you will probably notice that more 
narrow limits are determined by your screen resolution and display mode.

Zooming to a special view
The following features move you directly to a special view of the diagram regardless 
of your present location. They are especially useful for returning to a known view 
when you become disoriented. These features are found at the top of the View menu.

To zoom to a view of the entire page area
Choose Whole Page from the View menu or press the toolbar button. 

To zoom to a view of the top of the page area
Choose Page Width from the View menu or press the toolbar button. 

To zoom to a view of all the objects in the diagram
Choose All Objects from the View menu.

To zoom to a view of all selected objects in the diagram
1. Select one or more objects.
2. Choose Selected Objects from the View menu.
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Zoom 43
Zooming in and out
These features increase or decrease the amount of detail in the diagram window.

To zoom the view to any magnification
Using the combo box located on the tool bar, choose a predefined zoom percentage, or 
type in any valid percentage and press enter. The valid zoom range depends on your 
particular configuration but must never be less than 10% or more than 1000%.

To zoom in and out - using the keyboard
Press the PLUS key on the keypad to zoom in or the MINUS key to zoom out. The view 
is magnified or reduced by a small amount so that objects appear larger or smaller. 
Normally, the view remains centered at the same location of the diagram prior to 
zooming in. However, if any objects were selected, the new view is centered on those 
objects.

To zoom to one of the preset zoom intervals
Choose a specific percentage from the View menu. The status bar at the bottom of the 
screen displays the current zoom percentage. At one hundred percent, the size of the 
diagram on the screen exactly matches the printed size - assuming your screen height 
is set accurately.

To zoom in to the next zoom interval
Press the tool bar button that looks like a magnifying glass with a big “+”. The view 
will zoom to the next higher of the fixed zoom intervals. 

To zoom out to the next zoom interval
Press the tool bar button that looks like a magnifying glass with a big “-”. The view 
will zoom to the next lower of the fixed zoom intervals. 

To set custom zoom intervals
1. Choose Set from the View menu.
2. Use the Zoom tab of the Options dialog box to set your own zoom intervals.
3. Press OK to make your changes. The new percentages are sorted and entered into 

the View menu. Choose the new percentage from the View menu to change the 
zoom magnification.

Using zoom mode
Zoom mode provides even greater control to select a view of your diagram. You enter 
zoom mode by clicking on the zoom mode button in the tool bar. You can tell you are 
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44 Chapter 4: Getting Around in a Diagram
in zoom mode when the zoom mode button is pressed and the zoom cursor 
appears.

To zoom in incrementally in zoom mode
1. Enter zoom mode.
2. Move the mouse over a part of the diagram that you want to view in greater detail.
3. Click the left mouse button (press and release immediately) to zoom in a little 

closer.
4. Repeat until the view is sufficiently detailed.

To zoom in to a specific location in zoom mode
1. First you might want to zoom out so that the entire area you want to view is visible 

on the screen. Zoom Page is useful for this purpose.
2. Enter zoom mode.
3. Choose the area of the diagram that you want to view in detail. Move the mouse to 

the upper left-hand corner of that area.
4. Press and hold the left mouse button.
5. Drag the mouse to create a rectangular region covering the area of interest.
6. Release the mouse button. The rectangular region will fill the entire window.

Navigating among multiple sheets
Use the Sheet Bar and sheet tabs located in the lower left corner of the view window to 
change the active sheet. The individual sheet bar controls are described in the Sheets 
chapter.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 44 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



45

CHAPTER
5 SHEETS

A diagram may contain multiple sheets. A sheet is essentially a page. However we use the 
term sheet instead so not to confuse it with a printed page. It its simplest form each sheet 
will correspond to a printed page such as a letter-sized area. However, you can use Page 
Set-up to define larger sheets of just about any size that may not be printable unless divided 
into multiple printed pages. Therefore a sheet is a continuous rectangular space of any size 
(but most conveniently that of a supported paper size) on which you can lay out a diagram. 
And a diagram may contain multiple sheets to improve organization and modularity.

Each diagram has at least one sheet. You may choose to add sheets as a diagram’s size and 
complexity grows. While a diagram may multiple sheets, it’s important to understand that it 
remains a single diagram and all sheets share the same styles and diagram properties. 

Adding a Sheet
You can add a sheet to a diagram before the first sheet, after the last sheet, or between any 
existing sheets. 

To add a new sheet to a diagram
1. Right click on any tab in the Sheet Bar and select Insert Before or Insert After from 

the pop-up menu to add a new sheet before or after the corresponding sheet.
Or

2. Select the first or last tab of the diagram causing the Previous Sheet or Next Sheet 
button in the Sheet Bar respectively to change from a triangular arrow to “+”. Click the 
button add a new first or last sheet to the diagram.

Deleting a Sheet
You can delete any sheet or sheets within a diagram. Deleting a sheet will delete all 
diagram objects contained within the sheet. Keep in mind that you cannot delete the last 
remaining sheet of a diagram, nor will ou be allowed to delete all sheets at once.
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46 Chapter 5: Sheets
To delete a sheet from a diagram
1. Right click on any tab in the Sheet Bar and select Delete from the pop-up menu to 

delete the corresponding sheet. 
Or

2. Click the Go to Sheet button in the Sheet Bar to invoke the Go to Sheet screen. 
Then select one or more sheets and click the Delete button. This is the only way to 
delete more than one sheet at a time.

Changing the Active Sheet
The currently active sheet is displayed in the active window. It’s the sheet that is 
affected by edits, copies, pastes, exports, searches, and so on. Changing the active 
sheet is like flipping to a different page in your diagram.

To change the active sheet
1. Click on the corresponding sheet tab within the Sheet Bar.

Or

2. Use the Sheet Bar to navigate among multiple sheets in a diagram changing the 
active sheet that is displayed in the active view window. Click on the arrow 
buttons to navigate to the First Sheet, Last Sheet, Previous Sheet, or Next Sheet. 

To go to a specific sheet
1. Click on the Go to Sheet button in the Sheet Bar. It’s the middle button that 

displays the current sheet number and total number of sheets in the form “3 of 5” 
representing the third sheet of five. This invokes the Go to Sheet screen. Select a 
single sheet and click Ok to make it the active sheet, or simply double-click on it.

Assigning a sheet a custom name
You can assign a name to any or all sheets in a diagram. By default the sheets are 
simply named in sequence as “Sheet 1”, “Sheet 2”, “Sheet 3”, and so on. Assigning a 
custom name to sheet is both clearer and more stable. It’s clearer in the obvious sense 
that “Checkout Procedure” is more descriptive than “Sheet 3”. It’s more stable as well 
because a custom name sticks with the particular sheet when other sheets are added or 
removed, whereas “Sheet 3” becomes “Sheet 2” if you delete “Sheet 1”. 

Referring to a sheet by name rather than by number is especially useful when 
exporting or saving as HTML in which case the sheet name is used to construct the 
filename of the output file. A stable custom sheet name results in a more easily 
understood and maintained relationship between a diagram, it’s sheets, and their 
corresponding exported files or HTML pages. The same is true when hyperlinking to a 
particular sheet within a diagram.
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Assigning a sheet a custom name 47
Custom sheet names can be up to 64 characters in length. Each custom sheet name 
within a diagram must be unique. The name must not be blank or end in a space, and it 
must not contain characters not allowed within a Windows file name (“:”, “.”, “/”, “\”, 
“|”, “?”, “<“, “>”).

To assign a custom sheet name
1. Double click on the sheet name on the sheet’s tab in the Sheet Bar.
2. Edit the sheet name complying with the naming rules above.
3. Press Enter or click on another control in the Sheet Bar when complete, or press 

ESC to cancel.

To unassign a custom sheet name
1. Assign a custom name to the sheet as described above, but clear the name (make it 

blank) or assign it to the exact name it would have by default (such as “Sheet 2”). 
Once the custom sheet name is unassigned, the name will change such as from 
“Sheet 2” to “Sheet 3” reflecting its order in the diagram as other sheets get added 
and removed.
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CHAPTER
6 NODES

Nodes are the building blocks of UML diagrams. They represent any kind of logical entity 
in your design such as a process, a module, a component, a task, or a physical object. Nodes 
can be pre-defined shapes, icons, or graphics such as clip-art. When a node is a pre-defined 
shape, it may contain one or more areas or compartments for descriptive text. The shape of 
a node is one of its properties. It also has stylistic properties such as color and line 
thickness. And it has behavioral properties such as whether it remains aligned with the snap 
grid. The initial properties of a node come from the node style used to create it. 

This chapter covers the properties, behaviors, and features that are unique to nodes. There 
are also many operations not covered in this chapter that affect nodes as well as other types 
of objects (see  CHAPTER 3: General Editing,  page 27). 

Creating Nodes
The most common way to add a node to your diagram is to choose a node style that 
represents the shape and initial properties of the node object you are creating. This moves 
you into create mode where you drop the node onto your diagram and optionally resize it.

To choose a node style and initiate create mode

Perform one of the following:

1. Click on the style bar button of a node style. If the style does not have a button in the 
style bar, use one of the following methods instead.

Node style drop menu 
Node style combo box 
Style bar buttons 
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50 Chapter 6: Nodes
or

2. Press and hold the Nodes button in the style bar to activate the node style drop 
menu. Move to the representation of the style, and release the mouse button. Not 

all styles are necessarily displayed in this menu so you may have to choose the 
three dots to see all of them (see the next section).

or

3. Choose the node style by name from the node style combo box. The combo box 
always contains all styles defined in the diagram.

Method 4: Choosing a node style from the complete list of styles
A fourth method is available to select a node style. This method contains all of the 
styles with complete names, pictures, and descriptions and lets you choose which 
styles appear on buttons and in drop menus.
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Creating Nodes 51
Select the ellipsis (three dots) from the Nodes drop menu to open the Choose a Node 
Style dialog box.

To choose a node style 
1. Scroll to preview all of the available styles.
2. Click on the style to select it.
3. Press OK or double-click on the style. 

Category

Use this combo box to show all styles or only styles of a certain category.

Edit

While you’re here you may want to add, change, or delete styles from your diagram. 
This button just provides a convenient shortcut to the Styles dialog box. Also available 
by right-clicking any style in the list.
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Menu

Check or uncheck this button for each style to control whether the drop menu contains 
a representation of the particular style. Also available by right-clicking any style in the 
list.

Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Reserve buttons only for your most common styles. Also 
available by right-clicking any style in the list.

NOTE: Notice that this screen is resizable. If it is too narrow and cannot include the 
Edit, Button, and Menu controls, they remain available by right-clicking on 
a style.

Once you have selected the node style to create...

To create a new node
1. If the node style has a default size, the cursor becomes an outline of the node 

when you move the mouse over the diagram.
2. Use the mouse to position the new node.
3. Press the mouse button.
4. If the node has a default size and you want to create a node of this size, release the 

mouse button immediately. Otherwise, while continuing to hold the mouse button, 
resize the node to the desired size. Before releasing the mouse button, you can 
press ESC to cancel.

5. Release the mouse button
If the node has default text, the newly created node will contain the default text.

After selecting the node style, but before you actually click on the diagram to create it, 
you can use the property bar to change properties of the node that you are about to 
create such as the colors, font, text alignment and so on. Changes made in this way 
affect only the new nodes that you are about to create not the style definition.

Inserting a Symbol
Although the usual way to add nodes to your diagram is by creating them from a node 
style, there are also times that you just want to add a single node without first creating 
a new style. The Insert Symbol feature provides this capability.
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To insert a single node from the Node Symbol Gallery
1. In select mode, choose Insert Symbol from the Nodes menu or from the right 

click menu. Or press the Insert Symbol button on the tool bar.
2. Select any node symbol from the Node Symbol Gallery dialog box.
3. A new node with the selected symbol will appear on the screen. You may want to 

resize it and move it to a better location.

Changing the Size of Nodes
A node can be almost any size from a sixteenth of an inch to a hundred inches in height 
and width. As you’ve seen from the previous section, you can size a node as you create 
it. You can also change the size of an existing node.

To change the size of a node
1. Select the node.
2. Move the mouse over one of the eight handles (by default they are little red 

squares). The cursor’s shape indicates how the node will size with each handle.
3. Press the mouse button.
4. Drag the handle and resize the node to the desired size. If you decide to cancel at 

this time before releasing the mouse button, press ESC.
5. Release the mouse button.
How the node resizes depends on several things. If the node has the Center stationary 
when resizing property, then the node gets larger or smaller in all directions as you 
drag the handle, but the center stays in the same place. This is useful if you want to 
keep the node lined up with the center of other nodes above or below. If the node does 
not have this property, it extends only in the direction that you drag the handle. 
However, if the node has a vertical or horizontal path attached to it, the node will 
resize with the center remaining stationary even if it does not have this property. This 
is a feature to help keep your lines straight.

If snap is enabled and the node has the Height and width snap to grid property, the 
height and width can only change such that the edges of the node are positioned along 
snap grid lines. In effect, this means that the height and width will always be a factor of 
twice the snap spacing. For example, if the snap spacing is a quarter inch, the node 
width can be a half inch, one inch, one and a half inches and so on.

If the node contains text, you will not be permitted to resize the node such that it will 
be too small to contain the text. If the node has the word-wrap property, the text will 
reformat when you resize the node, in which case there is no minimum width.

There are also other ways to change the size of a node. When you type text in a node, 
the node can resize automatically. You can change the size of nodes by using the Make 
Same Size feature (see  Making Nodes the Same Size on page 56). You can also set the 
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54 Chapter 6: Nodes
height and width of nodes explicitly in the Node Properties dialog box (see  
Connections on page 58).
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Moving Nodes 55
Moving Nodes
There are several ways to move nodes from one place in a diagram to another. When 
you move a node, all text that is part of the node, all node labels, and all paths that are 
attached to the node move as well. 

To move a single node without first selecting it
1. Make sure you are in select mode.
2. Move the mouse over the node. The move cursor appears.
3. Press the mouse button.
4. While holding the mouse button down, drag the node to the new location.
5. Release the mouse button.
The procedure above works from seltext mode as well as from select mode. However, 
if you are in seltext mode, be sure that the cursor is actually over a node and not over a 
text area within the node before attempting to move it this way. You can tell that you 
can move the node when the move cursor appears.

To move one or more selected nodes
1. Move the mouse cursor over any selected node. The move cursor appears.
2. Press the mouse button.
3. While holding the mouse button down, drag the nodes to the new location. 

While dragging the nodes, you can cancel by pressing ESC before releasing the 
mouse button.

4. Release the mouse button.
There is also another way to move a group of selected nodes with greater control over 
precisely how much they move.

To move selected nodes more precisely (nudge)
1. Enter select mode.
2. Select one or more objects.
3. Press the up, down, right, or left arrow keys on the keyboard to move the objects a 

small increment in any direction.
The amount the objects move each time you press an arrow key depends on the snap-
to-grid diagram property (the button on the tool bar that resembles a rectangle over a 
grid). With snap enabled, each press of an arrow key moves the objects by a distance 
equal to the snap grid spacing. Otherwise, the objects move by one screen pixel.

There are also many indirect ways to move nodes such as aligning, centering on the 
page, spacing, and so on. You can also set the location of nodes explicitly in the Node 
Properties dialog box (see  Connections on page 58).
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Aligning Nodes

To align a group of nodes
1. Select the nodes.
2. Choose one of the selected nodes to be the model node, the node with which the 

other selected nodes are aligned. By default the last node selected is the model 
node. To force a different selected node to become the model node, hold down the 
SHIFT key and click on a different node.

3. Choose one of the alignment methods from the Align submenu under the Nodes 
menu.

4. All of the selected nodes are aligned with the model node using the chosen 
method. 

Making Nodes the Same Size
There are many aids for creating nodes with a uniform size. One way is to use the node 
style default size property. Another is to use the snap grid. Yet another is the Make 
Same Size feature.

To make a number of nodes the same size
1. Select the nodes.
2. Choose one of the selected nodes to be the model node, the node whose size 

indicates the size to make the other selected nodes. By default the last node 
selected is the model node. To force a different selected node to become the 
model node, hold down the SHIFT key and click on a different node.

3. Choose one of the sizing methods (Height, Width, or Both) from the Make Same 
Size submenu under the Nodes menu. 

4. All of the selected nodes will become the same size as the model node.

NOTE: There are cases where a node cannot be made the exact size as the model 
node. One example is a node that has more text than would fit if it were 
made as small as the model node. In this case, the node is made as small as 
possible.

Sizing Nodes to Text
A node can be no smaller than the text it contains. Occasionally you may want to make 
a node as small as possible for the current text. You can do this by dragging the node’s 
sizing handles, or more conveniently by using this feature.
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To adjust the size of a node to the text it contains
1. Select a node (or group of nodes).
2. Choose Size to Text from the Nodes menu. 
3. Each selected node will shrink to the smallest size possible for its text.

NOTE: If the snap grid is enabled and the node’s properties cause its height and 
width to snap to the grid, the node’s size may not be as small as possible to 
contain the text. If this is not the effect you want, turn off the snap grid first.

If you want a node to remain sized to its text automatically when the text changes, you 
can set its Keep sized to text property.

Spacing Nodes Evenly
The Space Evenly feature is useful for spacing nodes across the diagram or from top 
to bottom at equal intervals. 

To space a group of nodes evenly from left to right or top to bottom
1. Select at least three nodes.
2. Choose either Across or Down from the Space Evenly submenu under the 

Nodes menu. And choose whether to space the nodes evenly based on their 
centers, a particular edge, or based on the spacing between them.

3. The selected nodes will be spaced evenly from right to left if you chose Across, or 
top to bottom if you chose Down. 

The spacing is determined by the average spacing between the right-most and left-most 
of the selected nodes (in the across case), therefore the left-most node does not move. 
The left-to-right or top-to-bottom ordering of the nodes does not change.

Spacing these nodes evenly across (using centers)... 

Produces this result: 
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58 Chapter 6: Nodes
Centering Nodes on the Page
This feature can center a group of nodes on the page, length-wise, width-wise or both. 
This feature is available if the Show Page Boundaries option is enabled.

To center nodes on the page
1. Select a number of objects (not necessarily only nodes).
2. From the Center on Page submenu under the Nodes menu, choose one of the 

centering options.
3. All selected objects are centered as a group on the current page.
Note that when you center many objects on the page, they do not all end up overlapped 
at the center of the page. Rather, they are centered as if they were one larger object (as 
a group). This feature is especially useful for final formatting of your diagram. For 
example, when your diagram is complete, you can Select All and then Center on 
Page, neatly centering your entire diagram on the page for printing.

The page referred to here is actually the active sheet which might not be the same as a 
printed page. Any subsequent change to Page Set-up that affects page size or 
orientation may necessitate re-centering your diagram.

Connections
Nodes can have paths attached to them. Paths and their usage is described fully in the 
following chapter. This section describes the properties of nodes that affect 
connections.

Center connections
Most all nodes support center connections. In a standard center connection, a path 
attaches to a nodes at its center point and remains attached there if the node moves or 
the orientation of the path changes. While the path attaches to the center of the node, it 
actually terminates at the edge of the node where its end symbol drawn as well.

Connection points
For added flexibility, node may have connection points in addition to the center of the 
node or in its place. A connection point is an alternate point within the shape where 
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Connections 59
paths can attach.You can set connection points for nodes and node styles and attach 
paths to them. 

Setting Connection Points
You can set connection points for a node by going to the node’s properties dialog box 
(double click on the node or choose Properties from the right click menu) and select 
the Connections tab. You can set connection point in the same way in a node style.

Connection Point Tool
An additional method for setting the connection points of a node is to use the 
connection point tool. The connection point tool is a special mode that lets you add, 
move, and remove connection points right on the node in your diagram.

To use the connection point tool, click on the icon in the tool bar. The cursor will 
change to a small hand. When you are done editing connection points you can quit 
using the connection point tool and return to another mode by clicking on the select 
mode button or any of the usual alternate modes.

Adding Connection Points with the Connection Point Tool

To add new connection points to a node using the connection point tool, move the 
mouse over the node and click (or right-click and choose Add Connection Point from 
the menu). Right click on the new point and choose Connection Point Properties to 
add a name or description for the new point.

Moving Connection Points with the Connection Point Tool

To move a connection point using the connection point tool, position the mouse over 
the connection point so that it is highlighted. Then click and drag the connection point 
to a new location. Use the snap grid to help by clicking on the Snap Grid On/Off 
toolbar button.

Deleting Connection Points with the Connection Point Tool

To delete a connection point using the connection point tool, position the mouse over 
the connection point so that it is highlighted. Then right-click on the connection point 
and choose Delete Connection Point from the menu.

Sample uses for connection points
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60 Chapter 6: Nodes
After making changes to the connection points of a node, you can update the node 
style to reflect the new connection points. To do so, exit the connect point tool, right 
click on the node, and choose Update Style From. This will update the style and all 
other nodes of the style.

Connection Point Options
There are several options that let you control the use of connection points in your 
diagram. In addition to the ability to add, move, and delete connection points from 
nodes, there are options to control how they are used for connections, how they appear 
on the screen, and how they are indicated on output. Each of these is covered in detail 
elsewhere:

By selecting different attach methods (from the Paths menu), you can choose to 
attach to connection points, or ignore them while creating paths.
You can control how the connection points appear (on the screen) by turning them 
on or off from the View tab of the Options dialog box, and set their color in the 
Colors tab of the Options dialog box.
You can control whether the point where a path attaches to a connection point is 
marked with a dot (on screen and output), by setting Dots where paths attach to 
connection points in the Diagram Properties dialog box.
By choosing different options within the Connections tab of the Node Properties 
(and Styles) dialog boxes, you can control whether only the connection points are 
attached to (i.e., not the centers of the node) and whether connections to connect 
points extend all the way to the connect point or terminate at the edge of the node.

Reshaping Nodes
Certain nodes (but not all of them) can be reshaped after you add them to your 
diagram. Reshaping a node lets you adjust it to more precisely control its appearance.

To reshape a node
1. Select the node. If the node can be reshaped (not all can), it will have one or more 

yellow diamond-shaped reshape handles.
2. Click on and drag the reshape handle to adjust the shape. 
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Multiple Text Areas 61
To update the style to the new shape
If you update the style to the same shape as the newly reshaped object, other objects 
that you create using the same style will initially have the same shape. To do so, right 
click on the object after you have reshaped it and choose Update Style From... in the 
right click menu.

Reshape handles are yellow by default. However, you can customize this color from 
the Colors tab in the Options dialog box (see Tools menu).

If a node has multiple text compartments that are reshapable, the text areas adjust 
automatically with the reshaping of the node (see the following section).

Multiple Text Areas
Some nodes contain multiple areas for text, are also known as compartments in UML.

Generally, nodes that contain multiple text areas are reshapable to allow you to select 
different sizes for each area. When you reshape them (see the shaping section), the text 
areas reshape automatically. If the text area already contains text, reshaping will not be 
permitted if it would result in an area too small to contain the text.

Justification within text areas
Text in each area can be justified independently. For example, in one area the text can 
be centered and in another it can be left-justified (as show in the example above). If 
you are in text mode editing the text within a particular text area and you press one of 
the justification control buttons on the toolbar, the justification for only that area will 
change. If you leave text mode, select the node, and choose a justification, all text 
areas of the node will change to the new justification. You can also set justification by 
using the Text tab of the Node Properties dialog box.

Barry Smith

24 Center St.
555-1223
Age: 44

102 Accounting
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62 Chapter 6: Nodes
Containers
A container is a shape in your diagram that shows a group of objects, a subset, or some 
other collection or separation. The illustration below shows a portion of a diagram 
surrounded by a container.

There are three ways to add a container to a diagram. The first and easiest way is to 
choose a style from the current diagram template. If the template has a Containers 
category in the Nodes drop-down menu in the style bar, as the UML templates do, 
simply select it and place it on your diagram as you would any other node shape.

If the template you are using does not include predefined container styles, the next 
easiest method is to invoke the Insert Node / Icon feature to insert a predefined 
container symbol from the Node Symbol Gallery.

A container - a shape added to a 
NODE 1 

NODE 2 

diagram to illustrate a grouping or
collection.
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Containers 63
To insert a container from the Node Symbol Gallery
1. Without objects selected, right click on your diagram and select Insert Node / 

Icon. Or choose the Insert Node/Icon feature from the Nodes menu. The Node 
Symbol Gallery dialog box appears.

2. Select the Containers or UML Containers category. The large window displays 

the pre-defined container shapes. Notice that containers are indicated by brackets 
surrounding their names.

3. In the large window, select a container shape and click OK.
4. Size and position the new container in your diagram.
5. Optionally, right click on the new container and toggle Active Container to 

activate the container so that objects within the container are kept together with 
the container (see below).

If you require a container of a shape that is not included in the template or the gallery, 
you can create one of your own based on any existing node symbol.

To create your own container from any node symbol
1. Create any shape in one of the usual ways such as by using the Insert Node/Icon 

feature from the Nodes menu. 
2. Enlarge the shape and move it to the back of the diagram.  

This method has some drawbacks. Most notably, the software will still treat the inside 
of the container as part of a node making it a nuisance to select and connect objects 
within the container. To complete the construction of a container from any shape, 
adjust the node properties as follows:

3. Remove the fill color by selecting the shape and choosing the “x” from the fill 
color drop menu. A node with no fill color is treated as transparent. For example, 
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64 Chapter 6: Nodes
you will be able to select and manipulate objects that are “beneath” the container. 
A node that does not have a fill color can only be selected by clicking on its border 
or lassoing the whole object. 

4. Hide the text areas of the container object. Do this by clicking the “Hidden” box 
in the Text tab of the Node Properties dialog box - repeat for each text area if there 
is more than one in the node. Hiding the text areas is an important step because 
text areas are selectable even when there is no fill. The result is that non-hidden 
text areas prevent you from selecting objects beneath the container (even if the 
text is blank).

5. Choose stylistic attributes. For example, you will often want a dashed or dotted 
container. Do this from the General tab of the Node Properties dialog box.

6. Adjust behaviors for greater convenience. Do this from the Behaviors tab in the 
node properties dialog box. We suggest the following settings: 
(a)Horizontal expansion = Expand to right 
(b)Vertical expansion = Expand down 
(c)Center stationary when resizing = unchecked 
(d)Center snaps to grid = unchecked 
(e)(optional) Active container - keep contained objects together = checked

Active Containers - Keeping Objects Together
The last behavior suggested above is recommended when using containers in their 
prescribed manner. The “Active container“ behavior adds great power and simplicity 
to containers elevating them beyond drawing objects.

Containers with this property automatically keep any objects that are positioned within 
their bounds together for simple operations. If you move the container, all objects 
inside move along. If you copy it, the objects inside appear in the copy as well. If you 
delete it, the objects are removed. You can move individual objects into and out of the 
container simply by dragging them, but drag the container and them stay together.

Note, if the container is filled, only objects on top of the container are kept together. If 
it has no fill, all objects above or below are kept together.

It might seem that this behavior resembles a group (see Groups chapter). For simple 
operations like moving, copying, deleting, and so on, it is much like a group. However, 
it is more limited than a group and therefore more convenient for this purpose. For 
example, unlike a group, you never have to use the Group or Ungroup commands to 
change the contents, plus you always have full access to the included objects without 
having to ungroup first. Unlike a group, resizing a container expands it bounds rather 
than scaling it.
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Nodes in Flows 65
Nodes in Flows
Nodes within flows have some special features and behaviors to support this common 
usage. A flow is a sequence of nodes connected by paths such that the path enters a 
node, then exits it, enters another, exits that one, and so on. Flows commonly represent 
sequences of operations and hierarchies of relationships. For example, the following 
arrangements of nodes and paths are considered flows:

You do not need to identify a flow. The program will recognize these relationships and 
behave accordingly. For definition purposes, a node is considered to belong to a flow if 
it has two attached paths of the same style. Several features make it very easy to add a 
new node at any point in a flow, remove a node from a flow, or re-arrange the nodes of 
a flow.

Creating a node in a flow
During the normal process of adding a node to a diagram, you can insert it into an 
existing flow by dropping it on a path.

To create a node inserted within a flow
1. First verify that the “Snap nodes to flow” option is enabled (see the 'Edit' options 

within the Tools Options screen).
2. Begin the creation of a node in the usual way by choosing a node style and 

entering in to create mode.
3. Move the node cursor over an existing path such that the center point of the node 

marked by cross hairs is directly over the path. When you are directly over the 
path and there is room to insert the node into the flow the portion of the path 
beneath the node cursor will disappear.
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66 Chapter 6: Nodes
4. Click to create the node. The path will now enter and exit the new node. You can 
also resize the node before letting go of the button, just make sure there is still 
enough room to insert the node.

If the path is not vertical or horizontal you may need to disable the snap grid in order to 
position the cursor correctly over the path.

While in create mode, pressing the CTRL key triggers freeform creation. With the 
CTRL key held down, the path beneath the node cursor will not be recognized and 
creating a node will not insert it into the flow even if you click on a path.

Before you can insert a node into a flow you must make sure there is room available 
for the new node. This may mean extending or re-arranging parts of your diagram. For 
there to be enough room, there has to be ample room on a single segment so that no 
junctions that make up the path are beneath the new location of the node.

Attaching a node to a flow
Another method for inserting a node into a flow is to drag a node from elsewhere in 
your diagram into the flow.

To attach an existing node to a flow
1. First verify that the “Snap nodes into flows” option is enabled (see the 'Edit' 

options within the Tools Options screen).
2. Click on a single node to begin dragging it (you may select it beforehand or drag it 

without selecting it).
3. Move the node over an existing path such that the center point of the node marked 

by cross hairs is directly over the path. When you are directly over the path and 
there is room to insert the node into the flow the portion of the path beneath the 
node cursor will disappear.

4. Drop the node on the path. The path will now enter and exit the node.
If the path is not vertical or horizontal you may need to disable the snap grid in order to 
position the node correctly over the path.

While dragging, pressing the CTRL key keeps the drag freeform. This means that you 
can drop the node anywhere, including on a path, and the node will not be inserted into 
any flow.

Before you can insert a node into a flow you must make sure there is room available 
for the new node. This may mean extending or re-arranging parts of your diagram. For 
there to be enough room, there has to be ample room on a single segment so that no 
junctions that make up the path are beneath the new location of the node.
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Changing Node Properties 67
Detaching a node from a flow
Any node that is in a flow (having two paths of the same style) can be detached from 
the flow. When you detach a node from a flow, it will be free to move around without 
the attached paths. In addition the paths will join to continue the flow without the 
detached node.

To detach a node from a flow
1. Right click on the node and select Detach from Flow from the menu. 

Note that if the path was vertical or horizontal, the paths will merge into a single 
continuous segment. However, if they were not vertical or horizontal, a new junction 
will appear in place of the node’s old position in the flow. You can delete this junction 
by right-clicking on it and selecting Delete Junction.

Deleting a node from a flow
Whenever you delete a node in the usual way, it will be automatically detached from 
its flow first. To delete the node AND all attached paths, select the paths as well as the 
node when deleting.

Changing Node Properties
Each node has a set of properties that define how it looks, what text it contains, how it 
behaves, and more. Most of the initial properties of a node come from its original node 
style. This section describes how to change the node properties of an existing node.

To view and modify the properties of a node
1. Select the node.
2. Choose Properties from the Nodes menu or from the right mouse button menu.
or

1. Double click on the node. Note, double clicking on a node will edit the node 
properties only if you have chosen Display/edit properties in the 'Edit' options 
within the Tools Options screen.

The Node Properties dialog box appears on the screen near the selected node. This 
dialog box contains several different groupings of properties organized under tabs with 
an appropriate heading. To change to a different grouping of properties and their 
controls, press the corresponding tab. Controls located under each tab are described 
below.

Once you’ve set all of the properties of the node that you want to change, press one of 
the following buttons:
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68 Chapter 6: Nodes
Apply

Applies the property changes to the selected node or nodes without exiting the dialog 
box.

OK

Applies the property changes to the selected node or nodes and exits.

Cancel

Exits the dialog box and discards any changes you made since last pressing the Apply 
button. Once you apply changes, those changes remain in effect even if you press 
Cancel.

Changing properties for multiple nodes
You can change a property, or any number of different properties, for a number of 
nodes at the same time. To do so, select the nodes and use the dialog box as usual. 
Only the properties you actually modify will be applied to the selected objects. For 
example, if you select five nodes that all have different heights and widths, and you 
edit their properties and change only the Width field, all five nodes will acquire the 
new width and retain their previous height.

NOTE: Several node properties can also be changed simply by selecting the node(s) 
and clicking on the buttons and controls on the property bar or under the 
Node menu. These are simply shortcuts to the same changes in the Node 
Properties dialog box.
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Changing Node Properties 69
Node Properties: General
Use the General tab in the Node Properties dialog box to view and edit the basic 
properties of the selected node such as its location, size, appearance, and color.

Based on style

To change the node’s style, choose a new style from the combo box or the style drop 
menu located to the left. This will change the appearance of the node and it will inherit 
all the properties from the new style you choose.

For example, use this control if you created a box and later determine that it should 
really be a circle.

Styles

This button is just a drop menu to choose a style graphically for the same purpose as 
Based on style described above.

Left

To change the position of the node, enter a new location for the left-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the left edge of the page (positive measurements are to the right). 
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70 Chapter 6: Nodes
Top

To change the position of the node, enter a new location for the top-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the top edge of the page (positive measurements are downward).

Width

To change the width of the node, enter a new width here.

Height

To change the height of the node, enter a new height here.

Text color

To change the color of the node’s text, choose a different color from the color selection 
drop menu. 

Border color

To change the color of the node’s border, choose a different color from the color 
selection drop menu. 

Fill color

To change the color of the interior of the node, choose a different color from the color 
selection drop menu. 

Bind to style

Check this box to choose whether or not a node’s properties are bound to the style. If a 
node’s properties are bound to its style, then anytime the style changes, the node gets 
the new properties automatically. 

Border width

To change the thickness of the lines that make up the border (outline) of the node, 
enter a new border width. You can also change the border width by pressing the up and 
down spin buttons to the right. Or you can choose one of the standard border widths by 
pressing the Width drop menu button itself.

Line Pattern

Select a line pattern for drawing borders such as solid, dashed, dotted, and so on. The 
line style is used to draw for the entire outline of the shape, not just the outside edges 
so consider carefully before using a pattern other than solid. Also note that some older 
shapes cannot use this property.

Drop Shadow

Check this box to add a drop shadow to the node to give it a three-dimensional look. 
You control the size and color from within the Diagram Properties dialog box (see 
page 218).
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Changing Node Properties 71
Select or change shape
The remainder of the controls in the General tab of the Node Properties dialog box 
allow you to change the shape of the node. 

Symbol from Gallery

Press this button to select a shape from the collection of built-in symbols contained in 
the Node Symbol Gallery. 

Graphic from File

Press this button to select a graphic for the node from an external graphics image file 
such as a Windows Metafile (.WMF or. EMF) or a Windows bitmap file (.BMP 
or.DIB). 

Graphic from Clipboard

Press this button to select a graphic for the node from an image that is stored in the 
Windows clipboard. For example, you can create an image in Microsoft Paintbrush 
and do a Copy of it, then return to this program and paste it right into a node.
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Node Properties: Text
Use the Text tab of the Node Properties dialog box to view and edit the node’s text and 
the properties of the node that affect the display and format of the text.

Text box

This area shows a model of the shape of the node. The dotted rectangles show the 
boundaries of the text region(s) in the node. If the node shape contains more than one 
text region, the arrows control which region is selected and marked by a dark gray 
dotted box.

Text

The text control to the right of the model displays the text that is contained in the node 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
node itself. Furthermore, if you edit the text here, you will lose all embedded font 
controls. For example, if the text as a whole was not bold but you had bolded one 
word, then if you edit the text through this edit box, that bold word along with the rest 
of the text in the node will revert back to the node font attributes shown in this dialog 
box.
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Changing Node Properties 73
Hidden

When checked, the selected text area is hidden and cannot be edited on-screen. Hiding 
text areas is useful when creating transparent shapes that have outlines but no fill. To 
make a shape completely transparent you need to use a null fill and make the text areas 
hidden, otherwise objects beneath the shape will not be selectable.

Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Text color

To change the color of the node’s text, choose a different color from the color selection 
drop menu. 

Ellipsis (...)

Use the common font control to select a font, point size and text styles.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Margin

Select the internal text margin, the spacing between the text and the edges of the shape. 
Note that some shapes do not support fixed margins in which case their margins scale 
with the size of the shape.
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Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. Controls in this dialog are self-
explanatory.
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Node Properties: Connections
Use the Connections tab of the Node Properties dialog box to view and edit the node’s 
connection points and properties.

Connection points

This area shows the location of any connection points within the node. One connection 
point is always selected and highlighted. You can use the mouse to drag and reposition 
connection points, select a different point. or right click to delete a connection point or 
add a new one. The arrow buttons cycle through the selected connection point. The 
Add button adds a new point, and the Delete button deletes the highlighted point.

Name or Description

Each connection point can have a name or description. Use this control to view and 
edit the name of the selected connection point.

Remove when not in use

When a connection point is added during the creation of a path using the click point 
attach method, it is temporary by default and will remove itself when all attached paths 
are deleted. Using this control, you can make such a connection point permanent.
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76 Chapter 6: Nodes
Snap to center and edges

Check this box to have the mouse snap to the centers and edges of the node while you 
drag a connection point with the mouse (in this dialog box).

Snap to grid

Check this box to have the mouse snap to the diagram grid while you drag a 
connection point with the mouse (in this dialog box).

Terminate connections to connection points at border

Check this box to cause connections to terminate at the border of the node rather than 
extending all the way to the connection points. 

Enable standard center connect (terminated at border)

Check this box to enable paths to attach at the center of the node. This option is useful 
if you have a node with connection points. You can choose to allow paths to attach 
only at the connection points, or to the node center also.
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Changing Node Properties 77
Node Properties: Behaviors
Use the Behaviors tab of Node Properties dialog box to view and edit the properties 
that affect the way the node behaves within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the node. If 
set to Prevent, additional characters are not allowed. If set to Expand, the node 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the node 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the node expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the node. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a node of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the node automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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78 Chapter 6: Nodes
Vertical expansion

This property controls in which direction the node expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the node.

Horizontal center snaps to grid

Check this property to cause the node's horizontal center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for nodes that are connected to other nodes as it will aid in keeping nodes 
aligned horizontally.

Vertical center snaps to grid

Check this property to cause the node's vertical center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for nodes that are connected to other nodes as it will aid in keeping nodes 
aligned vertically.

Width snaps to grid

When this property is checked (and the snap grid is enabled), the node's width remains 
an even multiple of the snap grid when you resize the node. 

NOTE: When the height and width snap to the grid, both sides are aligned with snap 
grid lines which are not necessarily the same as the visible grid lines. In 
effect, the total width or height is always a multiple of twice the snap 
spacing. For example, if the snap spacing is one quarter of an inch and a 
node has the Width snaps to grid property, that node width can be 1/2 in., 1 
in., 1 1/2 in. and so on, but it cannot be 3/4 in. 

Height snaps to grid

When this property is checked (and the snap grid is enabled), the node's height remains 
an even multiple of the snap grid when you resize the node. 

Left and right edges snap to grid

When this property is checked and the snap grid is enabled, the node's left and right 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default 
size without intentionally resizing it.

If the node’s width is not an even multiple of the snap grid and you drag the node, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the node. In this case, either edge (the one that is closest) is aligned to the grid. 
And if the center is closest to the grid and Horizontal center snaps to grid is also 
enabled, the node can snap there as well. There are also cases where the node is 
allowed to snap in other positions to help keep lines straight. If the node’s width is not 
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Changing Node Properties 79
an even multiple of the snap grid and you resize the node by dragging a resize handle, 
only the edge that the handle is on (the one you are dragging) aligns to the grid. To 
resize it so that both edges are aligned to the grid, resize it using both the left handle 
and the right handle.

This property and Horizontal center snaps to grid are mutually exclusive. Only one 
can be in effect. This property is most useful when Center stationary when resizing 
horizontally is disabled.

Top and bottom edges snap to grid

When this property is checked and the snap grid is enabled, the node's top and bottom 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default size 
without intentionally resizing it.

If the node’s height is not an even multiple of the snap grid and you drag the node, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the node. In this case, either edge (the one that is closest) is aligned to the grid. 
And if the center is closest to the grid and Vertical center snaps to grid is also enabled, 
the node can snap there as well. There are also cases where the node is allowed to snap 
in other positions to help keep lines straight. If the node’s height is not an even 
multiple of the snap grid and you resize the node by dragging a resize handle, only the 
edge that the handle is on (the one you are dragging) aligns to the grid. To resize it so 
that both edges are aligned to the grid, resize it using both the top handle and the 
bottom handle.

This property and Vertical center snaps to grid are mutually exclusive. Only one can 
be in effect. This property is most useful when Center stationary when resizing 
vertically is disabled.

Center stationary when resizing horizontally

Check this property to cause the center of the node to remain in the same place when 
you resize it horizontally by dragging the handles. 

This property is useful when nodes are lined up vertically one on top of the other and 
potentially connected by a single path from the horizontal center of one node to the 
horizontal center of another above or below it. With this property, the node will remain 
aligned with the others if it is resized horizontally. 

Center stationary when resizing vertically

Check this property to cause the center of the node to remain in the same place when 
you resize it vertically by dragging the handles. 

This property is useful when nodes are lined up horizontally one alongside the other 
and potentially connected by a single path from the vertical center of one node to the 
vertical center of another to its right or left. With this property, the node will remain 
aligned with the others if it is resized vertically. 
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80 Chapter 6: Nodes
Keep sized to text

When this property is checked, the node is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a node such that the node has less text 
than it had before, the node will automatically resize itself to shrink down around the 
new text as soon as you complete editing the text.

This property is primarily useful for labels. Used with non-labels, it can cause 
confusion.

Preserve aspect ratio

When this property is checked, the node retains its current aspect ratio (its height 
compared to its width) when you resize the node by dragging the corner handles or 
when the node expands due to typing text. You can still change the aspect ratio of the 
node by dragging the side handles, setting the size directly in the General tab, or using 
the From Selected button.

Automatic Text Scaling

When this property is checked, the node text scales automatically when you resize the 
node. Objects having this property always maintain a fixed aspect ratio (height vs. 
width) over-riding the Preserve Aspect Ratio property.

Do not print or export

When this property is checked, the object will not appear in print-outs or when the 
diagram is copied or exported. This property is useful for hiding objects that exist only 
for visual notation on the screen, and for implementing hyperlinks to other diagrams or 
documents.

Active container - keep contained objects together

When this property is checked, the node serves as a container object that automatically 
keeps objects contained within its bounds together as a unit. Moving the container 
results in moving along the contents. Copying the container copies the contents. 
Deleting the container deletes the contents, and so on. Note, if the container is filled, 
only objects on top of the container are kept together. If it has no fill, all objects above 
or below are kept together.

This property is usually set along with others for the purpose of creating a container, a 
special type of node that identifies a subset of your diagram (see  Active Containers - 
Keeping Objects Together on page 64).
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Changing Node Properties 81
Node Properties: Fill
Use the Fill tab of the Node Properties dialog box to view and edit the node’s fill 
properties.

Linear gradient view.
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82 Chapter 6: Nodes
Elliptical gradient view:

Fill method

Select the type of fill. The remainder of controls on this screen depend on which 
method is selected.

Color

A single color control is available when the fill method is 'Solid color'. Use this control 
to select the solid fill color.

From/To

The 'From' and 'To' color selection controls are available when the fill method is 
'Linear gradient' or 'Elliptical gradient'. Use these controls to select the start and end 
colors that are blended across the gradient.

Blend

The 'Blend' control is available when a gradient fill method is selected. Use this 
control to choose how the 'From' color is blended into the 'To' color across the 
gradient. Linear blend means simply that the 'From' color is blended uniformly into the 
'To' color. When 'Bell curve' is selected, the 'From' color blends into the 'From' color 
based on a normal distribution bell curve contributing to a natural 3D shading effect. 
When 'Platform' is selected, the gradient begins with the 'From' color, gradually blends 
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Changing Node Properties 83
to a color midway between 'To' and 'From', remains constant for a certain distance, and 
then blends to the 'To' color.

Angle

The 'Angle' control is available when the linear gradient fill method is selected. Use 
this control to select an angle for the blend. For cylindrical blends, angles of 180 or 
greater cause the swapping of the 'From' and 'To' colors.

Intensity

The 'Intensity' control is available when a gradient fill method is selected. Use this 
control to select how prominent the 'From' color appears in the blend. A value of 100 is 
most intense, while a value of zero makes the 'From' color undetectable. Intensity is 
most useful when used with a white or black 'From' color in order to achieve a gradient 
between two shades of the same color but without having to actually choose two 
shades of the color separately.

Center

The 'Center' control is available only with the linear gradient fill method. Use this 
control to position the midpoint of the gradient from 0 to 100. If the 'Blend' is set to 
'Platform' this control affects the size of center rather than the position.

X Offset, Y Offset

These controls are available only for the elliptical gradient fill method. Choose values 
from 0 to 100 to position the center of the elliptical gradient anywhere on the node. An 
off-center elliptical gradient produces a 3D appearance.

Spread

This control is available only for the elliptical gradient fill method. Choose a value 
from 0 to 100 to increase the size of the center region of the gradient.

Presets

Choose a preset fill as a shorthand for popular combinations of the above options. 
Presets combine all of the fill properties except for the 'To' color which is 
independently controllable.
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84 Chapter 6: Nodes
Node Properties: Tabs
Use the Tabs tab of the Node Properties dialog box to view and edit the node’s tab 
stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.
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Changing Node Properties 85
Clear

Click to remove the highlighted tab stop from the tab stop list.

Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a node must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.
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Node Properties: Memo
Use the Memo tab of the Node Properties dialog box to view and edit the node’s memo 
text. Memo text contains any information you would like to attach to the node. It is 
displayed in a text balloon (tooltip) when you hover the mouse over the node while in 
select mode.

Memo Text

Enter the memo text. It can contain line breaks, but not formatting such as bold, 
underlines, italics, or different fonts or type sizes.
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CHAPTER
7 PATHS

Paths represent connections, control flow, and similar relationships between nodes. A 
typical path is a line between two nodes. Each end of a path can have a symbol or 
geometric shape called a terminator (for example an arrowhead). A path can have multiple 
straight segments that bend and turn corners, and each segment can have an attached label. 
Paths can be straight, curved, smoothed, arced, or they can have rounded corners. They can 
be solid lines, or broken lines of different patterns.

A path has a number of attributes or properties. Like nodes, paths have stylistic properties 
such as color and thickness. The initial properties of a path come from the path style used to 
create it.

About paths...

A single node may have any number of paths to other nodes.
Paths remain attached to the nodes they connect, even when those nodes move. 
A path need not be connected to a node at either end. 

This chapter covers the properties, behaviors, and features that are unique to paths. There 
are also many operations not covered in this chapter that can affect paths as well as other 
types of objects (see  CHAPTER 3: General Editing,  page 27). 

A path connects 
two nodes 

Update backup 
database cocurrently

Custom er

name: String
phone: String

add(name,phone)
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88 Chapter 7: Paths
Choosing an Attach Method
The attach method controls how paths connect to nodes when you click on the node in 
connect mode. Select an attach method from the Paths menu. The attach method 
applies only when you are creating a path. Once it is created, changing the method 
does not affect whether it remains attached or where it attaches. 

The following attach methods are available:

Freeform (no attach)

With this attach method objects are ignored. The path begins where you first click 
the mouse and terminates where you double-click, not becoming attached at either 
end. This method is helpful for free drawing such as adding an arrow pointing 
from one part of a diagram to another rather than from one node to another. You 
will want to set this attach mode only when you are doing a lot of freeform 
connections. Normally, you can use the CTRL key to temporarily switch to 
freeform.

Centers

With this attach method, paths attach to the centers of nodes. The path extends 
from the center of the first node that you click on, to the center of the second node 
you click on. Even though the paths are attached to the center, they still terminate 
at the border of the node for drawing purposes. When using this attach method, 
SHIFT key temporarily switches to the Click Point method described below, and 
the CTRL key temporarily switches to freeform.

Click Point

With this attach method, paths attach to nodes at the point where you click. A 
temporary connection point appears where you click. (However, “Use Connection 
Points” does not need to be enabled.) When clicking on a node to initiate or 
terminate a path, a form of snap gravity is used to snap to the center, the 
horizontal and vertical axes, and the edges. If the snap grid is enabled, click points 
can only occur on the grid or at a gravity point. When using this attach method, 
the SHIFT key temporarily switches to the Centers attach method described 
above.

Use Connection Points

This option affects how paths attach to nodes independent of the attach method. 
Nodes can have connection points either in their original definition or ones that 
you add. When this option is enabled, connection points are visible and enabled 
with any of the attach methods other than freeform (which doesn’t attach 
anything). 
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Creating Paths 89
Creating Paths
The most common way to add a path to your diagram is to choose a path style that 
represents the shape and initial properties of the path object you are creating. This 
moves you into connect mode where you attach the path to nodes in your diagram.

There are several methods for choosing a path style. All are located in the Paths area of 
the style bar. The Paths style bar area contains three types of controls, all of which 
select a path style in a different way.

To choose a path style and initiate connect mode
Perform one of the following:

1. Click on the button in the style bar that represents the path. If the style does not 
have a button, use one of the following methods instead.

or

2. Press and hold the Paths button in the style bar to activate the path style drop 
menu. Move to the representation of the style, and release the mouse button. Not 
all styles are displayed in this menu so you may have to choose the three dots to 
see all of them (see the next section).

or

3. Choose the path style by name from the path style combo box. The combo box 
always contains all styles defined in the diagram.

Path style drop menu 
Path style combo box 
Path bar buttons 
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90 Chapter 7: Paths
Method 4: Choosing a path style from the complete list of styles
To view all path styles with names, pictures, and descriptions and to choose which 
styles appear on buttons and in drop menus, select the ellipsis (three dots) from the 
Paths drop menu to open the Choose a Path Style dialog box.

To choose a path style
Scroll to preview all of the available styles and click on the style to select it. Then 
press OK or double-click on the style.

Edit

While you’re here you may want to add, change, or delete styles from your diagram. 
This button just provides a convenient shortcut to the Styles dialog box. Also available 
by right-clicking any style in the list.

Menu

Check or uncheck this button for each style to control whether the drop menu contains 
a representation of the particular style. Also available by right-clicking any style in the 
list.
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Creating Paths 91
Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Reserve buttons only for your most common styles. Also 
available by right-clicking any style in the list.

NOTE: Notice that this screen is resizable. If it is too narrow and cannot include the 
Edit, Button, and Menu controls, they remain available by right-clicking on a 
style.

Once you have selected the path style to create...
The connect cursor indicates you are in connect mode.

Though will be normally skip ahead to the step below, this is a point where you may 
choose to deviate from the path style you chose. In connect mode (after selecting the 
path style) you can use the property bar to change properties of the paths that you are 
about to create. For example, you may want this particular path to be red. You can 
select red as the path color using the path color property bar button. The path that you 
next create will be red. Changes at this point do not affect the style definition, only the 
properties of the new paths.

To connect two nodes with a path
1. Enter connect mode by choosing a path style from the style bar.
2. Move the connect cursor over a node. The cursor changes from a white arrow to 

black indicating that you are about to connect to a node.
3. Press the mouse button. You can either release the mouse button immediately or 

keep it pressed until step five.
4. Move the mouse until it is over the second node. The cursor color (white or black) 

indicates whether you are over the second node.
5. Click the mouse button again (or release it for the first time). A path of the style 

you chose now connects the two nodes.

NOTE: To create only orthogonal paths composed of lines that are all vertical or 
horizontal only, hold down the ALT key while creating the connections.

To create an unattached path
1. While in connect mode, move the mouse cursor to a position NOT over a node. (If 

you select Freeform attach mode or hold CTRL, it doesn’t matter whether you are 
over a node.) The white connect cursor indicates that you are not over a node.

2. Press the mouse button. You can either release the mouse button immediately or 
keep it pressed until step four.
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92 Chapter 7: Paths
3. Move the mouse to the point at which you want the other end to terminate (not 
over a node, or holding the CTRL key).

4. Double click the mouse to force the end of the path.
When creating a path, you also have the option of attaching either end of the path to 
the middle of a previously existing path.

To connect to another path
Create the path as described above but click either end on an existing path. The 
previous path is split in two and a junction is created with the new path.

Segmented Paths and Junctions
A path can be more than a simple straight line. It can have multiple straight segments 
that meet at junctions (vertices) where the path can turn and bend along its path.

To create a multi-segment path
Create a path by any of the methods described in the previous section. Instead of 
clicking the end in a node or path, click on the diagram (not above another object, but 
do not double click or the path will terminate.) A junction appears and a new segment 
of the path forms. Add up to fifty segments this way. Finally, click on a node or double 
click to terminate the path.

NOTE: Arced paths are special because they are normally composed of a single 
segment with a control point that defines the path of the arc. When creating 
an arc, you can click to position the control point as if you were defining a 
junction of a segmented path. However, the control point that you define in 
this manner is not actually a junction and you cannot click multiple times to 
add more control points. If necessary you can manually create arced paths 
with more than one segment, but to do so you need to first create different 
type of segmented path (such as straight), then change it to arced and adjust 
each segment manually.

To select a multi-segment path
Select a multi-segment path just like any other object (see  Selecting and Deselecting 
Objects on page 27). If you select any segment of a path or any junction of a path, the 

A path with three segments and two junctions. 

Fig. 1 Fig. 2 

junctions 
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Segmented Paths and Junctions 93
entire path (all segments) becomes selected. However, all junctions do not necessarily 
become selected. 

The following diagram shows a multi-segment path that has been selected by clicking 
on the left-most junction. Notice that the entire path is selected. Also notice that the 
left junction is selected but not the one on the right. Selected junctions are indicated by 
four corners of a small red box.

If we were to choose Cut or Delete after selecting the above path as shown, the entire 
path above would be deleted including all segments and all junctions (not only those 
that are selected).

You can always re-arrange the path by dragging any of its handles. If however, you 
drag a selected junction, all selected junctions and nodes move together. The following 
diagram shows what happens when you select the left junction and the left node then 
drag either.

A path that has been selected by clicking on the left junction. 

Fig. 1 Fig. 2 

selected
junction 

the entire path (all segments) 
is selected 

The effect of dragging a selected junction plus a selected node 

Fig. 1 Fig. 2 

Fig. 1 

Fig. 2 
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94 Chapter 7: Paths
Curved Paths
The previous section described how you can create paths that have multiple straight 
segments that can be created to wind around a diagram from one node to another. 
Multiple-segment paths can also be curved. Curved paths can be of four types: simple 
curved, smoothed, rounded, or arced. All can have multiple segments, though arcs 
typically have just one. Each is illustrated below: 

Arcs are special because they typically have only a single segment and they are 
defined by a control point drawn as an open circle rather than by a series of junctions. 
All other curved paths require at least one junction. If no junctions are included to 
define the path of a curve, the path reduces to a straight line. The different kinds of 
curved paths and their relation to the junction points are described below.

Curved
Curved paths are simply paths that follow a curve starting at one end and always 
curving toward the next junction point but not passing through it. The curve is similar 
to a bezier curve or a b-spline, but it is actually much simplified in a way that the 
relation to the curve’s path is intuitive from the position of the intermediate junction 
points.

Fig. 1 

Fig. 2

Curved Smoothed 

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

(path winds toward junctions) (path passes through junctions) 

Rounded 
(corners rounded at junctions) 

Fig. 1 

Fig. 2 

Arced 
(circular arc through control point) 
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Curved Paths 95
Smoothed
Smoothed paths get the name from the fact that the path of the curve is actually a 
smoothing operation performed on the polyline defined by the intermediate junction 
points. Therefore the resulting path of a smoothed path is a line that curves smoothly 
through each of it’s junction points on the way to the next. A smoothed curve is the 
most intuitive way to define the path of a curved line from a small number of 
intermediate points.

Rounded
A rounded path is simply one in which the corners created by the intermediate junction 
points form rounded arcs from one line segment or the next. The radius of the arc is a 
property of the diagram and can be set differently for each diagram through the 
Diagram Properties dialog box.

Arc
An arc path follows a circular arc through a control point from one endpoint to another. 
Unlike for all other curved paths, the control point is not a junction. 

There are several ways to create a curved path of any of the types described above.
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96 Chapter 7: Paths
To create a curved path
1. Use an existing path style that has the desired curvature characteristic to create a 

path with at least one junction point (vertex). This presumes that you have already 
created a curved path style or are using a template that contains such a style. In the 
case of an arc, click to define the control point just as you would to define the first 
junction of a path of another type.

or

2. While in connect mode to create a path, use the menu or the toolbar button to alter 
the curvature of the path that you are in the process of creating.

or

3. Select the path and use the menu, the toolbar drop menu, or the Path Properties 
dialog box to change the curvature.
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Splitting Paths 97
Splitting Paths
You can split a single-segment path into a multi-segment path and create a junction in 
the process.

To split a path (method one)

1. While pressing and holding the ALT key, move the mouse over the path at the 
point you want it split.

2. While still holding the ALT key, press the mouse button. A new junction appears 
where the mouse points. Before releasing the mouse button you can move the new 
junction.

3. Release the mouse button.

To split a path (method two)
1. You can also split a path (create a new junction) by right-clicking on the path at 

the position where you want the split to occur and choosing the Add Junction 
Here command from the right-click menu.

2. Reposition the junction as needed.

Deleting Path Junctions
In addition to splitting paths into multiple segments, you can also rejoin segments of a 
path by deleting junctions. The following diagram shows how this is done.

In the above example, if you were to delete both junctions, you would end up with a 
simple arrow connecting directly from node one to node two.

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

Before splitting the path After splitting the path and dragging 

Before deleting the selected junction 

Fig. 1 Fig. 2 Fig. 1 Fig. 2 

After deleting the junction 

This junction is being deleted 
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98 Chapter 7: Paths
To remove a segment of a path
1. Right-click on a junction and choose the Delete Junction command.
OR

1. Select the junction that connects the two segments.
2. Choose Delete Junctions from the Edit menu.
When you delete a junction, two segments join to become one. Either or both of these 
segments could have an attached path label. If just one of the segments has a path 
label, the label moves to the final segment. If both original segments have attached 
path labels, one moves to the final segment, the other is deleted.

Moving the Ends of Paths
You can move either of the endpoints of a path. If the endpoint is connected to a node, 
you can detach it from the node, or attach it to a different node. 

To move one end of a path
1. Select the path. Red handles appear at both endpoints of the path and at each 

junction if the path has more than one segment.
2. Move the mouse cursor over one of the handles at the end of the path. The path 

end cursor appears.
3. Press the mouse button and hold it.
4. Move the end of the path and release the mouse button.
A path end can be separated from a junction of three or more paths in this way by 
selecting only the one path and dragging its endpoint. However, a path segment cannot 
be divided at a junction of only two. In that case it not possible to select only one of the 
two - they are treated as one continuous path. To divide or cut a path anywhere along 
its length (see  Snipping Paths on page 98).

When dragging a path endpoint, you can drop it anywhere you like. If you drop it onto 
another object indicated by a small plus sign in the mouse cursor, it will attach to that 
object. As when creating a new path, when you drop it onto another path, it will attach 
at a new junction. If you drop it onto the endpoint of another path, the two will 
combine into one.

Snipping Paths
You can snip a path in two at any point along its length with the Snip Path feature. 
Snipping a path is like cutting a string with a scissors. Each half of the path can then be 
moved independently.
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Flipping Paths 99
To snip a path
1. Right click on the path at any point along its length, even at a junction of two 

segments.
2. Select Snip Paths from the right click menu.
You can reverse this operation with Undo or by simply dragging one of the new free 
endpoints back over the other.

Flipping Paths
You can flip paths so that the ends swap with one another. Flipping works for both 
simple paths and multi-segment paths.

To flip one or more paths
1. Select one or more paths to flip.
2. Choose Flip from the Paths menu.

Jogs
Jogs are small loops drawn when two paths intersect visually but are otherwise 
unrelated. The jog helps to make it clear that the two paths are independent and that 
one simply crosses the other without any kind of interaction. 

Jogs can be enabled and their size can be adjusted from the Paths tab of the Diagram 
Properties dialog box. 

Fig. 1 

Fig. 2 

Fig. 1 

Fig. 2 

After flipping the path Before flipping the path 

Jogs on vertical and horizontal paths
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100 Chapter 7: Paths
Other notes about jogs:

The loop is always drawn on the top or right of the path regardless of the direction 
of the path. 
Jogs on one path must be separated by enough distance to permit some spacing 
between each jog. If a path overlaps multiple other paths that are spaced too 
closely together, some jogs may be omitted.

Orthogonal Paths
Orthogonal paths contain only horizontal and vertical lines and right angles. 

In some types of diagrams, orthogonal paths are preferred and tend to appear much 
neater than non-orthogonal paths. There are several features that help you create and 
maintain orthogonal paths.

One way to assure orthogonal paths is to make sure that all nodes being connected are 
aligned properly, particularly so that their centers are directly in line. The node 
alignment commands (see  Aligning Nodes on page 56) can help you align existing 
nodes in this way. 

The snap grid is another tool that is useful for keeping nodes aligned. When you have a 
snap grid enabled and you use node properties that keep the node center aligned to the 
grid when moved or resized, it is relatively easy to keep your paths orthogonal.

However, in any diagram, not all nodes that you connect can be aligned and not all 
paths are simply a straight line connecting two nodes. Therefore, some additional path 
properties are also required to help create and maintain orthogonal connections.

One aid is to hold down the ALT key while creating paths. Doing so will force all of the 
lines you create to be orthogonal when they are created.

Orthogonal paths Non-orthogonal paths 
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Orthogonal Paths 101
There is also a related path property. The orthogonal property of a path has two 
possible conditions, manual, and guided. This property can be viewed and modified 
from the General tab in the Path Properties and Path Styles dialog boxes.

Manual
The manual option simply means that no assistance is provided by the path properties 
to keep the path orthogonal. Other then the effects of the snap grid if it is enabled, the 
path will go exactly where you click. This is useful when orthogonal paths are not 
important and when you want very precise control over the placement of path 
junctions.

Guided
The guided option is the most generally useful. It helps you create orthogonal paths 
when you want but does not limit you to only orthogonal connections. With this 
option, the paths snap to a straight angle when they are nearly straight. This behavior is 
independent of the snap grid. It works even if the snap grid is disabled and it overrides 
the snap grid if the snap grid is enabled. 

One stipulation with guided paths is that the guiding only occurs when you are creating 
the path. This is sufficient because there is a universal rule that favors straight paths 

Guided path Non-guided path 

A B 

C 
D 

A B 

C 
D 

Effect of the guided path property when you connect two 
nodes by clicking at A, B, C, and then D (no snap grid). 
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102 Chapter 7: Paths
when you move a junction and the snap grid is enabled. Also notice that the guided 
property has no effect unless the path point is nearly straight with regard to the 
previous point. Therefore it does not prevent you from creating a diagonal segment 
when you choose. 

Flow Symbols
Flow symbols are small shapes that are drawn along the path of a path at a fixed 
spacing either in addition to a line or in place of a line. You can control flow symbols 
through the Line tab in the Path Properties and Path Styles dialog boxes.

Changing Path Properties
Each path has a set of properties that define how it looks and behaves. Most of the 
initial properties of a path come from its original path style. This section describes how 
to change the properties of an existing path.

To view and modify the properties of a path
1. Select the path.
2. Choose Properties from the Paths menu or from the right mouse button menu. 

(or double click on the path.) 

The Path Properties dialog box will appear on the screen near the selected path. This 
dialog box contains several different groupings of properties organized under tabs 
with an appropriate heading. To change to a different grouping of properties and their 
controls, press the corresponding tab. Controls located under each tab are described 
below.

Once you’ve set all of the properties of the path that you want to change, press one of 
the following buttons:

Examples of flow symbols on a path. 
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Changing Path Properties 103
Apply

Applies the property changes to the selected path or paths without exiting the dialog 
box.

OK

Applies the property changes to the selected path or paths and exits.

Cancel

Exits the dialog box and discards any changes you made since last pressing Apply. 
Once you apply changes, those changes remain in effect even if you press Cancel.

Changing properties for multiple paths
You can change any number of different properties to a number of paths at the same 
time. To do so, select the paths and use the dialog box as usual. Only the properties you 
actually modify will be applied to the selected objects. For example, if you select five 
paths that all have different colors and widths, and you edit their properties and change 
only the color not touching the width, all the nodes will acquire the new color and 
retain their previous width.

NOTE: Several properties can also be changed by selecting the path(s) and clicking 
on the buttons and controls on the property bar or the Paths menu. These are 
simply shortcuts to the same changes in the path properties dialog box.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 103 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



104 Chapter 7: Paths
Path Properties: General
Use the General tab of the Path Properties dialog box to view and edit the style that the 
path is based on and some other general properties.

Based on style

To change the path’s style, choose a new style from the combo box or the style drop 
menu located to the left. This will change the appearance of the path and it will inherit 
all the properties from the new style you choose.

Styles

This button is a drop menu for the same purpose as Based on style described above.

Bind to style

Check this box to choose whether or not a path’s properties are bound to the style. If a 
path’s properties are bound to its style, then anytime the style properties change, the 
path gets the new properties automatically. 

Orthogonal

This property can provide some assistance in creating and keeping paths orthogonal 
(all lines vertical or horizontal). Guided provides adequate help for most cases. 
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Changing Path Properties 105
Path Properties: Line
Use the Line tab of the Path Properties dialog box to view and edit the appearance of 
the line that is drawn along the path’s path.

Line

A path line can be one of many line styles such as solid, dashed, dotted, and so on. To 
change the path’s line style, choose a new line style from the drop menu.

Color

To change the color of the path, choose a different color from the color selection drop 
menu. 

Width

To change the line width of the path, enter a width or use the up and down spin 
buttons. You can also choose a standard width by clicking on the drop menu.

Curvature

Select one of the curvature options for the path. The path of the path can be straight, 
curved. smoothed, rounded, or arced (see  Curved Paths on page 94).

Corners

Choose a corner style (also known as a line join style). These options apply to the way 
that thick straight paths appear when two segments meet. Note that corners will appear 
rounded when imported into other documents.
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106 Chapter 7: Paths
Flow symbols along line

Check this box to enable flow symbols to be drawn along the path of the path.

Kind

Choose the kind of flow symbol from the flow symbol drop menu

Fill color

Choose a fill color for the flow symbols. 

Border color

Choose a border color for the flow symbols.

Size

Choose the size for the flow symbols.

Spacing

Choose the spacing interval between flow symbols.

Border width

Choose the line width of the borders of the flow symbols.
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Changing Path Properties 107
Path Properties: Ends
Use the Ends tab of the Path Properties dialog box to view and edit the appearance of 
the symbols that are drawn at the ends of the path (such as arrowheads).

Terminator 1

To change the originating terminator of the path, choose a color, size, and terminator 
symbol.

Symbol

Select a terminator symbol shape from the terminator symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the Terminator Symbol Gallery.
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108 Chapter 7: Paths
Fill color

Choose a fill color for this terminator symbol.

Symbol size

Choose a size for this terminator symbol.

Terminator 2

To change the terminating end of the path, choose a color, size, and terminator symbol.

Symbol

Select a terminator symbol shape from the terminator symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the Terminator Symbol Gallery.

Fill color

Choose a fill color for this terminator symbol.

Symbol size

Choose a size for this terminator symbol.

Borders

To change the width of the borders around the terminators, enter a border width or use 
the up and down spin buttons.
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Changing Path Properties 109
Path Properties: Behaviors
Use the Behaviors tab of the Path Properties dialog box to view and edit the properties 
that affect the way the path behaves within your diagram.

Do not treat as a flow (no drop-ins)

When checked, “flow” properties will be disabled for this path. For example, you will 
not be able to drop a new or existing node into the flow of the path, automatically 
connecting the node in-line with the path. This behavior only has meaning if the “Snap 
figures into flows” option is enabled in the Snap Labels section under Edit in the Tools 
Options screen. This property is useful when a path is used as a simple line rather than 
for connecting nodes.

No crossovers (jogs)

When checked, this path will not use jogs when crossing over other paths, nor will 
other paths use jogs when crossing over this path. This behavior only has meaning if 
jogs are enabled in the diagram properties (see Diagram Properties Paths). This 
property is useful when a path is used as a simple line rather than for connecting nodes.

Do not print or export

Self-explanatory.
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111

CHAPTER
8 LABELS

Labels are words, phrases, sentences, and paragraphs that you can position anywhere in 
your diagram. Use labels for titles, notes, descriptions, and to label elements of your 
diagram. 

A label consists of text and a set of properties such as justification, font, and color. The 
initial properties of a label come from the label style you use to create it.

This chapter covers the properties, behaviors, and features that are unique to labels. There 
are also many operations not covered in this chapter that can affect labels as well as other 
types of objects (see  CHAPTER 3: General Editing,  page 27). 

Types of Labels
There are several types of labels, each with different uses and properties. In addition to 
standard labels, there are a number of specialty labels that retain an attachment to various 
objects within a diagram.

ok

data

Sample

box 1Node
Text

box 2Node
Text

ok
data

Sample

box 1Node
Text

box 2Node
Text

A sample portion of a diagram 
showing different types of labels.

Label movements after the lower box is moved 
to the right. Notice that the standard label is 
unaffected and the specialty labels each move 
to remain near an associated object.

Path Label

Flow Label

Standard
Label

Node
Labels
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112 Chapter 8: Labels
Standard Labels

A standard label is simply text added to a diagram that is not associated with any 
particular object in the diagram. Standard labels are useful for adding titles, headings, 
and explanations. They add meaning to the diagram or describe a portion of the 
diagram. Standard labels do not adjust to movements of any other parts of the diagram.

Path Labels

A path label labels a path that connects (usually) one node to another. A path label is 
drawn either in-line within the path, or laterally alongside the path. As the path is 
adjusted, the path label moves along to remain within the path.

Node Labels

A node label labels a particular node and is attached to the node. When the node 
moves, all attached node labels move with it and retain their positions relative to the 
node. Node labels are useful for adding notes or comments about a node. They are also 
useful for nodes that cannot contain internal node text, such as glyphs, icons, or 
imported graphics.

Flow Labels

A flow label labels a flow point, the point at which a path meets a node. When either 
the node or the attached path moves in any way, the flow label adjusts its position to 
remain near the final location of the flow point. Flow labels are useful for labeling path 
endpoints in class diagrams. 

All label types are similar and can be manipulated in similar ways. But there are also 
some special properties and behaviors of each of the specialty labels. There are also 
some features to enable the most convenient usage of these labels in their intended 
ways.

The following section describes features common to labels of all types. It covers 
common methods for creating and destroying labels, editing their appearance and 
position, and changing their properties. Later sections describe features and 
characteristics unique to each type of label.

Working with Labels
The following apply to ALL kinds of labels.

Creating Labels
Specialty labels can be created in other ways as well, but any kind of label can be 
created by entering text mode, clicking on the origin point in your diagram, and typing 
the label text, followed by ESC when done.
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Working with Labels 113
To create a a label, you can use one several methods. Each provide different control 
over the appearance and style of the label. You can choose to create a label based on a 
defined style using the defined characteristics of that style, or you can create a label 
without any such affiliation.

To initiate creation of a label of a defined style
Choose a label style to provide the initial properties of the label, then use that style to 
create a label on the diagram. Locate the “Labels” section of the style bar

Perform one of the following:

1. Press and hold the Labels button in the style bar to activate the label style drop 
menu. Move to the representation of the style, and release the mouse button. Not 
all styles are displayed in this menu so you may have to choose the three dots to 
see all of them (see below).

or

2. Choose the label style by name from the label style combo box.
or

3. If the label has a style bar button, click that button.

Choosing a label style from the complete list of styles
Another method is available to select a label style. This method contains all of the 
styles with complete names, pictures, and descriptions and lets you choose which 
styles appear on buttons and in drop menus.

Label style drop menu 
Label style combo box 
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114 Chapter 8: Labels
Select the ellipsis (three dots) from the Labels drop menu to open the Choose a Label 
Style dialog box.

To choose a label style

1. Scroll to preview all of the available styles.
2. Click on the style to select it.
3. Press OK. Alternately, double-click on the style. 

Edit

While you’re here you may want to add, change, or delete styles from your diagram. 
This button just provides a convenient shortcut to the Styles dialog box. Also available 
by right-clicking any style in the list.

Menu

Check or uncheck this button for each style to control whether the drop menu contains 
a representation of the particular style. Also available by right-clicking any style in the 
list.

Button

Check or uncheck this button for each style to control whether the style is represented 
by a button in the style bar. Reserve buttons only for your most common styles. Also 
available by right-clicking any style in the list.
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Working with Labels 115
NOTE: Notice that this screen is resizable. If it is too narrow and cannot include the 
Edit, Button, and Menu controls, they remain available by right-clicking on a 
style.

To initiate creation of a label without a defined style
There is no requirement that you go through the steps described above (choosing a 
label style) just to create a simple text label. If you don’t care to use a defined style for 
the label, just click on the text mode button.

Clicking the text mode button places you in text mode without selecting any particular 
label style. The font properties and text color will reflect the last properties you used in 
text mode. 

Once you have entered text mode
Now that you are in text mode, the text mode button will appear depressed and the 
cursor will appear as a caret .

In text mode you can use the property bar to change properties of the label that will be 
created such as the color, font, text size, and justification. If you started by selecting a 
label style, any such change will cancel the label style.

To create a label
1. Use the mouse to position the new label. The text cursor points to the position 

where the bottom left corner of the label will be located (for a left-justified label).
2. Click the mouse button.
3. Type the label text. 
4. When you are done adding or changing the text, you can either press ESC to save 

your changes and remain in text mode, press the right mouse button to save your 
changes and return to select mode, or simply click on the diagram to create 
another label.

To create a label (automatic method)
1. From text mode or select mode or seltext mode... 
2. Point the mouse at the location where you want to place the label.
3. Start typing text on the keyboard. A label is created automatically containing the 

text you type.

Deleting Labels
Deleting labels is similar to deleting nodes or any other object in your diagram.
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116 Chapter 8: Labels
To delete a label (standard method)
1. Select the label.
2. Choose Delete from the Edit menu, or press the DEL key.

To delete a label (automatic method)
1. Edit the text in the label, and delete all the text.
2. Labels that contain no text are deleted automatically.

Moving Labels
Moving labels is just like moving any other objects in your diagram. However, special 
considerations occur for specialty labels. See the later sections of this chapter 
regarding each of the specialty label types.

Changing Label Properties
Each label has a set of properties that define how it looks, what text it contains, how it 
behaves, and more. Most of the initial properties of a label come from its original label 
style. This section describes how to change the label properties of an existing label.

To view and modify the properties of a label
1. Select the label.
2. Choose Properties from the Labels menu or from the right mouse button menu.
or

1. Double click on the label. Note, double clicking on a label will edit the label 
properties only if you have chosen Display/edit properties in the 'Edit' options 
within the Tools Options screen.

The Label Properties dialog box will appear on the screen near the selected label. This 
dialog box contains several different groupings of properties organized under tabs 
with an appropriate heading. To change to a different grouping of properties and their 
controls, press the corresponding tab. Controls located under each tab are described 
below.

Once you’ve set all of the properties of the label that you want to change, press one of 
the following buttons:

Apply

Applies the property changes to the selected labels without exiting the dialog box.

OK

Applies the property changes to the selected label or labels and exits the dialog box.
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Working with Labels 117
Cancel

Exits the dialog box and discards any changes you made since last pressing the Apply 
button. Once you apply changes, those changes remain in effect even if you press 
Cancel.

Changing properties for multiple labels
You can use the Label Properties dialog box to change a property, or any number of 
different properties, to a number of labels at the same time. To do so, select the labels 
and use the Label Properties dialog box as usual. Only the properties you actually 
modify will be applied to the selected objects. For example, if you select five label that 
all have different heights and widths, and you edit their properties and change only the 
Width field not touching the Height field, all five label will acquire the new width and 
retain their previous height.

NOTE: Several label properties can also be changed simply by selecting the label(s) 
and clicking on the buttons and controls on the property bar. These are 
simply shortcuts to the same changes in the label properties dialog box.
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118 Chapter 8: Labels
Label Properties: General
Use the General tab of the Label Properties dialog box to view and edit the basic 
properties of the selected label such as its location, size, appearance, and color.

Based on style

To change the label’s style, choose a new style from the combo box or the Styles drop 
menu located to the left. This will change the appearance of the label and it will inherit 
all the properties from the new style you choose.

Styles

This is a drop menu for choosing a style for the same purpose as Based on style.

Left

To change the position of the label, enter a new location for the left-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the left edge of the page (positive measurements are to the right). 

Top

To change the position of the label, enter a new location for the top-most edge. The 
value is the distance from the origin point on the ruler bar (0,0) or equivalently from 
the top edge of the page (positive measurements are downward).
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Width

To change the width of the label, enter a new width here.

Height

To change the height of the label, enter a new height here.

Text color

To change the color of the label’s text, choose a different color from the color selection 
drop menu. Use of this drop menu is described elsewhere (see page 38). If you select a 
color that cannot be drawn solid, Windows draws the text in the nearest solid color.

Bind to style

Check this box to choose whether or not a label’s properties are bound to the style. If a 
label’s properties are bound to its style, then anytime the style properties change, the 
label gets the new properties automatically.

Label Properties: Text
Use the Text tab of the Label Properties dialog box to view and edit the label’s text and 
the properties of the label that affect the display and format of the text.
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120 Chapter 8: Labels
Text

The text control to the right of the model displays the text that is contained in the label 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
label itself. Furthermore, if you edit the text here, you will lose all embedded font 
controls. 

With rotated labels (those whose lettering is top-to-bottom or bottom-to-top instead of 
left-to-right), you will not be able to edit the text directly on screen. Therefore, this 
will be the primary way to edit the text. Because doing so removes embedded font 
controls, for example a single word within the label that is bold or underlined, it is less 
convenient to have rotated text with mixed font attributes. However, it can still be 
done. Just rotate the label back to normal (left-to-right), edit the text attributes on 
screen rather than with this edit box, and rotate the label back.

Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Text color

To change the color of the label’s text, choose a different color from the color selection 
drop menu. Use of this drop menu is described elsewhere (see page 38). If you select a 
color that cannot be drawn solid, Windows draws the text in the nearest solid color.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
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Working with Labels 121
preview a sample of the font as you select it Controls in this dialog are self-
explanatory.
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122 Chapter 8: Labels
Label Properties: Behaviors
Use the Behaviors tab of the Label Properties dialog box to view and edit the 
properties that affect the way the label behaves within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the label. 
If set to Prevent, additional characters are not allowed. If set to Expand, the label 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the label 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the label expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the label. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a label of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the label automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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Working with Labels 123
Vertical expansion

This property controls in which direction the label expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the label. 

Horizontal center snaps to grid

It is generally best to disable this property for labels.

Vertical center snaps to grid

It is generally best to disable this property for labels.

Width snaps to grid

It is generally best to disable this property for labels.

Height snaps to grid

It is generally best to disable this property for labels.

Left and right edges snap to grid

It is generally best to disable this property for labels.

Top and bottom edges snap to grid

It is generally best to disable this property for labels.

Center stationary when resizing horizontally

Check this property to cause the center of the label to remain in the same place when 
you resize it horizontally by dragging the handles. 

Center stationary when resizing vertically

Check this property to cause the center of the label to remain in the same place when 
you resize it vertically by dragging the handles. 

Keep sized to text

When this property is checked, the label is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a label such that the label has less text 
than it had before, the label will automatically resize itself to shrink down around the 
new text as soon as you complete editing the text. You will generally want to set this 
property for labels.

Automatic Text Scaling

When this property is checked, the label text scales automatically when you resize the 
label. Labels having this property always maintain a fixed aspect ratio (height vs. 
width).
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124 Chapter 8: Labels
Label Properties: Tabs
Use the Tabs tab of the Label Properties dialog box to view and edit the label’s tab 
stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.
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Working with Labels 125
Clear

Click to remove the highlighted tab stop from the tab stop list.

Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a label must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.
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126 Chapter 8: Labels
Label Properties: Memo
Use the Memo tab of the Label Properties dialog box to view and edit the label’s 
memo text. Memo text contains any information you would like to attach to the label. 
It is displayed in a text balloon (tooltip) when you hover the mouse over the label 
while in select mode.

Memo Text

Enter the memo text. It can contain line breaks, but not formatting such as bold, 
underlines, italics, or different fonts or type sizes.

Working with Specialty Labels
Path labels, node labels, and flow labels are collectively known as specialty labels. 
Unlike ordinary labels, specialty labels serve a specific purpose in a diagram and they 
automatically make adjustments in accordance with their roles. The primary 
adjustment is in position. For example, one type of specialty label is a Path Label. A 
path label labels a path, and accordingly its position adjusts to remain with the path as 
the path moves. Specific behaviors of the different specialty labels are described in the 
following section. 
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Working with Specialty Labels 127
Creating Specialty Labels
Specialty labels can be created in different ways. Each type has special creation 
method(s) described in one of the following sections.

A common way to create any of the specialty labels is to create a label in the usual way 
but to place it on your diagram so that the software can deduce that it should be a 
specialty label. For example, if you select a label style, then click on a path to create a 
label, the label will automatically be created as an inline path label for the path. 

Specialty Label Slots

The locations where specialty labels can be added to your diagram are called slots. Slot 
locations for the different types of specialty labels are described in the sections below.

In order for specialty labels to be created automatically based on placement, the 
corresponding snap-to-slot option must be enabled. These are located in the Snap 
Labels section under Edit in the Tools Options screen. They are as follows:

Snap labels to path label slots (inline) - enabled by default

Snap labels to path label slots (lateral) - enabled by default

Snap labels to node label slots - disabled by default 
in conjunction with Snap labels to node label primary position only

Snap labels to flow label slots - enabled by default

Path Label Slots (lateral)
Anywhere alongside 

above or below a path.

Node Label Slots
Alongside the node, centered

and at all corners.

Flow Label Slots
Near the point where a path 
attaches to a node, on either 

side of the path.

Path Label Slots (in-line)
Anywhere along a path.
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128 Chapter 8: Labels
Specialty Labels - Freeform

If you disable the above options, labels will instead become standard labels regardless 
of their placement. In other words, the diagram content will be ignored when you place 
the label. If you enable these options, you can coerce this freeform behavior case-by-
case by holding down the CTRL key.

Creating Specialty Labels with Default Text

A special case occurs when you create a specialty label from a style for which default 
text is defined. In this case, the cursor is replaced by a representation of the text for 
you to drop onto your diagram. Position the text where you like. If you want it to 
become a specialty label, position it over the proper slot and drop it there. Use the 
CTRL key for freeform.

Attaching Specialty Labels
Specialty labels can be created from existing standard labels simply by dragging them 
one at a time over a specialty label slot and dropping them into place.

To attach an existing label as a specialty label
1. Make sure the appropriate snap-to-slot options are enabled (see above).
2. Drag a single existing standard label over a specialty label slot. When you are 

properly over a slot, the slot will appear as a dashed or dotted gray line and the 
status bar will reflect this as well.

3. Drop the label onto the slot at the new position. Do not hold down the CTRL key 
unless you want to prevent the label from becoming a specialty label.

In some cases, attaching a label as a specialty label causes some of its properties to 
change. For example, if you start with a left-justified label and drag it to become a path 
label, it will become center-justified. See the specific specialty label types for more 
details.

Detaching Specialty Labels
A specialty label can easily be detached and made a standard label using the Detach 
Label feature.

To detach a specialty label:
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 128 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



Path Labels 129
1. Right click on the label and choose Detach Label from the right-click menu.
Once detached the label will no longer adjust to the position of other objects. It will be 
converted to a standard label that you can move anywhere.

Path Labels
Labels can be attached to paths to form path labels. Path labels are useful for 
describing the purpose of a path or the relationship that the path represents between 
two nodes. The illustration below shows a typical path label.

Path Label Slots (in-line)
In-line path labels can be placed anywhere along a path. Therefore, the in-line path 
label slots are located anywhere such that the center point is on the path. This is the 
location where creating a label or dragging a label will result in the label becoming an 
in-line path label.

Update backup 
database cocurrently

Custom er

name: String
phone: String

add(name,phone)

An in-line path 
 

DATA 

label 

In-line Path Label Slots - Anywhere along a path
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 129 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



130 Chapter 8: Labels
Path Label Slots (lateral)
Lateral path labels can be placed anywhere alongside a path. Therefore, the lateral path 
label slots are located just above or below (or to the right or left) of the path. This is the 
location where creating a label or dragging a label will result in the label becoming a 
lateral path label.

Special properties and behaviors
A path can have only one label. Multi-segment paths, described later in this 
chapter, can have one label per segment.
The center of an in-line path label attaches to any point on the path. When the path 
is drawn, it breaks around the label rather than going through it. Regardless of the 
label properties, the text in a path label is always center-justified and the center 
always remains stationary when the label is sized. 
The text justification of a lateral path label is self-determined based on the 
position of the label and the orientation of the path such that the distance from the 
path to the text is fixed if the text expands.
When the path moves, any attached path label moves as well. The path label 
remains attached to the same point on the path at the path’s new location.

Lateral Path Label Slots - Anywhere alongside a path
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Path Labels 131
Creating Path Labels
You create a path label just like an ordinary label except that you attach it to a path.

To create a path label
1. Enter text mode by pressing the text mode button on the tool bar or by choosing a 

label style from the style bar. Be sure that at least one of Snap labels to path label 
slots (in-line) or Snap labels to path label slots (lateral) is enabled in Tools 
Options.

2. Move the mouse over a path label slot. You will notice that the path label slot is 
highlighted with a dashed gray box and the status bar also reflects that you are in 
position to create a path label.

3. Click the left mouse button to create the path label.
4. Type in the text for the label. ESC when done.
There is another way to create a path label that does not require Snap labels to path 
label slots (in-line) or Snap labels to path label slots (lateral) to be enabled.

To create a path label (method 2)
1. Go to Select (or SelText) mode.
2. Right click the mouse on the path to label at the point where you want the new 

label placed. 
3. Choose Add In-line Path Label Here or Add Lateral Path Label Here from the 

right click menu. The label will appear with default label text “label”.
4. Enter your own text for the label and press ESC when done.

NOTE: A single segment of a path can have only one in-line path label or one lateral 
path label.

Moving Path Labels
Once you’ve created a path label, you can adjust its position on the path, or move it to 
a different path.

To move a path label
1. In select mode, move the mouse over the path label. The move cursor  

appears.
2. Press the left mouse button and hold it down.
3. Drag the path label. The label slides across to the point on the path nearest the 

mouse, or to a point on a different path.
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132 Chapter 8: Labels
4. Release the mouse button. If the label does not move to the new location, there is 
something wrong with the location - the path may already have a label.

Detaching Path Labels
A path label can be detached and made a standard label using the Detach Label 
feature.

To detach a path label
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

1. Right click on the label and choose Detach Label from the right-click menu.

Deleting Path Labels
Deleting a path label is just like deleting an ordinary label with a few minor 
exceptions.

To delete a path label
1. Select the label.
2. Choose Delete from the Edit menu, or press the DEL key.
or

1. Edit the text in the label, and delete all the text.
2. A path label, like any other label, is automatically deleted when it contains no 

text.
When you delete the path to which the label is attached, the label is deleted 
automatically.

Node Labels
Labels can be attached to nodes to form 
node labels. Node labels are useful for 
describing the purpose of a node or 
adding some information about the node. 
In UML these relationships are also 
called associations. This illustration 
shows a typical node label. The node 
label here is positioned beneath the node. 

Custom er

nam e: S tring
phone: S tring

add(nam e,phone)
A node label

Customer Data Record
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Node Labels 133
If the node is moved, the node label will move along to remain below the node at its 
new location.

Node labels form a grouping of the label and the node so that many operations affect 
them together. They have many applications in addition to UML associations. Here are 
a few examples:

Node Label Slots
Node label slots are located above, below, to 
the right and left of each node, and at the four 
corners as illustrated. These are the locations 
where creating a label or dragging a label will 
result in the label becoming a node label.

Each node label slot is “attached” to the node 
at a different point so that it can adjust 
properly of the node is moved or resized. 
Each slot also enforces a text justification 
(and growth directions) of the label so that the 
label can grow as well and remain properly 
positioned relative to the node.

For example, if you create a node label in the most popular slot (the center slot beneath 
the node), that label will be center-justified and top-justified. As you type more text 
into the label it will remain centered beneath the node, and as you add new lines, it will 
grow downward to maintain the same distance from the node. Similarly, at this 
particular slot position, the top center of the label is “attached” to the bottom center of 
the node so that when the node resizes, the label remains centered below it and at the 
same distance from the node. All nine standard slot positions function similarly using 
different attach points and text justifications.

The Snap labels to node label slots option and the Snap labels to node label primary 
position only options control which if any of the slots are sensed when dragging or 
creating node labels. See Tool Options for details.

Joe’s PC

Some common uses for node labels.

RECONFIGURE
APPARATUS

The procedure for 
reconfiguring the apparatus 
varies based on the 
manufacturer of the equipment 
(see user guide).

Employee

Node Label Slots
Alongside the node, centered

and at all corners.
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134 Chapter 8: Labels
After you create a node label in a slot, or 
attach a label to a node label slot, you can 
move the label as you like to adjust its 
position relative to the node. When you do so, 
you’ll see a hook-up indicator (a dotted line 
form the label to the node) which shows that 
the label is a node label belonging to the 
node. The hook-up also shows which point on 
the label is bound to which point on the node.

If you use the slots to create a node label or to attach a node label, you can later adjust 
the position of the node label relative to the node by dragging it, and you can change 
its text justification in the usual way, but you cannot change the hook-up.

If you create the node label by using the Attach Label to Node feature rather than 
creating a label on a slot or attaching an existing label to a slot, then the hook-up 
extends from the center of the label to the center of the node. As a result the label 
position may need to be re-adjusted manually if the node changes size.

Special properties and behaviors of node labels
A node may have any number of node labels though only one can occupy each 
node label slot.
Node labels move along with the node when the node position changes.
If the node changes size, the node label may adjust automatically. Node labels that 
occupy standard node label slots are attached to the node in a way that specifically 
forces the node label position to adjust to repositioning or resizing of the node. 
The text justification of node labels in slots adjusts as well for this purpose. Node 
labels that were attached to the node using the Attach Label to Node feature may 
need to be adjusted manually if the node is resized (these attach center-to-center).
If a node is deleted or copied all of its attached node labels are deleted or copied as 
well. To prevent this, detach each node label before deleting or copying the node.

Creating Node Labels
The easiest way to create a node label is to enable the Snap labels to node label slots 
option and create a label in the usual way but over one of the node’s unoccupied node 
label slots, or to drag an existing label onto a node’s unoccupied node label slot. These 
methods have been described earlier in this chapter. The sense of the Snap labels to 
node label primary position only option affects this as well. See Tools Options for 
details.

Another method to create a node label is to use the Add Node Label feature. This 
method is only for node labels and does not require you to enable the Snap labels to 
node label slots option. 

Node Label Hook-up Indicator

Label
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Node Labels 135
We have disabled the Snap labels to node label slots option by default because the 
presence of many node label slots can be distracting and frustrating until you 
understand node labels. If you become familiar with node labels and want the added 
convenience you can enable this option. You can also limit the exposed node label 
slots to only the one slot designated as the primary position by enabling the Snap 
labels to node label primary position only option. The Add Node Label feature and the 
Attach Label to Node feature DO NOT require this option to be enabled and they still 
provide all of the power you need to work with node labels.

To add a node label to a node
1. Right click on the node and choose Add Node Label from the right-click menu.
2. Choose a slot from the pop-up submenu (above, below, right, left, and so on). A 

label with default text “label” will be created in the slot you chose.
3. Edit the label text as you like and press ESC when done.

Attaching Node Labels
The easiest way to attach a label to a node is to enable the Snap labels to node label 
slots option and drag the label onto one of the node’s unoccupied node label slots. This 
method was described earlier in the chapter. The sense of the Snap labels to node label 
primary position only option affects this as well. See Tools Options for details.

Another method is to use the Attach Label to Node feature.

To attach an existing label to a node
1. Position the label where you want it relative to the node.
2. Select the label and the node (and no other objects).
3. Right click and choose Attach Label to Node from the menu.
The label will become a node label attached to the node in its current position, not in a 
node label slot. The label will move with the node in the usual way. You can detach the 
label from the node by right-clicking on it and choosing Detach Label.

Re-positioning Node Labels
After you have attached a node label to a node in any of the ways described in this 
section you can reposition the label relative to the node.

To re-position a node label
1. Drag the label only (make sure the node is not selected).
2. As you drag the label, the node that it is attached to will remain stationary and you 

will see a gray dashed line extending from the label to the node.
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136 Chapter 8: Labels
The gray line indicates that the label is a node label, which node it is attached to, and 
where it is hooked up to on both the label and the node. When you release the mouse 
button, the node label will be re-positioned. When the node is moved the label will 
move as well but will remain in this new relative position.

Detaching Node Labels
A node label can be detached from the node and made a standard label using the 
Detach Label feature.

To detach a node label
1. Select the label.
2. Choose Detach Label from the Labels menu.

Or

1. Right click on the label and choose Detach Label from the right-click menu.

Node Labels as Auto-Labels
A label can be added to a created node automatically through the use of Auto-labels. 
An auto-label is a text label defined for a node style. When you create a node of a style 
and the Auto-label option is enabled (see  Options: Start-up on page 231), a label with 
the preset text is automatically created beneath the new node. The auto-label is 
actually an automatically added node label that uses the node label Primary Position 
slot (initially directly below the node).

The auto label is a node label of new node. If you move the node, the auto-label will 
move along. However, if you move just the auto-label, you can re-position it relative to 
the node.

By default the label style used for auto-labels (including font, size, color and so on) is 
the last label style you used in the diagram. However, you can set the label style used 
for a particular diagram in Diagram Properties. You can also set the Primary Position 
in Diagram Properties. 

Computer

Example of a node 
created from a style 
with the auto-label 
text “Computer”. 
The label appears 
centered directly 

An auto-label
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Flow Labels 137
Flow Labels
Labels can be attached to the point where a path 
attaches to a node (a flow point) to form flow 
labels. Flow labels are useful for describing the 
relationship between nodes represented by a path. 
The two most common uses for flow labels are in 
labeling branch conditions as in flow charts, and 
for labeling class relations in UML diagrams 
(which is also common in E-R modeling 
diagrams). This illustration shows a typical flow 
label. If the node or the path is moved, the flow 
label will move along to remain near the point 
where the path meets the node.

Flow labels have a variety of uses such as these:

Flow Label Slots
Flow labels can be placed only in flow label slots. The flow label slots are located near 
the node on either side of the point where a path attaches to a node. This is the location 
where creating a label or dragging a label will result in the label becoming a flow label.

Special properties and behaviors of flow labels
A node/path connection may have a flow label on either side of the connection or 
on both sides. 
Flow labels adjust their position when either the node or the path moves.
Flow labels cannot be dragged or re-positioned by themselves.

1.n

Flow Label Flow Point

Some common uses for flow labels.

YES

NO a b c

To step 12b

Flow Label Slots - Near the point where a path 
attaches to a node, on either side of the path.
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138 Chapter 8: Labels
The flow labels for a node/path pair get deleted if either the node, the path, or both 
are deleted.
The text justification of a flow label is adjusted automatically to assure that it 
grows in the proper directions.
You can resize a flow label using the resize handles. After resizing it will snap 
back to its proper location.

Creating Flow Labels
The easiest way to create a flow label is to enable the Snap labels to flow label slots 
option and create a label in the usual way but over an unoccupied flow label slot, or to 
drag an existing label onto an unoccupied flow label slot. These methods are described 
earlier in this chapter.

Another method to create a flow label is to use the Add Flow Label feature. This 
method is only for flow labels and does not require you to enable the Snap labels to 
flow label slots option. 

To add a flow label
1. Right click on a flow point and choose Add Flow Label from the right-click 

menu.
2. Choose which side of the path to add the flow label from the pop-up submenu 

(above/left or below/right). A label with default text “label” will be created in the 
slot you chose.

3. Edit the label text as you like and press ESC when done.

Attaching Flow Labels
The only way to make a standard label into a flow label is to enable the Snap labels to 
flow label slots option and drag the label onto an unoccupied flow label slot. This 
method was described earlier in the chapter.

Detaching Flow Labels
A flow label can be detached using the Detach Label feature. For example, to move 
the flow label to the other side of the path, detach it, move it, and re-attach it.

To detach a node label
1. Select the label.
2. Choose Detach Label from the Labels menu. Or
Right click on the label and choose Detach Label from the right-click menu.
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CHAPTER
9 TEXT

Text plays a very important role in most diagrams. You can use text to add descriptions for 
nodes, labels for paths, titles, comments, annotations, instructions, and so on. You can add 
text just about anywhere quickly and easily.

This chapter describes how to work with text in labels and nodes.

The Text Area
Geometric nodes have an outline shape and 
reserve the majority of the inside of the shape for 
text. The portion of the node that is reserved for 
text is called a text area. In UML, a text area is 
also called a compartment so we will use these 
terms interchangeably. You can see the text area 
on the screen when you move the text cursor over 
it.

When you are in text mode, moving over an existing text area or over a “slot” for a 
specialty label (see previous chapter) results in a highlighted dashed rectangle outlining the 
text area. This rectangle is simply an indicator of a place where you can add or edit text on 
an object or associated with an object.

A label always has one and only one text area that is the same size as the label. A node, on 
the other hand, can have no text areas, or as many as you want. If a node has no text area, 
you cannot add any text to the node. If it has multiple text areas, you can add text to each of 
the areas independently.

The number of text areas, and their locations within a node are part of the node symbol 
definition.

A text area within a node 
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140 Chapter 9: Text
Adding Text to Nodes and Labels
You can add text to a text area of any label or node (see previous section for a 
discussion of text areas).

To add text to a node or label
1. Enter text mode.
2. Move the cursor anywhere over a label or over a node’s text area. The cursor 

changes as shown in the diagram above.
3. Click the mouse button to begin adding text.
Nodes can have multiple text areas. You can add text to any of these areas by clicking 
on different parts of the node.

To add text to a node (automatic method)
1. Move the cursor over a node’s text area. 
2. Start typing text on the keyboard. You are automatically placed in text mode 

entering text. If the node contained any previous text, the typed text replaces it.
See Editing Text below for additional ways to edit the node text after the node is 
created.

Labels are similar to nodes except that a label cannot exist if it has no text. 
Consequently, you add text to a label when you create it. If you do not add any text 
when creating a label, or if you later remove all the text, the label is deleted 
automatically.

Rotating Text
Labels can be rotated so that the text is drawn vertically top to bottom or bottom to top.

To rotate a label
1. Select one or more labels.
2. Press the toolbar button that represents the way that you want the text rotated. The 

text rotation toolbar buttons show ABC at different angles.
3. OR, choose one of the commands in the Rotate submenu of the Labels menu.
4. OR, right click and choose a command from the Rotate submenu.
When a label is rotated, you cannot edit the text by clicking on it while in text mode. 
Instead, use the Edit Text command to edit the text through the node’s property dialog 
box.
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Editing Text 141
Editing Text

To edit node or label text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a node’s text area. 
3. Click the mouse button to begin editing the text.
Note, the above procedure cannot be used to edit rotated text. To edit rotated label text, 
use one of the additional methods described below.

Additional methods for editing node or label text
There are also some other methods available for editing the text of a node or label. Use 
the method you find most convenient.

1. Select the node or label and choose Edit Text from the Edit menu.
2. Select the node or label and choose Edit Text from the right click menu.
3. Select the node or label and press the F2 key.
4. Double-click on the node or label. This works to edit text only if you have selected 

Display/edit properties in the 'Edit' options within the Tools Options screen.
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142 Chapter 9: Text
Selecting Text
To perform operations such as Cut, Copy, and Delete, you need to select a range of 
text.

To select a range of text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a node’s text area. 
3. Press the left mouse button and hold it down to begin selecting the text.
4. Drag the mouse to select text. The selected text becomes highlighted.

To select a word of text
1. Enter text mode.
2. Move the cursor anywhere over a label or over a node’s text area. 
3. Double-click the left mouse button to select the word beneath the cursor.

To select all text within a label or node
1. Enter text mode.
2. Move the cursor over a label or a node’s text area. 
3. Triple-click the left mouse button.

To extend a text selection
While holding down the SHIFT key, click the mouse on additional text to select.

An example of a node with some 
selected text. The word “SAMPLE” 

NODE
A SAMPLE

is selected. 
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Using the Keyboard to Edit Text 143
Using the Keyboard to Edit Text
This table lists the functions available from the keyboard when working with text:

You can use any of the keys that move the cursor in combination with the SHIFT key to 
extend the current text selection.

Some international characters, for example the German umlaut, may not be available 
on all keyboards. To type these characters, use the ALT key with the ANSI character 

Table 1: Text Editing Keys
KEY FUNCTION
ESC Quit editing text
RIGHT Move the cursor to the right one character
LEFT Move the cursor to the left one character
UP Move the cursor up one line
DOWN Move the cursor down one line
CTRL-RIGHT Move the cursor right one word
CTRL-LEFT Move the cursor left one word
HOME Move the cursor to the beginning of the current line
END Move the cursor to the end of the current line
CTRL-HOME Move the cursor to the beginning of all text
CTRL-END Move the cursor to the end of all text
TAB In a node with multiple text areas, move to next area
SHIFT-TAB In a node with multiple text areas, move to previous area
BACKSPACE If any text is selected, delete the selected text. Otherwise, 

delete the character to the left of the cursor.
DEL If any text is selected, delete the selected text. Otherwise, 

delete the character to the right of the cursor.
ENTER Add a “hard” line break
Invalid Many control keys, and a few obscure punctuation keys are not 

allowed
Valid Standard characters such as letters, numbers. and punctuation 

are valid. As you type valid characters, they are inserted in the 
text at the cursor position. There is no overstrike mode. If any 
text is selected, the typed character replaces the selected text.

CTRL-B Toggle Bold for the current word or text being typed
CTRL-I Toggle Italics for the current word or text being typed
CTRL-U Toggle Underline for the current word or text being typed
CTRL-L Left-justify the text
CTRL-E Center-justify the text
CTRL-R Right-justify the text
CTRL-Z Undo text edit
CTRL-Y Redo text edit
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144 Chapter 9: Text
code entered from the numeric keypad. For example, the ANSI code for an “ae” 
character is 230. To type this character, while holding down the ALT key, type 0230 
on the numeric keypad. (Always include the leading zero.)

Guillemets (also known as chevrons, French quotation marks, or double angle 
brackets) «» can be added by entering their ANSI codes as described above (0171 and 
0187 respectively) or by typing two greater-than or less-than signs in a row.

Cutting, Copying, and Pasting Text
Selected text can be cut to the Windows clipboard, copied to the clipboard, and pasted 
from the clipboard. The combination of these features allows you to move text from 
one node to another, copy text from one node to another, or copy text from one 
diagram to another. You can also copy text to and from other programs.

To delete text (without moving it to the clipboard)
1. Select a range of text.
2. Press the DEL key or choose Delete from the Edit menu.

To cut text (and move it to the clipboard)
1. Select a range of text.
2. Choose Cut from the Edit menu.

To copy text to the clipboard
1. Select a range of text.
2. Choose Copy from the Edit menu.

To paste text from the clipboard
1. Position the cursor to the location in the text where you want to add the text from 

the clipboard.
2. Choose Paste from the Edit menu. The text from the clipboard is added at the 

cursor position. If any text was selected, the pasted text replaced the selected text.
When you are not in text mode, you can still paste text from the clipboard. In that case, 
a new label will automatically be created for you and positioned at the center of the 
screen with the text that was in the clipboard. The style of this label will be the last 
label style you selected.

Replacing Text
If any text is selected when you type from the keyboard or Paste, the selected text is 
first deleted before the new text is entered. This is a handy way to replace text.
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Setting Text Attributes 145
To replace a range of text
1. Select the range of text to replace.
2. Type the replacement text from the keyboard or Paste the replacement text from 

the clipboard.
3. The text that was originally selected is deleted before the new text is added.

Setting Text Attributes
Text attributes such as the font, size, color, and styles (bold, italic, and underline) can 
be set for the entire node or label or for any portion of text within the node or label. If 
you want all of the text within a node or label to have the same attributes, you can set 
those attributes in the Text tab of the Node or Label Properties dialog boxes, or you 
can select the node or label and use the property bar buttons (for instance the Bold 
button) to change the font attributes of the entire node or label.

However, you can also change the text attributes of a portion of the text for a single 
node or label in the following ways:

To set the text attributes of a portion of text within a node or label
1. In text mode, select the range of text.
2. Use the property bar buttons to change the font, font size, color or styles such as 

bold, italic, and underline for the range of text. Some of these attributes are also 
available through the right-click menu. By default, subscript, superscript, and all-
caps are available only through the right-click menu.

To set the text attributes of an individual word within a node or label
1. In text mode, select the word of text. There are a couple of ways to do this. The 

obvious way is just to click and drag until the whole word is selected. Another is 
to double click on the word. Another convenient way is to just place the cursor 
within the word after the first letter but before the last without any selection.

2. Use the property bar buttons to change the font, font size, color or styles such as 
bold, italic, and underline for the word. Some of these attributes are also available 
through the right-click menu. By default, subscript, superscript, and all-caps are 
available only through the right-click menu.

 
You can also control the text attributes of the text that you are about to type. Normally, 
text that you type will appear in the base font attributes of the node or label. In 
addition, if the cursor is located within the text in a place with its own text attributes 
(such as in the middle of a word that is bolded), typed text will naturally appear 
accordingly. However, you can also choose to select different text attributes to appear 
as you type.
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146 Chapter 9: Text
To set the text attributes for text that you are about to type 
1. In text mode, move the cursor to a position that is not within a word. It can be in 

front of or immediately following a word, or at the start or end of all the text.
2. Use the property bar buttons to change the font, font size, color or styles such as 

bold, italic, and underline for the text that you are about to type. Some of these 
attributes are also available through the right-click menu. By default, subscript, 
superscript, and all-caps are available only through the right-click menu.

3. Without moving the cursor, type your text. The attributes of the typed text will 
reflect those you just chose. If you move the cursor, for example by pressing the 
arrow keys, Typed text will return to using the text attributes already at the new 
cursor location.

Text Fields
Text fields are sections of text such as a date or filename that can be added to text 
within a diagram. For example, you can place the text caret within your text and 
instruct that the filename for the current diagram file be added to the text. Once the text 
field is added, its contents are updated automatically when it is displayed or printed.

Text fields include the diagram’s filename, the time and date that the diagram was 
created, and the time and date that the diagram was last saved. Each of these fields can 
be displayed in either a short or long version. Fields that indicate a time can be further 
customized to one of many short or long display formats.

Table 2: Text Fields
FIELD DESCRIPTION EXAMPLE
Filename (Short) Simple filename File.edg
Filename (Long) Full file path c:\Folder\File.edg
Create Time (Short) Short format (programmable) 

time/date file was created
09/07/08

Create Time (Long) Long format (programmable) 
time/date file was created

August 25, 2008 9:54 PM

Save Time (Short) Short format (programmable) 
time/date file was last saved

09/07/08

Save Time (Short) Long format (programmable) 
time/date file was last saved

August 25, 2008 9:54 PM
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Special Considerations 147
To insert a field into diagram text
1. Enter text mode using the text tool and clicking on the text area of a diagram 

object or label. (Fields cannot be inserted when editing text from the Text tab of 
the Properties screen.)

2. If the diagram is new, save it to a file before inserting a text field. Text fields 
display information about the current file which is not available if the diagram has 
never been saved.

3. Place the text caret where you want the text field inserted.
4. Select Insert Field from either the main Edit menu or from right-click menu and 

then select one of the fields to insert.
After inserting a text field, you can treat it like typed text. For example, you may want 
to set attributes for the field using Bold, Italics, Underline, or All Caps (the All Caps 
style can be found in the Character Style submenu within the right click menu). The 
main difference between the field text and typed text is that characters within the field 
text cannot be edited individually, and the field text will not break when wrapped, even 
if it contains spaces.

The display formats for the fields that reflects times can be customized using the 
Fields category within the Tools Options screen.

Special Considerations
When typing in a node or label with word-wrap active, This program remembers 
the difference between hard carriage returns (those you insert by pressing the 
RETURN key), and soft carriage returns that are inserted automatically during word 
wrap. Hard carriage returns remain in effect until you delete them. Soft carriage 
returns get added and deleted automatically every time the text is reformatted, 
such as when you resize the node.
A single node or label can contain a maximum of 4095 characters including those 
that are not visible such as carriage returns. This limit applies to the sum of all text 
in all text areas of a node.
Within a single node or label, you are limited to a maximum of 20 different text 
colors and 20 different fonts.
Text entry is always insert mode as opposed to overstrike mode. In overstrike 
mode, each new character you type would replace the next character in the 
previous text. Some other programs use the INSERT key to toggle between insert 
and overstrike mode. This program does not.
Undo is not supported for individual operations within text mode, for example, to 
undo the deletion of a single word. You can use Undo to undo all text changes 
since you started editing the node or label.
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CHAPTER
10 NODE STYLES

Like paragraph styles in word processors, styles are the true definitions of objects. In order 
to create any object, a node, label, or path, you must start with a predefined style. The style 
defines the initial characteristics and behaviors of the object.

To work with node styles choose Styles from the Nodes menu. If no styles are defined, 
you will be immediately prompted to create a new style. Otherwise, the Define Node Styles 
dialog box appears. This dialog box allows you to view and modify attributes of the 
existing styles.

Node Styles: Common Controls
The Define Node Styles dialog box contains tabs for General, Text, and Behavior styles 
which are described in following sections. This section describes the dialog controls that 
are always visible.
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150 Chapter 10: Node Styles
Model

The upper left corner of the dialog box contains a model of the node style. The model 
is an illustration of how a node of this style will appear in your diagram. As you 
modify style attributes that affect the appearance of the style, the model helps you to 
visualize the outcome.

Style Selection

Below the model is a list box containing names of all the node styles presently 
included in your diagram. The style that is selected is the one being shown in the 
model and reflected throughout all the other controls in the dialog box. When you 
make a change, this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Node Style dialog box appears to 
prompt for the name of the new style.

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style. 

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Immediately after you create a new style, you will need to select a node shape by 
pressing one of the Select or change shape buttons. 

Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 150 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



Node Styles: Common Controls 151
Rename

Press this button to change the name of a style. 

Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 

Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected node 
style. You should apply your changes before switching to select a different style or 
closing the dialog box. If you forget, you will be asked whether to apply or discard the 
changes before going on.

The selected node style
The Define Node Styles dialog box usually displays the attributes of a single selected 
node style. Each of the tabs groups a different set of attributes belonging to this same 
selected node style. 

You can tell which style is currently selected because it’s name is highlighted in the 
list box of styles at the left side of the dialog box, and a picture of the style is shown in 
the model area above the list box.

You can select a different style by clicking on its name in the list box located at the left 
of the dialog box or by choosing a new style from the Styles drop menu. As you move 
from style to style changing or viewing attributes of the style, you will see the right 
half of the dialog box change to reflect the new style’s attributes. 

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.

You can also select <All> instead of a single style. Changes you make to <All> will 
affect all styles in your diagram.
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152 Chapter 10: Node Styles
Node Styles: General
Use the General tab of the Define Node Styles dialog box to view and edit the basic 
properties of the selected node style such as its description, default dimensions, and 
colors.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Width

Enter the default width for nodes of this style here. Nodes that you create of this style 
will begin at this size. Choose zero to indicate no default width.

Height

Enter the default height for nodes of this style here. Nodes that you create of this style 
will begin at this size. Choose zero to indicate no default height.

From Selected

Rather than typing dimensions for Width and Height, you can select a single node 
before entering the node style dialog box, then press this button to use the width and 
height of that node as the style’s defaults. This button will be grayed unless a single 
node is selected in your diagram when you invoke the dialog box.
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Text color

To change the color of the text for nodes of this style, choose a color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Border color

To change the color of the border for nodes of this style, choose a color from the color 
selection drop menu. Borders must be a color that can be drawn solid on your screen. If 
you select a color that cannot be drawn solid, Windows draws the border in the nearest 
solid color.

Fill color

To change the interior fill color for nodes of this style, choose a color from the color 
selection drop menu. There are no restrictions on the fill color, it does not have to be 
solid.

Border width

To change the thickness of the lines that make up the border (outline) of nodes of this 
style, enter a new border width. You can also change the border width by pressing the 
up and down spin buttons to the right.

Line Pattern

Select a line pattern for drawing borders such as solid, dashed, dotted, and so on. The 
line style is used to draw for the entire outline of the shape, not just the outside edges 
so consider carefully before using a pattern other than solid. Also note that some older 
shapes cannot use this property.

Drop Shadow

Check this box to add a drop shadow to the node style to give it a three-dimensional 
look. All drop shadows in a diagram are the same size and color. You control the size 
and color from within the Diagram Properties dialog box.

Bind to style

When this property is checked, any object created with this style is automatically 
bound to the style. This means that if the style changes in the future, the object will 
change as well. If an object is not bound to the style, future changes to the style will 
not effect the object.

In drop menu

If this button is checked, the style appears in the node style drop menus, otherwise it 
does not. This is the same as checking Menu in the Choose a Node Style dialog box.
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154 Chapter 10: Node Styles
Style bar button

If this button is checked, a button with a representation of the style is included in on 
the style bar. Style bar buttons are useful for frequently used styles. Because the 
representation on a style bar button is not exact (contains no color or line thickness), 
they are not useful for every style. This is the same as checking Button in the Choose a 
Node Style dialog box.

Select or change shape
The remainder of the controls in the General tab of the Define Node Styles dialog box 
help you to set the shape (graphic definition) of the node style. 

Symbol Gallery

This button shows a graphic representation of the node symbol. Press this button to 
select a shape for the node style from the collection of built-in symbols contained in 
the symbol gallery. See the following section for detailed instructions.

Graphic from File

Press this button to select a graphic definition for the node style from an external 
graphics image file such as a Windows Metafile (.WMF or. EMF) or a Windows 
bitmap file (.BMP or.DIB). See the following section for detailed instructions.

Graphic from Selected

Press this button to copy a shape (symbol or graphic definition) for the node style from 
a single node that you selected in your diagram prior to entering this dialog box. For 
example, suppose you have copied and pasted a clipart image into your diagram and 
want to use that image as the shape of a node style. Select the lone node that appeared 
when you pasted the image into your diagram. Then open this dialog box, select the 
node style (or create a new one), and press this button. This button will be grayed 
unless a single node is selected in your diagram when you invoke the dialog box. See 
the following section for more details.

Graphic from Clipboard

Press this button to select a shape (graphic definition) for the node style from an image 
that is stored in the Windows clipboard. For example, you can create an image in 
Microsoft Paintbrush and do a Copy of it, then return to this program and paste it right 
into a style definition. See the following section for detailed instructions.
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Node Styles: Text
Use the Text tab of the Define Node dialog box to view and edit the style’s text and the 
properties of the style that affect the display and format of the text.

Text box

This area shows a model of the shape of the node. The dotted rectangles show the 
boundaries of the text region(s) in the node. If the node shape contains more than one 
text region, the arrows control which region is selected and marked by a dark gray 
dotted box.

Text

The text control to the right of the model displays the text that is contained in the node 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
node itself. 

Hidden

When checked, the selected text area is hidden and cannot be edited on-screen. Hiding 
text areas is useful when creating transparent shapes that have outlines but no fill. To 
make a shape completely transparent you need to use a null fill and make the text areas 
hidden, otherwise objects beneath the shape will not be selectable.

Alignment
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156 Chapter 10: Node Styles
Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.

Text color

To change the color of the node’s text, choose a different color from the color selection 
drop menu. If you select a color that cannot be drawn solid, Windows draws the text in 
the nearest solid color.

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
preview a sample of the font as you select it. Controls in this dialog are self-
explanatory.
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Node Styles: Connections 157
Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Margin

Select the internal text margin, the spacing between the text and the edges of the shape. 
Note that some shapes do not support fixed margins in which case their margins scale 
with the size of the shape.

Node Styles: Connections
Use the Connections tab of the Node Properties dialog box to view and edit the node’s 
connection points and properties.

Connection points

This area shows the location of any connection points within the node. One connection 
point is always selected and highlighted. You can use the mouse to drag and reposition 
connection points, select a different point. or right click to delete a connection point or 
add a new one. The arrow buttons cycle through the selected connection point. The 
Add button adds a new point, and the Delete button deletes the highlighted point.

Name or Description

Each connection point can have a name or description. Use this control to view and 
edit the name of the selected connection point.
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158 Chapter 10: Node Styles
Snap to center and edges

Check this box to have the mouse snap to the centers and edges of the node while you 
drag a connection point with the mouse (in this dialog box).

Snap to grid

Check this box to have the mouse snap to the diagram grid while you drag a 
connection point with the mouse (in this dialog box).

Terminate connections to connection points at border

Check this box to cause connections to terminate at the border of the node rather than 
extending all the way to the connection points. 

Enable standard center connect (terminated at border)

Check this box to enable paths to attach at the center of the node. This option is useful 
if you have a node with connection points. You can choose to allow paths to attach 
only at the connection points, or to the node center also.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 158 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



Node Styles: Behaviors 159
Node Styles: Behaviors
Use the Behaviors tab of the Define Node Styles dialog box to view and edit the 
properties that affect the way nodes of this style behave within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the node. If 
set to Prevent, additional characters are not allowed. If set to Expand, the node 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the node 
does not change and the text word-wraps automatically to the next line. 

Horizontal expansion

This property controls in which direction the node expands when it expands 
automatically in the horizontal direction, such as when you type more text than will fit 
in the current width of the node. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a node of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the node automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.
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160 Chapter 10: Node Styles
Vertical expansion

This property controls in which direction the node expands when it expands 
automatically in the vertical direction, such as when you type more lines of text than 
will fit in the current height of the node. 

Horizontal center snaps to grid

Check this property to cause the node's horizontal center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for nodes that are connected to other nodes as it will aid in keeping nodes 
aligned horizontally.

Vertical center snaps to grid

Check this property to cause the node's vertical center to snap to the grid when you 
create it or move it, provided snap is enabled. You will generally want to set this 
property for nodes that are connected to other nodes as it will aid in keeping nodes 
aligned vertically.

Width snaps to grid

When this property is checked (and the snap grid is enabled), the node's width remains 
an even multiple of the snap grid when you resize the node. 

NOTE: When the height and width snap to the grid, both sides are aligned with snap 
grid lines which are not necessarily the same as the visible grid lines. In 
effect, the total width or height is always a multiple of twice the snap 
spacing. For example, if the snap spacing is one quarter of an inch and a 
node has the Width snaps to grid property, that node width can be 1/2 in., 1 
in., 1 1/2 in. and so on, but it cannot be 3/4 in. 

Height snaps to grid

When this property is checked (and the snap grid is enabled), the node's height remains 
an even multiple of the snap grid when you resize the node. 

Left and right edges snap to grid

When this property is checked and the snap grid is enabled, the node's left and right 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default 
size without intentionally resizing it.

If the node’s width is not an even multiple of the snap grid and you drag the node, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the node. In this case, either edge (the one that is closest) is aligned to the grid. 
And if the center is closest to the grid and Horizontal center snaps to grid is also 
enabled, the node can snap there as well. There are also cases where the node is 
allowed to snap in other positions to help keep lines straight. If the node’s width is not 
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Node Styles: Behaviors 161
an even multiple of the snap grid and you resize the node by dragging a resize handle, 
only the edge that the handle is on (the one you are dragging) aligns to the grid. To 
resize it so that both edges are aligned to the grid, resize it using both the left handle 
and the right handle.

This property and Horizontal center snaps to grid are mutually exclusive. Only one 
can be in effect. This property is most useful when Center stationary when resizing 
horizontally is disabled.

Top and bottom edges snap to grid

When this property is checked and the snap grid is enabled, the node's top and bottom 
edges snap to the grid when you move, create, or resize the node. But not if you move 
or resize it along with a group of selected objects, or if you create it with its default size 
without intentionally resizing it.

If the node’s height is not an even multiple of the snap grid and you drag the node, it 
would obviously not be possible for both edges to be aligned to the grid without 
resizing the node. In this case, either edge (the one that is closest) is aligned to the grid. 
And if the center is closest to the grid and Vertical center snaps to grid is also enabled, 
the node can snap there as well. There are also cases where the node is allowed to snap 
in other positions to help keep lines straight. If the node’s height is not an even 
multiple of the snap grid and you resize the node by dragging a resize handle, only the 
edge that the handle is on (the one you are dragging) aligns to the grid. To resize it so 
that both edges are aligned to the grid, resize it using both the top handle and the 
bottom handle.

This property and Vertical center snaps to grid are mutually exclusive. Only one can 
be in effect. This property is most useful when Center stationary when resizing 
vertically is disabled.

Center stationary when resizing horizontally

Check this property to cause the center of the node to remain in the same place when 
you resize it horizontally by dragging the handles. 

This property is useful when nodes are lined up vertically one on top of the other and 
potentially connected by a single path from the horizontal center of one node to the 
horizontal center of another above or below it. With this property, the node will remain 
aligned with the others if it is resized horizontally. 

Center stationary when resizing vertically

Check this property to cause the center of the node to remain in the same place when 
you resize it vertically by dragging the handles. 

This property is useful when nodes are lined up horizontally one alongside the other 
and potentially connected by a single path from the vertical center of one node to the 
vertical center of another to its right or left. With this property, the node will remain 
aligned with the others if it is resized vertically. 
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162 Chapter 10: Node Styles
Keep sized to text

When this property is checked, the node is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a node such that the node has less text 
than it had before, the node will automatically resize itself to shrink down around the 
new text as soon as you complete editing the text.

Preserve aspect ratio

When this property is checked, the node retains its current aspect ratio (its height 
compared to its width) when you resize the node by dragging the corner handles or 
when the node expands due to typing text. You can still change the aspect ratio of the 
node by dragging the side handles, setting the size directly in the General tab, or using 
the From Selected button.

Automatic Text Scaling

When this property is checked, the object text scales automatically when you resize the 
object. Objects having this property always maintain a fixed aspect ratio (height vs. 
width) over-riding the Preserve Aspect Ratio property.

Do not print or export

When this property is checked, the object will not appear in print-outs or when the 
diagram is copied or exported. This property is useful for hiding objects that exist only 
for visual notation on the screen, and for implementing hyperlinks to other diagrams or 
documents.

Active container - keep contained objects together

When this property is checked, the node serves as a container object that automatically 
keeps objects contained within its bounds together as a unit. Moving the container 
results in moving along the contents. Copying the container copies the contents. 
Deleting the container deletes the contents, and so on. Note, if the container is filled, 
only objects on top of the container are kept together. If it has no fill, all objects above 
or below are kept together.

This property is usually set along with others for the purpose of creating a container, a 
special type of node that identifies a subset of your diagram (see  Active Containers - 
Keeping Objects Together on page 64).
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Node Styles: Auto Label 163
Node Styles: Auto Label
Use the Auto Label tab of the Define Node Styles dialog box to view and edit the 
style’s auto label.

Automatically label nodes created using this style

Check this box to enable auto-label for this style.

Label Text

Enter the text for the auto label.

Node Styles: Fill
Use the Fill tab of the Node Styles dialog box to view and edit the node style’s fill 
properties.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 163 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



164 Chapter 10: Node Styles
Linear gradient view.

Elliptical gradient view:
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Node Styles: Fill 165
Fill method

Select the type of fill. The remainder of controls on this screen depend on which 
method is selected.

Color

A single color control is available when the fill method is 'Solid color'. Use this control 
to select the solid fill color.

From/To

The 'From' and 'To' color selection controls are available when the fill method is 
'Linear gradient' or 'Elliptical gradient'. Use these controls to select the start and end 
colors that are blended across the gradient.

Blend

The 'Blend' control is available when a gradient fill method is selected. Use this control 
to choose how the 'From' color is blended into the 'To' color across the gradient. Linear 
blend means simply that the 'From' color is blended uniformly into the 'To' color. 
When 'Bell curve' is selected, the 'From' color blends into the 'From' color based on a 
normal distribution bell curve contributing to a natural 3D shading effect. When 
'Platform' is selected, the gradient begins with the 'From' color, gradually blends to a 
color midway between 'To' and 'From', remains constant for a certain distance, and 
then blends to the 'To' color.

Angle

The 'Angle' control is available when the linear gradient fill method is selected. Use 
this control to select an angle for the blend. For cylindrical blends, angles of 180 or 
greater cause the swapping of the 'From' and 'To' colors.

Intensity

The 'Intensity' control is available when a gradient fill method is selected. Use this 
control to select how prominent the 'From' color appears in the blend. A value of 100 is 
most intense, while a value of zero makes the 'From' color undetectable. Intensity is 
most useful when used with a white or black 'From' color in order to achieve a gradient 
between two shades of the same color but without having to actually choose two 
shades of the color separately.

Center

The 'Center' control is available only with the linear gradient fill method. Use this 
control to position the midpoint of the gradient from 0 to 100. If the 'Blend' is set to 
'Platform' this control affects the size of center rather than the position.
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166 Chapter 10: Node Styles
X Offset, Y Offset

These controls are available only for the elliptical gradient fill method. Choose values 
from 0 to 100 to position the center of the elliptical gradient anywhere on the node. An 
off-center elliptical gradient produces a 3D appearance.

Spread

This control is available only for the elliptical gradient fill method. Choose a value 
from 0 to 100 to increase the size of the center region of the gradient.

Presets

Choose a preset fill as a shorthand for popular combinations of the above options. 
Presets combine all of the fill properties except for the 'To' color which is 
independently controllable.

Node Styles: Tabs
Use the Tabs tab of the Node Styles dialog box to view and edit the style’s tab stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.
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Setting Node Style Symbol or Graphic 167
Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.

Clear

Click to remove the highlighted tab stop from the tab stop list.

Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a style must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.

Setting Node Style Symbol or Graphic
The graphic definition can be a predefined symbol or an imported graphic image.

Using a predefined symbol as a node style graphic
Press the Symbol from Gallery button to access the Node Symbol Gallery dialog box 
to select a node symbol. See the following section for instructions.

Using a graphic image as a node shape
You can define a node style using a graphic or clipart image imported from a file, from 
a node in your diagram, or from the Windows clipboard.

Several import formats are supported. A complete discussion of supported formats is 
contained elsewhere (see  Importing Graphics on page 211).

To import a graphic image from a file to serve as the node style shape
1. Press the Graphic from File button in the Define Node Style dialog box.
2. Choose the graphic file type in the List files by type box.
3. Select a graphics file and press OK.
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168 Chapter 10: Node Styles
To copy a graphic image or symbol from an existing node to serve as the 
node style shape
1. In your diagram, select the single node that contains the graphic that you want to 

use as your node style shape. This might be a node that was created when you 
pasted a clipboard image into your diagram from another program.

2. Enter the Define Node Styles dialog box by choosing Styles from the Nodes 
menu.

3. Press the Graphic from Selected button in the General section of the dialog box.

To import a graphic image from the Windows clipboard to serve as the 
node style shape
1. Copy a graphic image into the Windows clipboard. In another program, this is 

usually as simple as selecting the image and choosing copy.
2. Enter the Define Node Styles dialog box by choosing Styles from the Nodes 

menu.
3. Press the Graphic from Selected button in the General section of the dialog box.

Node Symbol Gallery
The Node Symbol Gallery is a library of the pre-defined symbols available to your 
diagram. Use the node symbol gallery to select a symbol when (a) changing a node 
shape in the Node Properties dialog box, (b) selecting a node style shape in the Define 
Node Styles dialog box, or (c) using the Insert Symbol feature.

The node symbols
The program comes with an initial collection of node symbols. These are categorized 
by shape and by diagram type. 
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Defining a Style Based on Node in your Diagram 169
Using the Node Symbol Gallery dialog box
Invoke the Node Symbol Gallery dialog box to find, preview, and select a node 
symbol.

The dialog box displays the installed node symbols. The highlighted box indicates the 
selected symbol. At the left is a list of categories. Check Show text areas to display the 
text areas within the symbols.

Select a symbol by clicking on it and pressing OK, or by double-clicking on it.

Defining a Style Based on Node in your Diagram
When you create a node in your diagram, it will start out as defined by the style you 
chose to base it on. You may then set the properties of that new node in special ways 
such as giving it a specific color, or a new font size. Once you have altered the node 
you may then want to update the style it was based on to reflect the changes such that 
all existing objects of that style, and all new objects of that style reflect the properties 
of the node.

Update Style From
With the Update Style From feature you can use an existing node to redefine the style 
that it was created from.

To update a style based on an existing node of the style
1. Right-click on the node and choose Update Style From. from the right-click 

menu.
OR
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170 Chapter 10: Node Styles
2. Select the node and choose Update Style From.. from the Nodes menu.

New Style From
With the New Style From feature you can use an existing node to define a new style.

To define a new style based on an existing node 
1. Right-click on the node and choose New Style From.. from the right-click menu.

OR

2. Select the node and choose New Style From.. from the Nodes menu.
3. Enter a name for the style when prompted. The style will appear in the style bar on 

the left of the screen by default. If you don’t want it there just right-click on the 
button and choose Hide.

Reapplying a Node Style
Use the Reapply Style feature to restore a node to the properties of its initial style. This 
will work for any node with an associated style. Most nodes have an associated style 
because they were created by choosing from a style. Those that do not have an 
associated style are created in other ways, such as by importing graphics or inserting 
symbols directly without specifying a style. You can review and change the associated 
style in the Node Properties screen. 

To reapply the properties of the original style to one of more nodes 
1. Select one or more nodes that have an associated style.
2. Right-click on the node and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style from the Nodes menu.

NOTE: Certain properties that are judged to be critical to a specific object will not 
be restored from the style when you reapply. One example is the node text. 
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CHAPTER
11 LABEL STYLES

Label styles are similar to node styles. Label styles define the initial characteristics and 
behaviors of labels. Labels are essentially specialized nodes. Therefore, working with label 
styles is very much like working with node styles.

To work with label styles, choose Styles from the Labels menu. If no styles are defined, 
you are immediately prompted to create a new style. If any styles are defined, the Define 
Label Styles dialog box appears. This dialog box allows you to view and modify attributes 
of the existing styles.

Label Styles: Common Controls
The Define Label Styles dialog box contains tabs for General, Text, and Behavior styles 
which are described in following sections. This section describes the dialog controls that 
are always visible.
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172 Chapter 11: Label Styles
Model

The upper left corner of the dialog box contains a model of the label style. The model 
is an illustration of how a label of this style will appear in your diagram. As you 
modify style attributes that affect the appearance of the style, the model helps you to 
visualize the outcome.

Style Selection

Below the model is a list box containing names of all the label styles presently 
included in your diagram. The style that is selected is the one being shown in the 
model and reflected throughout all the other controls in the dialog box. When you 
make a change, this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Label Style dialog box appears to 
prompt for the name of the new style

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style.

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.

Rename

Press this button to change the name of a style. 
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Label Styles: Common Controls 173
Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 

Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected label 
style. You should apply your changes before switching to select a different style or 
closing the dialog box. If you forget, you will be asked whether to apply or discard the 
changes before going on.

The selected label style
The selected label style is similar in function to the selected node style described in the 
previous chapter.

To view a different style
1. Choose a different style by name from the style list box by clicking on the current 

style name.
or

2. Use the style drop menu button Styles located above the style list box to select a 
different style by its appearance.

When you choose a different style, the controls reflect the properties of the style and 
the style model at the upper left displays a sample of the style with its current 
properties.

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.
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174 Chapter 11: Label Styles
Label Styles: General
Use the General tab of the Define Label Styles dialog box to view and edit the basic 
properties of the selected label style such as its description, default dimensions, and 
colors.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Width

Enter the default width for labels of this style here. This field is not particularly 
important for labels because they resize automatically to fit their text.

Height

Enter the default height for labels of this style here. This field is not particularly 
important for labels because they resize automatically to fit their text.

From Selected

Rather than typing dimensions for Width and Height, you can select a single node or 
label before entering the label style dialog box, then press this button to use the width 
and height of that object as the style’s defaults. This button will be grayed unless a 
single node is selected in your diagram when you invoke the dialog box.
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Label Styles: General 175
Text color

To change the color of the text for label of this style, choose a color from the color 
selection drop menu. If you select a color that cannot be drawn solid, Windows draws 
the text in the nearest solid color.

Bind to style

When this property is checked, any object created with this style is automatically 
bound to the style. This means that if the style changes in the future, the object will 
change as well. If an object is not bound to the style, future changes to the style will 
not effect the object.

In drop menu

If this button is checked, the style appears in the label style drop menus, otherwise it 
does not. This is the same as checking Menu in the Choose a Label Style dialog box.

Style bar button

If this button is checked, a button with a representation of the style is included in on the 
style bar. Style bar buttons are useful for frequently used styles. Because the 
representation on a style bar button is not exact (contains no color or line thickness), 
they are not useful for every style. This is the same as checking Button in the Choose a 
Label Style dialog box.
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176 Chapter 11: Label Styles
Label Styles: Text
Use the Text tab of the Define Label Styles dialog box to view and edit the style’s text 
and the properties of the style that affect the display and format of the text.

Text

The text control to the right of the model displays the text that is contained in the node 
in the selected text region. The text here can be edited using the usual Windows edit 
box controls including copy and paste. Notice that text in this box just shows the 
words. It does not reflect the font, text size, boldness, or alignment as it would in the 
node itself. 

Alignment

Use the alignment controls to determine how the text is aligned horizontally (left, 
center, or right) and vertically (top, middle, or bottom).

Font

Choose the font family to display the font.

Bold, Italic, and Underline

Select common font attributes.

Size

Use the drop down box to select a point size for the font.
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Label Styles: Text 177
Text color

To change the color of the node’s text, choose a different color from the color selection 
drop menu. If you select a color that cannot be drawn solid, Windows draws the text in 
the nearest solid color.

Line Spacing (at lower left)

Select the spacing between lines of text. Single spaced is the default and most common 
option. 

Ellipsis (...)

Use the button with the three dots to choose the font attributes using the standard 
Windows font selection dialog box shown below. This method also allows you to 
preview a sample of the font as you select it. Controls in this dialog are self-
explanatory.
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Label Styles: Behaviors
Use the Behaviors tab of the Define Label Styles dialog box to view and edit the 
properties that affect the way labels of this style behave within your diagram.

Line too long

This property controls what happens when typed text becomes too wide for the node. 
If set to Prevent, additional characters are not allowed. If set to Expand, the node 
automatically grows wider as you continue typing. The direction of expansion is 
controlled by the Horizontal expansion property. If set to Wrap, the width of the node 
does not change and the text word-wraps automatically to the next line. 

Too many lines

This property controls what happens when typed text exceeds the number of lines that 
fit in a node of this style. If set to Prevent, additional lines are not allowed. If set to 
Expand, the node automatically grows taller as you add lines. The direction of 
expansion is controlled by the Vertical expansion property.

Horizontal center snaps to grid

It is generally best to disable this property for labels.

Vertical center snaps to grid

It is generally best to disable this property for labels.

Width snaps to grid

It is generally best to disable this property for labels.
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Height snaps to grid

It is generally best to disable this property for labels.

Left and right edges snap to grid

It is generally best to disable this property for labels.

Top and bottom edges snap to grid

It is generally best to disable this property for labels.

Center stationary when resizing horizontally

Check this property to cause the center of the label to remain in the same place when 
you resize it horizontally by dragging the handles. 

Center stationary when resizing vertically

Check this property to cause the center of the label to remain in the same place when 
you resize it vertically by dragging the handles. 

Keep sized to text

When this property is checked, the node is always sized to exactly fit the amount of 
text it contains. For example, if you edit text for a node such that the node has less text 
than it had before, the node will automatically resize itself to shrink down around the 
new text as soon as you complete editing the text.

Automatic Text Scaling

When this property is checked, the label text scales automatically when you resize the 
label. Labels having this property always maintain a fixed aspect ratio (height vs. 
width).
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Label Styles: Tabs
Use the Tabs tab of the Label Styles dialog box to view and edit the style’s tab stops.

Tab stop position

This box shows the position of a single tab stop that you can edit or create. It can 
reflect a tab stop highlighted in the tab stop list, or it can reflect a new tab to be added 
to the list.

Alignment

Select how text is aligned at the tab stop. Note that decimal tab stops, align text on the 
decimal point character which may vary by locale.

Set

Click to add the tab stop defined by the tab stop position and the alignment controls to 
the tab stop list. If the tab stop position corresponds to a tab stop already in the list, that 
tab stop will be updated. Otherwise, the new tab stop will be added. To change the 
position of an existing tab stop, add a tab stop at the new position, then clear the old 
one.

Clear

Click to remove the highlighted tab stop from the tab stop list.
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Default tabs every

In addition to individual tab stops defined in the tab stop list, you can define a default 
tab stop interval, or set this field to zero for none. Tab stops occur at every interval of 
this distance from the left margin, beyond any individually defined tab stops.

NOTE: Note that a style must have simple left text justification in order for tabs to 
be expanded and tab stops to be in effect.
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Defining a Style Based on a Label in your Diagram
When you create a label in your diagram, it will start out as defined by the style you 
chose to base it on. You may then set the properties of that new label in special ways 
such as giving it a specific color, or a new font size. Once you have altered the label 
you may then want to update the style it was based on to reflect the changes such that 
all existing objects of that style, and all new objects of that style reflect the properties 
of the label.

Update Style From
With the Update Style From feature you can use an existing label to redefine the style 
that it was created from.

To update a style based on an existing label of the style
1. Right-click on the label and choose Update Style From.. from the right-click 

menu.
OR

2. Select the label and choose Update Style From.. from the Labels menu.

New Style From
With the New Style From feature you can use an existing label to define a new style.

To define a new style based on an existing label 
1. Right-click on the label and choose New Style From.. from the right-click menu.

OR

2. Select the label and choose New Style From.. from the Labels menu.
3. Enter a name for the style when prompted. 

Reapplying a Label Style
Use the Reapply Style feature to restore a label to the properties of its initial style. This 
will work for any label with an associated style. Only those labels that were created 
from a style have an associated style unless you assign one yourself. When you simply 
click on the Text tool rather than using a test style button to create a label, that label 
will not have an associated style. You can review and change the associated style in 
the Label Properties screen.
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Reapplying a Label Style 183
To reapply the properties of the original style to one of more labels 
1. Select one or more labels that have an associated style.
2. Right-click on the label and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style from the Labels menu.

NOTE: Certain properties that are judged to be critical to a specific object will not be 
restored from the style when you reapply. One example is the node text. 
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CHAPTER
12 PATH STYLES 

Path styles define the initial characteristics and behaviors of paths. This chapter describes 
how to define, create, modify and delete path styles.

To work with path styles choose Styles from the Paths menu. If no styles are defined, you 
are immediately prompted to create a new style. If any styles are defined, the Define Path 
Styles dialog box appears.

Path Styles: Common Controls
The Define Path Styles dialog box contains tabs for General. Line, and Ends styles which 
are described in following sections. This section describes the dialog controls that are 
always visible.

Model

The upper left corner of the dialog box contains a model of the path style. The model is an 
illustration of how a path of this style will appear in your diagram. As you modify style 
attributes that affect the appearance of the style, the model helps you to visualize the 
outcome.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 185 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



186 Chapter 12: Path Styles
Style Selection

Below the model is a list box containing names of all the path styles presently included 
in your diagram. The style that is selected is the one being shown in the model and 
reflected throughout all the other controls in the dialog box. When you make a change, 
this is the style that is altered.

Above the list box is a button labeled Styles that provides a drop menu for changing 
the selected style.

New

Press this button to create a new style. The New Path Style dialog box appears to 
prompt for the name of the new style.

Press OK immediately to accept the default name, or enter a more descriptive name of 
your own. The name must not match the name of any existing style.

We strongly recommend that you enter a descriptive name for the style. This will help 
you remember the style’s purpose. Now is the time to do it, because if you want to 
change the name later, the only way to do it is to copy the style to one of a new name 
and delete the old style. This can be inconvenient because you may have to go back 
and define and existing objects of the old style to the new style (by editing its 
properties).

Copy

Press this button to create a new style that is a copy of the current style. Enter a 
descriptive name for the style as with New above.

Rename

Press this button to change the name of a style. 

Delete

Press this button to delete the currently selected style. You will be asked to confirm the 
deletion before it takes effect. Be very careful. Deleting a style cannot be undone. If 
you have any doubts, save your diagram before deleting any styles.

When you delete a style, any objects in the diagram that were created with this style 
and bound to it become unbound. 
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Close

Press this button to exit the dialog box. If you have made changes to the currently 
selected style that you have not yet applied, you will be asked to do so before exiting.

Apply

Press this button to apply all the changes you have made to the currently selected path 
style. You should apply your changes before switching to select a different style or 
closing the dialog box. If you forget, you will be asked whether to apply or discard the 
changes before going on.

The selected path style
The selected path style is similar in function to the selected node style described in a 
previous chapter.

To view a different style
1. Choose a different style by name from the style list box by clicking on the current 

style name.
or

2. Use the style drop menu button Styles located above the style list box to select a 
different style by its appearance.

When you choose a different style, the controls reflect the properties of the style and 
the style model at the upper left displays a sample of the style with its current 
properties.

If you attempt to switch styles after making changes to the current style properties but 
before you apply those changes to the style, you will be asked whether you want to 
apply the changes before switching to the new style.
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Path Styles: General
Use the General tab of the Define Path Styles dialog box to view and edit the basic 
properties of the selected path style.

Description

The description is a short text description of the style. This description is displayed in 
the status bar when the style is selected.

Bind to style

Check this box to choose whether or not a path’s properties are bound to the style. If a 
path’s properties are bound to its style, then anytime the style properties change, the 
path gets the new properties automatically. You will generally want to set this option 
for normal path.

In drop menu

Check this box to have this style appear in the Paths style drop menu.

Style bar button

Check this box to have the style appear on a button on the style bar.

Orthogonal

This property can provide some assistance in creating and keeping paths orthogonal 
(all lines vertical or horizontal). Guided provides adequate help for most cases. 
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Path Styles: Line
Use the Line tab of the Define Path Styles dialog box to view and edit the line of the 
selected path style.

Line

A path line can be one of many line styles such as solid, dashed, dotted, and so on. To 
change the path’s line style, choose a new line style from the drop menu.

Color

To change the color of the path, choose a different color from the color selection drop 
menu. Use of this drop menu is described elsewhere (see  Choosing Colors on page 
38).

Width

To change the line width of the path, enter a width or use the up and down spin 
buttons. You can also choose a standard width by clicking on the drop menu.

Curvature

Select one of the curvature options for the path. The path of the path can be straight, 
curved. smoothed, rounded, or arced (see  Curved Paths on page 94).

Corners

Choose a corner style (also known as a line join style). These options apply to the way 
that thick straight paths appear when two segments meet. Note that corners will appear 
rounded when imported into other documents.
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Flow symbols along line

Check this box to enable flow symbols to be drawn along the path of the path.

Kind

Choose the kind of flow symbol from the flow symbol drop menu.

Fill color

Choose a fill color for the flow symbols. 

Border color

Choose a border color for the flow symbols.

Size

Choose the size for the flow symbols.

Spacing

Choose the spacing interval between flow symbols.

Border width

Choose the line width of the borders of the flow symbols.
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Path Styles: Ends
Use the Ends tab of the Define Path Styles dialog box to view and edit the appearance 
of the symbols terminators that are drawn at the ends of the path (such as arrowheads).

Terminator 1

To change the originating end of the path, choose a color, size, and terminator symbol.

Symbol

Select an terminator symbol shape from the terminator symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the Terminator Gallery.

Fill color

Choose a fill color for this terminator symbol.
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Symbol size

Choose a size for this terminator symbol.

Terminator 2

To change the terminating end of the path, choose a color, size, and terminator symbol.

Symbol

Select a terminator symbol shape from the terminator symbol drop menu. 

The symbols above the line are always available. The symbols below the line (if 
any) are the non-built-in symbols used in this diagram. Click on the three dots on 
the lower right to choose from more symbols in the Terminator Gallery.

Fill color

Choose a fill color for this terminator symbol.

Symbol size

Choose a size for this terminator symbol.

Borders

To change the width of the borders around the path ends, enter a border width or use 
the up and down spin buttons.
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Terminator Gallery
The Terminator Gallery is a library of the pre-defined terminator symbols (arrowheads 
and such) available to your diagram. Use the terminator gallery to select a terminator 
symbol to use as the shape of a path’s arrowhead.

The terminator symbols
The program comes with an initial collection of terminators including a number of 
built-in arrows that are always visible in the drop menu. These are categorized by 
shape and by diagram type. 

Using the Terminator Gallery dialog box
Invoke the Terminator Gallery dialog box to find, preview, and select a terminator 
symbol.

The dialog box displays the terminators. The highlighted box indicates the selected 
symbol. At the left is a list of categories.

Select a symbol by clicking on it and pressing OK, or just be double-clicking on it.
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Path Styles: Behaviors
Use the Behaviors tab of the Path Styles dialog box to view and edit the properties that 
affect the way paths of this style behave within your diagram.

Do not treat as a flow (no drop-ins)

When checked, “flow” properties will be disabled for paths of this style. For example, 
you will not be able to drop a new or existing node into the flow of the path 
automatically connecting the node in-line with the path. This behavior only has 
meaning if the “Snap figures into flows” option is enabled in the Snap Labels section 
under Edit in the Tools Options screen. This property is useful when a path is used as a 
simple line rather than for connecting nodes.

No crossovers (jogs)

When checked, paths of this style will not use jogs when crossing over other paths, nor 
will other paths use jogs when crossing over paths of this style. This behavior only has 
meaning if jogs are enabled in the diagram (see Diagram Properties Paths). This 
property is useful when a path is used as a simple line rather than for connecting nodes.
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Path Styles: Auto-Label
Use the Auto-Label tab of the Define Path Styles dialog box to view and edit the 
properties that affect the automatic labeling of paths created with this style.

Automatically add a default label upon creation

Check this box to cause paths of this style to be labeled with default text automatically 
when created. The label’s style and hence its size, color, font and so on are controlled 
by the current Path Label Style defined in the Labels tab of the Diagram Properties 
dialog box.

Label text

Enter the default text of the auto-label. 

Position

Select whether the automatically created label will appear in-line or alongside the path 
above or below (or to the right or left of vertical paths). The label will always be 
centered along the length of the path and the text will be center-justified. Also note that 
if you create the path with multiple segments, the label will appear on the first 
segment. 
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Path Styles: Stamp
Use the Stamp tab of the Define Path Styles dialog box to control how a path of the 
style gets created. Whereas normally a path is created by clicking one endpoint then 
the other, it can also be created as a stamp with a predetermined length and orientation. 
Use this dialog box to define these attributes.

Automatically add a default label upon creation

Checking this property allows you to create paths of this style as a stamp similar to 
how you create nodes. In other words, when you select the label style and enter 
connect mode, the cursor will become a representation of a fixed size segment of the 
path that you can “stamp” onto your diagram rather than clicking twice to define the 
endpoints of the path. 

Length

A stamp path requires a fixed (non-zero) length. This is the size of the path that will be 
created when you stamp it onto your diagram. 

Orientation

A stamp path requires an orientation. The stamp path can point in any of the directions 
provided. 

NOTE: Note that the stamp attribute controls only how a path is created. Once it is 
created it is identical to any other path and can be adjusted in any of the 
usual ways.
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Defining a Style Based on a Path in your Diagram
When you create a path in your diagram, it will start out as defined by the style you 
chose to base it on. You may then set the properties of that new path in special ways 
such as giving it a specific color. Once you have altered the path you may then want to 
update the style it was based on to reflect the changes such that all existing objects of 
that style, and all new objects of that style reflect its properties.

Update Style From
With the Update Style From feature you can use an existing path to redefine the style 
that it was created from.

To update a style based on an existing path of the style
1. Right-click on the path and choose Update Style From.. from the right-click 

menu.
OR

2. Select the path and choose Update Style From.. from the Paths menu.

New Style From
With the New Style From feature you can use an existing path to define a new style.

To define a new style based on an existing path 
1. Right-click on the path and choose New Style From.. from the right-click menu.

OR

2. Select the path and choose New Style From.. from the Paths menu.
3. Enter a name for the style when prompted. 

Reapplying a Path Style
Use the Reapply Style feature to restore a path to the properties of its initial style. This 
will work for any path with an associated style. Most paths do have an associated style 
because they were created by choosing from a style. You can review and change the 
associated style in the Path Properties screen. 

To reapply the properties of the original style to one of more paths 
1. Select one or more paths that have an associated style.
2. Right-click on a path and choose Reapply Style from the right-click menu.

OR

3. Choose Reapply Style from the Paths menu.
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NOTE: Certain properties that are judged to be critical to a specific object will not 
be restored from the style when you reapply. One example is the path’s 
curvature. 
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CHAPTER
13 GROUPS

You can combine diagram objects into a group so you can work with them as though they 
were a single object. You can then move, copy, delete, and resize the group as a single unit. 
You can also use groups to apply property changes to all of the included objects without 
being required to select each object separately. Groups are convenient for positioning and 
aligning objects as a set as well, and you can even create groups containing other groups to 
help you construct complex diagrams.

Creating a Group
You can create a group from almost any set of objects from your diagram using the Group 
feature.

To create a group
1. Select a number of objects or existing groups. You can use the lasso selection to select 

objects within a rectangular area and/or use Shift-Click to add other objects to the 
selection. 

2. Choose the Group command from the Grouping submenu of the main Edit menu, or 
from the right click menu, or use the hot key combination Ctrl-G.

3. The newly created group will now appear as a single selectable item. 

When you create a new group, two changes will automatically take place to the set of 
objects making up the group. First, certain objects may be excluded or included despite 
whether they were selected or not; this occurs to preserve other relationships between 
objects. Also, the members of the group become re-ordered with respect to objects outside 
the group such that all objects in the group are immediately in front of, or behind one 
another. The objects within the group will retain their relative ordering so the re-ordering 
will rarely be noticed. 
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Breaking Apart a Group
You can break a group apart into its original components using the Ungroup and 
Ungroup All commands.

To break a group apart
1. Select the group (or groups).
2. Choose the Ungroup command from the Grouping submenu of the main Edit 

menu, or from the right click menu, or use the hot key combination Ctrl-U.
3. Each selected group will be broken apart leaving the components as individual 

objects once again. If the group was composed of other groups, those groups will 
once again be accessible as individual groups. 

To break a group apart completely
1. Select the group (or groups).
2. Choose the Ungroup All command from the Grouping submenu of the main Edit 

menu, or from the right click menu.
3. Each selected group will be broken apart leaving the components as individual 

objects once again. If the group was composed of other groups, those groups will 
also be broken apart, and so on until the selection contains no more groups just 
individual ungrouped objects.

Ungroup All is the same as doing Ungroup repeatedly until all groups and nested 
groups, and nested groups and so on are broken apart. The only difference is that the 
Regroup feature described below is not available following Ungroup All.

Re-establishing a Group
You can use the Regroup feature to re-establish a single group that you just broke 
apart. You can also accomplish this by immediately undoing the Ungroup command 
but the Regroup feature provides the added capability to re-establish the group after 
performing additional steps. The most common usage of Regroup is to temporarily 
break apart a group for the purpose of editing some components individually 
(changing their size, position, color etc.). The regroup feature makes this common task 
easier and less error prone because you don’t need to remember exactly which objects 
were in the group and then select then afterwards without error to regroup them.

Note that you can only regroup a single group, the last group that you ungrouped 
individually. Therefore, to have the option of regrouping a group, select a single group 
and ungroup it alone, not within a selection containing other groups, and not using the 
Ungroup All.
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Working with Groups 201
To re-establish the more recent group
1. Right click either with nothing selected or on an object that belonged to the group 

and select Regroup from the menu.
2. The original group will be re-established with all of its members. 

You can regroup the last ungrouped group only until you perform a function that 
affects the identify of the group or its members. These include deleting an original 
member of the group, creating any new group, or performing another Ungroup or 
Ungroup All. If Regroup is not available in the menu, you will need to select the 
members of the group again and use the Group feature to re-establish the group.

Working with Groups
With most operations you can treat a group as if it were a normal diagram object. You 
can select it, move, copy, and delete it in all of the usual ways. In most respects, once 
individual objects are placed within a group, their individual properties are no longer 
accessible and you cannot perform operations such as moving, resizing, or editing the 
individual object. Some exceptions exist for added convenience. They are described in 
the following sections as well as some special properties and behaviors of groups.

Selecting Groups
Select groups by clicking on any item that is a member of the group. You can also 
select groups using the lasso select but only groups that are entirely within the lasso 
rectangle become selected.

Aligning, Spacing, and Centering Groups
When aligning, spacing evenly, or centering on page, a group of objects will be treated 
as it if were one object. For example, if you select two groups and left align them, the 
left edge of one group will become aligned with the left edge of the other. The left edge 
is identified by the left most edge of the left most member of the group.To change the 
relative alignment and spacing of members of a group you must ungroup them first.

Changing Properties of Group Members
You can change properties (such as fill color, line widths, and so on) of individual 
group members while they remained grouped. However, you must apply any property 
changes to all members of the group or none. You can select a group and attempt to 
change properties of objects within it by using the toolbar buttons or the Properties 
commands located in the main menus, but the right click menu will not provide access 
to properties in its usual way. When you apply property changes to a group, you will 
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202 Chapter 13: Groups
be asked whether to apply the changes to the group members or not. You may answer 
how you like and you can also choose to make your answer permanent to future 
questions of the same nature by checking the “Don’t ask again” box. If you tell it not to 
ask again, you can later change your mind by unchecking the option “Prompt to apply 
property edits to selected objects” located in the Tools Options dialog box at the 
bottom of the General area.

Individual Operations Allowed for Group Members
Even though objects are placed in a group, there are certain operations still allowed on 
the member objects.

Hyperlinks: If a grouped object contained a hyperlink, you can still follow the link 
by double-clicking on the object. However, you will not be able to right click on it 
and select the Follow Link feature.
Text Editing: You can edit the text of a grouped object using the text tool in the 
usual ways. Methods other than the text tool cannot be used to edit the text of 
grouped objects. Text can however be changed indirectly by using the Find and 
Replace feature. 
Connecting: You can connect to grouped objects in the usual way as if they were 
not in a group. 

Resizing and Scaling Groups
Groups can be resized as if they were one item. To resize a group, drag one of the eight 
red resize handles as you would with an ordinary object. When you resize a group, all 
objects in the group scale including the text, line widths, paths and so on. 

There are some special considerations to keep in mind when resizing groups:

Unlike most ordinary objects, a can only be resized to keep the same aspect ratio. 
It cannot be stretched more in one direction than another.
When making a group smaller, the minimum size of the group is determined by 
the smallest text (or text attribute) of any member of the group. For example, the 
minimum text size allowed by the program is 4 points. If one of the objects within 
the group contains 8 pt text, the whole group can only be shrunk by 50%.
If you shrink and then expand the size of a group back to its original size, it is 
possible that all aspects of the group may not end up exactly as they began. This is 
especially true of line widths and text sizes which can lose resolution when scaled 
too small.
After resizing a group you may have to manually adjust some lines to make sure 
they are straight. The program will attempt to keep most lines straight through a 
group resize, but some, particularly non-center connections may require manual 
adjustment.
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CHAPTER
14 LAYERS

In addition to the foreground layer of a diagram, you may also choose to add a background 
layer. Objects, labels, and graphics contained within the background layer appear behind 
the foreground of the diagram but are unaffected by normal editing. 

Typically a background layer may contain:

A solid colored backdrop
A gradient backdrop for a 3D appearance
A graphic image such as a company logo or watermark
Informational text such as headers or footers 

Using foreground and background layers is simple. Use the View menu to switch the active 
layer between Normal, Foreground, or Background then edit objects normally within the 
active layer. Normal is a special view in which the foreground and background layers are 
both visible, but only objects in the foreground layer can be edited. Typically, you’ll do 
most of your diagram editing in the Normal layer view and switch to the Background layer 
view temporarily to create or edit the background.

Background layer object
(cannot be edited in 

Normal view)

Foreground layer objects
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 203 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



204 Chapter 14: Layers
NOTE: When a diagram consists of multiple sheets, each sheet has a distinct 
background. There is no common shared background. To implement a 
common background, copy the background of an existing sheet when you 
create a new sheet.

To switch the active layer view
1. Select Normal from the View menu to display both the foreground and 

background layers. Only objects in the foreground layer will be editable. 
2. Select Foreground from the View menu to display only the foreground layer. 

Only objects in the foreground layer will be editable. 
3. Select Background from the View menu to display only the background layer. 

Only objects in the background layer will be editable. 

To move objects between layers
1. Select object(s) in the active view. 
2. Cut or Copy the selected objects.
3. Switch the active layer. 
4. Paste the objects into the active view.

NOTE: The foreground and background layers should not be confused with the 
ordering features such as Front and Back. The ordering features control the 
order of objects within the active layer. If for example, you move an object 
to the Back from within the foreground layer view, it will then appear 
behind all other objects in the foreground layer, but it will still appear in 
front of the background layer and all objects contained within the 
background layer. Consider that the entire background layer is drawn before 
anything in the foreground layer is drawn.

Selecting Objects from Multiple Layers
In Normal layer view and Foreground layer view, most selection operations will only 
select objects belonging to the foreground layer. Likewise in Background layer view, 
most selection operations will only select objects belonging to the background layer.

There are two exceptions that allow the selection of objects from multiple layers 
simultaneously. The Select All feature (available from the Edit menu or by using the 
Ctrl-A shortcut key) selects all objects in diagram including both foreground and 
background objects. And lasso selection from within the Normal layer view can be 
made to select objects from all layers within the selection lasso (including background 
objects) by holding down the Alt key simultaneously to performing the selection.
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Working with Groups 205
Selecting objects from multiple layers can be useful when copying or exporting 
selections in which you prefer to include both foreground and the background objects. 

Copying Objects from Multiple Layers
When a diagram contains foreground and background objects, copy operations require 
special attention. Selecting only foreground objects (not selecting the underlying 
background objects) causes only the foreground objects to be copied. The background 
objects will not appear behind them when you paste the copied selection into another 
document. To include the background objects as well, use the Alt+Lasso Selection 
method described in the previous selection to select both the foreground and 
background objects. The bounds of the entire selection (foreground and background 
objects) will define the size and extent of the copied area.

In the special case where the background objects are larger than the foreground object 
selection, you may prefer to include the background layer only partially, as a backdrop 
to the selection, cropped to the selection rectangle but not necessarily including the 
entire background object extents. In this case, you will need to use the Export feature 
instead of Copy as described in the following section.

Copy or Export
(foreground and background

Copy, Export, Save As
(no objects selected) 

objects selected by using Alt-lasso) 
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206 Chapter 14: Layers
Exporting Objects from Multiple Layers
Exporting objects from multiple layers also requires some special considerations. 
When exporting an entire diagram sheet, with no selection, the result of the export is 
exactly as you would expect. The foreground objects appear on top with the 
background objects beneath, just like the normal view on the screen, and just like 
when printing. However, when exporting a selection, the exported contents will 
normally contain only the selected objects, just as described in the previous section in 
regard to the Copy operation. 

However, exporting a selection allows an additional option that in some cases is more 
in keeping with the true intent of the background layer. When you export a selection 
and the selection contains any unselected background objects behind it, the export 
screen will include a “Background” checkbox which allows you the choice of 
including the background objects cropped to the selection rectangle. Unlike copying, 
where background objects must be selected to be included (thus expanding the copied 
rectangle if the background objects are larger than the foreground selection), this 
option allows the background to appear partially, as a simple backdrop image behind 
the foreground objects, and cropped to the rectangle defined by the export selection 
rather than contributing to it.

Export

Copy or Export
(foreground objects selected) 

background objects not selected, 
(foreground object selected,

“Background” export option checked)
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CHAPTER
15 HYPERLINKS

Hyperlinks make it possible to link any node in your diagram to another diagram, a 
document of a different application, or to a web page. They work a lot like hypertext links 
on the internet except that (a) it’s the node that contains the link rather than the text, and (b) 
hyperlinks work for a wider variety of destinations.

With hyperlinks you can enhance your diagrams in these ways:

Link a node to another diagram. When you double click on the node, the linked 
diagram opens in another window much like how an internet browser works. This is 
especially useful for expanding the detail of a node (such as a process) into an entirely 
separate diagram.
Link a node to a document. For example, you can link a node to a spreadsheet that 
contains data relating to that node. When you double-click on the node, the document 
opens in its proper application (Microsoft Excel for example).
Link a node to a web page (URL). When you double click on the node, your browser is 
launched at the appropriate web page.

NOTE: Hyperlinks are an extension of this tool and are not part of the standard UML 
specification. In fact the UML specification advises against using such features 
because they make diagrams dependent on specific tools and therefore less 
portable. We recommend that you use hyperlinks to create shortcuts and to 
supplement your UML diagrams rather than creating a dependency upon them. 
With this in mind, you can quite easily develop diagrams that stand on their own 
without any hyperlinks, and still make full use of them to add shortcuts for 
navigation between diagrams, to organize related documents, and to reference 
web pages and internet resources.

The following features permit you to set hyperlinks for nodes, open hyperlinks to navigate 
between diagrams and documents, and maintain a rudimentary history of diagram links for 
backtracking.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 207 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



208 Chapter 15: Hyperlinks
Setting a Hyperlink
Any node or label can contain one (and only one) hyperlink to another diagram, 
document, or web page.

To link a node or label to another diagram or document
1. Select one node or label.
2. Choose Set Hyperlink from the Nodes (or Labels) menu, or right-click the node 

and choose Set Hyperlink.
3. Use the dialog box to select a file (diagram or document) for the hyperlink or 

replace a previous hyperlink. You can also use the Remove button to eliminate the 
hyperlink.

NOTE: It is a good practice use relative file names where appropriate when linking 
to files on the same computer as the diagram file that contains the linked 
object. For example, if you have a number of diagrams that are part of a 
project and contain hyperlinks to one another, it's best to use the file names 
alone as the hyperlink "FILE1.EDG" (assumed relative) or ".\FILE1.EDG" 
(explicitly relative) rather than "C:\PROJECT\FILE1.EDG". Using relative 
file name links permits you to move the entire project to a different folder or 
drive without having to reconstruct all of the links. There is a relative/
absolute option to help with creating relative links in the browse dialog box 
used by the Set Hyperlink screen. NOTE: all web URL hyperlinks must be 
absolute, starting with one of the following protocol identifiers "http:", 
"https:", "ftp:", or "file:".
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Setting a Hyperlink to a Web Page 209
Setting a Hyperlink to a Web Page
Setting a hyperlink to a web page is the same as setting a hyperlink to a document. 
Follow the procedure above but instead of specifying a document on your hard disk or 
network, instead specify a web address (URL). 

Hyperlink URLs should begin with a protocol identifier such as “http:” and may 
contain fragments such as “http://www.pacestar.com/edge/eddesc.htm#reqs” or query 
strings such as “http://www.pacestar.com?id=1233”.

Opening a Hyperlink to a Diagram or Document
When a node or label contains a hyperlink to another diagram or to a document, you 
can open or follow that hyperlink to cause the link diagram to be opened in place of the 
current diagram. If the link is to a document other than another diagram, following the 
hyperlink will open that document.

To follow a hyperlink to another diagram or document
1. Make sure you are in Select mode (or Seltext mode)
2. Move the mouse cursor over a node or label that contains a hyperlink. The node or 

label can be selected or not selected. The cursor will show a combination hand and 
move cursor and the status bar will indicate the name of the diagram or document 
that will be opened if you double-click.

3. Double click the mouse on the node or label. If the hyperlink is to another 
diagram, the current diagram will be saved automatically if it has been modified 
and the linked diagram will be opened in its place. If the hyperlink is to a 
document, that document will be opened.

alternately

1. Select the node or label
2. Choose Open Hyperlink from the Nodes (or Labels) menu 

Following hyperlinks to documents other than diagrams makes use of Windows file 
associations. The extension of the link file must be known to Windows as being 
associated to a program. Once the program is identified, Windows will launch it with 
an “open” action on the specified document. In order for this to work, you must have 
the file association set-up in advance. To set a file association, choose “View” and 
“Folder Options” under My Computer. Refer to your Windows documentation for 
further details.
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210 Chapter 15: Hyperlinks
NOTE: If the current diagram is maximized and you follow a hyperlink to another 
diagram, the new diagram will replace the current diagram which will be 
saved automatically and closed. If the current diagram is not maximized, the 
new diagram will be opened in another window and the current diagram will 
not be affected.

Moving Back and Forward Among Previous Diagrams
When you move between diagrams by opening hyperlinks, you can use the Back and 
Forward features to return to diagrams that you previously visited.

To go back to the previously visited diagram, choose Back Hyperlink from the Tools 
menu, or press the Back Hyperlink button on the toolbar - it is a small link symbol with 
a blue arrow pointing left.

To go forward to the diagram that you left with Back, choose Forward Hyperlink from 
the Tools menu, or press the Forward Hyperlink button on the toolbar - it is a small 
link symbol with a blue arrow pointing right.
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CHAPTER
16 TOOLS 

The Tools menu contains a variety of tools for manipulating diagrams and controlling 
program options.

Importing Graphics
This program supports several methods of importing graphics such as images and clip art 
from other programs and from disk. The simplest method, that of simply cutting and 
pasting a graphic picture from another program into a diagram, has been covered in another 
section (see  Pasting Objects on page 32). This section describes how to import graphic 
files directly from disk without necessarily using another program.

Supported graphics file types
There are many different file types that may contain graphics or clip art. Each graphics file 
type is considered either raster (bitmap) or vector (scalable). Either type can be resized, but 
when you resize bitmaps, they tend to distort and become unattractive. Scalable vector 
graphics are popular because they scale smoothly. 

This program can import several popular bitmap graphics formats including:

Windows Bitmaps (.BMP)
Windows Device-Independent Bitmaps (.DIB)
JPEG Bitmaps (.JPG). 
Graphic Interchange Format Bitmaps (.GIF)
Portable Network Graphics Bitmaps (.PNG)
PaintBrush Bitmaps (.PCX)

This program can also import scalable vector graphics formats including:

Windows Metafiles (.WMF)
Windows Enhanced Metafiles (.EMF). 

There are other graphics file types which you might come across that cannot be imported 
directly. For example, there are Encapsulated Postscript (*.EPS) files, Computer Graphics 
Metafiles (*.CGM), and so on. Even though you cannot import these directly, you can still 
use them fairly easily. One way of importing such files is to load them into another 
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212 Chapter 16: Tools
program, copy them to the clipboard, then paste them into a diagram. There are also 
many programs that will let you import all different graphics types and then export as 
one of the supported import formats.

Inserting graphics
You can import supported graphics files directly from disk by using the Insert 
Graphic feature in the Nodes menu or equivalently with the Import Graphic feature 
in the Tools menu. The Import Graphic Dialog box looks like this:

To insert a graphic into your diagram
1. Choose Insert Graphic from the Nodes menu or the right click menu.
2. Select the file that you wish to insert and choose the Graphics Importation 

Options that work best for the particular file (see below). 
3. Click the Import button. A new node containing the imported graphic will appear 

in the active view.
Once you have inserted the graphic, you can manipulate it just like any other nodes, 
moving, resizing, connecting, and so on.

Graphics Importation Options
The following options are available in the Insert Graphic dialog box and can be used to 
control how a particular graphic appears and behaves after it is imported. They are 
remembered once the dialog box is closed and remain in effect when drag-and-
dropping graphics into the diagram, and when pasting them from the clipboard.
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 212 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



Importing Graphics 213
Fitted Bounds (Recommended ON in most cases)

Checking this option causes the creation of a bounding polygon shown in flashing red 
that serves as an approximation of the boundaries of the graphic. The outlined area is 
used for two purposes neither of which affects how the image appears. The first is 
define a Hot Zone, an irregularly shaped area that delineates the edges of the image 
that are sensitive to clicking by the mouse. The second purpose of the fitted bounds is 
to provide a border where attached paths terminate. Without the fitted bounds the 
edges of the image will reflect the simple bounding rectangle. When importing clip-art 
to use as diagram elements, we recommend enabling this feature. However, when 
importing large images for the purposes of a background, turning off this option will 
decrease the time it takes to import. 

Transparent Edges (Recommended ON in most cases)

Some graphics such as GIF files can have included transparency information which 
improves how the image will appear against a background or near other diagram 
elements. This option simulates this effect for graphics that do not have built-in 
transparency. When checked, the white space around the edges of the graphic become 
transparent. This allows you to import an image in any format and have an alternative 
to a basic rectangular image. For a good result, this feature requires that the image 
have a white background color and that the edges be fairly sharp. However, the Clean 
Background option described below may help to improve the result as well. Note that 
transparency affects only how the imported image appears, whereas the fitted bounds 
above affects only how it behaves. Often an imported image will appear and behave 
slightly differently.

Clean Background (Recommended ON in most cases)

This option supplements the Transparent Edges option above.Some clipart images 
have white backgrounds and surrounding edges, but due to the methods that produced 
the image, the background is not a single color of pure white. This condition is very 
common for images that use data compression such as JPEG files. To achieve 
acceptable results when using the Transparent Edges option, a range of near-white 
colors must be treated as pure white.When this option is checked, every color in the 
image that appears white is converted to a true white greatly improving the sharpness 
of the transparency border. In some cases, you may prefer to uncheck this option 
because it can cause white parts of the image to become transparent inadvertently.

Inserting a graphic with drag and drop
Another convenient way to insert graphics is to drag-and-drop them into your diagram.
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214 Chapter 16: Tools
To insert a graphic file into your diagram with Drag and Drop
1. Open a diagram. If you have more than one diagram open, make sure the one you 

want to import into is active.
2. Go to the Windows Explorer. Locate and select the graphics files that you want to 

insert into your diagram. You can use the shift key to select more than one.
3. Drag the selected files over the program and drop them (let go of the mouse 

button). The graphics will be inserted and appear as new nodes in the active view. 
Note that the last Graphic Importation Options you set will affect how the 
dropped graphics appear and behave.

More about graphics
Nodes that contain imported graphics will retain their shape (aspect ratio) when you 
resize them using the corner handles.

Inserted graphics are actually imported copies of images NOT links. If you cause a 
change to the graphics file, that change will not appear in your diagram unless you re-
import the file.

The fill color for imported graphic images serves as a tinting color. Initially there is no 
tint color (fill color) for the imported graphic and all of the colors are unaffected. If 
you change the tint color by selecting a fill color, the colors will appear as shades of 
the tint color.

Exporting Graphics
You can export a diagram to a disk file in a standard graphic format so that you can 
later import the diagram into a different program. Note that exporting objects does not 
remove them from your diagram.

For example, if you export a diagram to a file as a Windows Metafile, you can then use 
Microsoft Word’s Insert Picture feature to add the diagram to a Microsoft Word 
document. You can export a diagram as a JPG file for use on a web page.

To export the objects from your diagram to a graphics file 
1. Select all the objects that you want to be exported. If you do not select any objects, 

ALL objects in your diagram will be exported. If your diagram contains multiple 
sheets, only objects in the active sheet will be exported.

2. Choose Export Graphics from the Tools menu.
3. Select a file name and a file format and press the Save button. 
You can transfer diagrams and portions of diagrams to other programs more 
conveniently through the Windows clipboard by using Cut and Copy. However, there 
are a few advantages to using Export instead. Once you export a diagram to a file, you 
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Exporting Graphics 215
can easily store and transport that file. You can also use other commercially available 
programs to convert the file to other graphics formats that this program does not 
support. 

Once you export a diagram to a file, you cannot reload that file into as a diagram. The 
exported file is essentially a snapshot of the image of the diagram and does not contain 
the actual diagram definition.

Graphic Export Options
When exporting to a bitmapped graphics format, you are given an opportunity to 
specify the size of the resulting output graphic using the Graphic Export Options 
dialog box. 

Width, Height

You can choose a specific dimension in pixels by entering a desired Height and Width.

Scale

Use this control to select an image size as a percentage of “true” size. The true size is 
the size that is shown by the rulers within your diagram. For example, if you have a 
box that is one inch square as shown by the rulers in your diagram and you export it 
scaled by 200%, the resulting bitmap will be two inches by two inches when displayed 
on your monitor. Note that the size of bitmaps vary based on the device on which they 
are displayed. 

Quality

Use this control to select a quality level for JPEG images. The quality can range from 
10 (lowest) to 100 (highest). Highest quality images best represent the original but they 
are also require the largest file size. The default is 85% which produces a reasonable 
file size but a very good image.
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216 Chapter 16: Tools
Background

Select a background color for the image. Don’t confuse this color with the page color 
(set in Tools Options) that controls the appearance of your diagram workspace, nor 
with the background layer of objects that draw beneath the foreground objects.

Anti-alias (smooth)

Check this option to apply anti-aliasing (smoothing) to an exported bitmap. Anti-
aliasing removes the jagged lines and drop-outs that result from rendering a diagram 
on a low resolution bitmap. It is especially superior when scaling down the diagram 
under 100% and when creating bitmaps for display on the screen, such as web page 
graphics. Anti-aliasing is available only when exporting to a full color bitmap format 
rather than a scalable vector format. Also, anti-aliasing is not available when exporting 
as a transparent bitmap.

Apply Color Scheme
After you have begun work on a diagram you can change object and style colors 
individually by modifying the style attributes and object properties manually. 
However, if the original template offered color scheme options, you can also use the 
Apply Color Scheme feature to change to an alternate color scheme. 

To apply a new color scheme to your existing diagram, choose Apply Color Scheme 
from the Tools menu. Then use the Apply Color Scheme dialog box to select and 
apply the color scheme. If the feature is grayed it is unavailable for the diagram, most 
likely because the diagram was not created from a template having color scheme 
options.

The Apply Color Scheme dialog box looks like this: 
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Color Scheme

Scroll to a color scheme and select it. The preview window will show how the diagram 
will appear with the selected color scheme.

Apply to: Styles

This box is always checked. It serves as a reminder that the color scheme will always 
affect the styles. If you prefer to change the colors of the diagram objects without 
affecting the styles, do so by selecting the objects individually and adjusting their color 
properties.

Apply to: Diagram

When checked all objects in the current diagram that are based on styles are included 
and adopt the new color scheme. Note that the color scheme will not be applied to 
objects that are not based on an existing diagram style such as imported clip art 
images. To change the color of imported graphics, select the object and change its 
color individually.

Apply to: Selection

When checked all of the selected diagram objects adopt the new color scheme. As with 
the Diagram option above, imported clip art images are not included. This box is 
enabled only when diagram objects are selected.
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Diagram Properties
Each diagram has a set of properties that are saved with the diagram. To view and 
modify the properties of the diagram, choose Diagram Properties from the Tools 
menu.

The Diagram Properties dialog box contains groupings of properties organized under 
tabs with an appropriate heading. To change to a different grouping and their controls, 
press the corresponding tab. Controls located under each tab are described below.

Diagram Properties: General
Use the General tab in the Diagram Properties dialog box to set the basic properties of 
your diagram.

Disable text margin limits for decision (diamond) symbols

Check this box to use the whole rectangular bounds of diamond-shaped symbols for 
text. With the limits disabled you can fit more text into the diamond but you will have 
to manage the placement manually and keep it from overlapping the edges.
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Diagram Properties: Grid and Snap
Use the Grid and Snap tab in the Diagram Properties dialog box to set the visible grid 
and the snap grid for your diagram.

Show grid

Check this box to display a grid over your diagram. This box controls only the 
appearance of the grid as a visual guide, not whether objects snap to the grid. The grid 
is displayed either as dots or lines based on options set in the Options dialog box.

You can also turn the grid on and off with the grid button on the tool bar.

Spacing (for visible grid)

Choose the spacing between the drawing of grid lines in your diagram.

Snap to grid

Check this box to have your diagram objects snap to the underlying snap grid. you will 
usually want this to be the same as the visible grid and use them together. Take note 
that nodes and label have a property that tells them whether that particular node or 
label snaps to the grid. Therefore, for any particular object to snap to the grid, it must 
have it’s Snap center to grid property set and the Snap to grid diagram property must 
be set.

You can also turn snap on and off with the snap button on the tool bar.
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Spacing (for snap grid)

Choose the spacing for snap alignment. A snap spacing that is smaller than the visible 
grid spacing works well. For instance, try a snap spacing of an eighth inch and a grid 
spacing of a quarter inch. 

Diagram Properties: Labels
You can choose a specific label style to use for all labels of a certain kind (see Labels 
chapter for explanation of specialty labels.).

Path Label Style

Use the control to choose an existing label style for all path labels or choose <none> to 
use the usual toolbar text settings.

Flow Label Style

Use the control to choose an existing label style for all flow labels or choose <none> to 
use the usual toolbar text settings.

When you set any of the above to a label style and apply, you will be asked whether or 
not to apply the change to all existing labels of the kind.

Also note that if you are placing a label of a specific style that contains default text, 
that style will prevail even if a style is defined here.

Node Label Style

Use the control to choose an existing label style for all node labels or choose <none> 
to use the usual toolbar text settings.
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Primary position

The Primary Position for node labels identifies one of the nine standard slots as the one 
to use for (a) all Auto-labels and (b) the single slot to snap to if the Snap labels to node 
label primary position only option is enabled.

Spacing from objects

Choose the spacing between labels and the objects they label attached nodes and paths.

Diagram Properties: Paths
Set diagram properties that affect the appearance of paths and their intersections.

Rounded paths - Corner radius

Enter the corner radius for this diagram. This is the amount of rounding that occurs for 
all corners of rounded paths (see  Rounded on page 95).

Jogs - Enable / Loop radius

Choose whether to enable jogs (small loops drawn when paths intersect but do not 
interact). Also set their radius in this diagram.

Draw dots where three or more paths meet

Check this box to cause small dots to be drawn at the point where three or more paths 
attach to one another. These are opposite in function to jogs. These dots DO appear 
when printing.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 221 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



222 Chapter 16: Tools
Draw dots where paths attach to connection points

Check this box to cause small dots to be drawn at the point where a path attaches to a 
node at a connection point. These dots DO appear when printing.

Diagram Properties: Text
Set diagram properties that affect how text is displayed and formatted.

Line Spacing

Enter a value for line spacing. Single spaced is the default. Spacing applies to all text 
including labels. To set the line spacing for a single object or for a single style, use the 
Line Spacing field in the object properties Text screen or the style Text screen instead.

Margin

Text margins are the spaces between node text and the edge of the node. Changes 
made here will apply to all existing node in your diagram and all node styles and will 
not be undoable! To set the margins for a single node or for a single style, use the 
Margin field in the node properties Text screen or the style Text screen instead. Note 
that not all shapes support fixed margins, some require the internal margins to scale 
with the shape rather than remain constant.
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Diagram Properties: Shadows
Use the Shadows tab in the Diagram Properties dialog box to change the appearance of 
drop shadows throughout your diagram.

Diffusion

Set the diffusion to a higher value to add more blurring to the shadows. Shadows 
become larger as the diffusion increases. 

Transparency

Set the transparency to a higher value to make the entire shadow appear more or less 
faded.

Offset

Set the offset so that drop shadows are drawn a different distance from the object. The 
offset is always positive and equidistant below and to the right. Setting the offset to 
zero with non-zero diffusion creates a halo effect around the object.

Color

To change the color of drop shadows in your diagram, choose a different color from 
the color selection drop menu. 
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Diagram Properties: UML
Set diagram properties that affect only UML diagrams.

Stereotype Icon Size

Enter a value for the size of stereotype icons that appear within other symbols. Note 
that the actual size in any particular symbol may be smaller if necessary to fit within 
the geometry of the symbol. Also note that stereotype icons appearing within 
containers are twice the size that you set here.

Self-transitions Radius

Enter a value for the size (radius) of self-transition arcs. Self-transitions are commonly 
used in state diagrams. Self-transitions can be changed individually as well by 
manually adjusting the arc. Making a change here has the side effect of changing all 
pre-existing self-transitions in the diagram, except for any that were positioned or 
sized manually already. If that side-effect is not desired, you can undo those changes 
after completing the programming and the new radius will still apply to self-transitions 
created in the future, but changes to existing transitions will be undone.
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Customize
Toolbars are highly flexible. While most features are available by other means such as 
through menus and hot keys, toolbars offer the most convenient access to common 
features and styles. This is particularly true when you customize the toolbars to contain 
the controls you find most useful and arrange them to your personal liking.

To customize toolbars including the style bar, choose Customize from the Tools 
menu, or right click on any toolbar and choose Customize from the drop menu. The 
Customize dialog box will appear.

The Customize dialog box contains groupings of options organized under tabs with an 
appropriate heading. To change to a different grouping and their controls, press the 
corresponding tab. Unlike other similar screens, you do not need to click on OK for the 
changes you make to take effect. All changes occur immediately.

Using the Customize Dialog Box
The Customize dialog box helps you choose which toolbars are visible, select which 
buttons and controls are available, and arrange them to your preference. You can 
perform the following operations from the Customize dialog box. The operations 
described below apply regardless of which tab you are viewing unless indicated 
otherwise.

To remove a button or control from a toolbar (including the Style Bar)
Click on the button or control and drag it off the toolbar until the cursor is no longer 
over any toolbar and shows an 'x'. Then release the mouse button to remove the 
control.

To add a button or control to a toolbar
Use the Commands tab to select commands and add them to toolbars. Or use the Styles 
tab to select object styles and add them to the appropriate section of the Style Bar (see 
below).

To move a button or control on a toolbar (including the Style Bar)
Click on the button or control, drag it to a new location indicated by the cursor, and 
release the mouse button. The control will be removed from its previous location and 
reposition where it was dropped.

To add spacing between buttons or controls
Click on the button or control to the right of the location where you want the space 
inserted. Drag the button to the right but not past the next control. Release the mouse 
button and the new space will appear to the left of the button. You can add only one 
space between controls. You cannot add spaces to the Style Bar.
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226 Chapter 16: Tools
To remove a space between buttons or controls
Click on the button or control to the right of the space that you want to remove. Drag 
the button to the left but not past the next control. Release the mouse button and the 
space will be eliminated. This does not apply to the Style Bar.

Using Customize Dialog Box Tabs
The previous page listed operations that are available in the Customize dialog box 
regardless of the tab selection. In addition, each tab contains some specific controls for 
further customizing toolbars. The contents of each of these tabs is described below.

Customize: Toolbar
Use the Toolbar tab to hide or show toolbars or to reset toolbars to their default layout.

Toolbars

Use the check boxes to select which toolbars are visible. The illustration to the right 
shows the location of the selected toolbar when it is visible.

Reset To Default

Select a toolbar and click the Reset to Default button to return the layout of the toolbar 
to its initial configuration. For the Style Bar, the default configuration is how the 
particular diagram or template was originally designed.
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Customize: Commands
Use the Commands tab to add buttons and controls to toolbars. The controls and 
commands shown here can only be added to simple toolbars and NOT to the style bar.

To add a command to a control bar
Locate the command in the command list box. Select a category on the left side and 
locate the command on the right side. Then simply drag the command to the location 
on the toolbar where you want it to be positioned.

Notice that any button or control can only be located on one toolbar. If you add a 
control that is already on a toolbar, the control will be moved from the old position to 
the new position rather than being duplicated. If the command is already located on a 
toolbar it will become highlighted as you drag it.
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228 Chapter 16: Tools
Customize: Style bar
Use the Style Bar tab to customize the layout of the Style Bar including the size of 
buttons and the number of columns of each type.

Columns

Select the number of columns of buttons for each style type. You can also adjust the 
width of the entire Style Bar for complete control of the button widths (see below).

Height

Select the height of the style buttons for each type of style. Choose a height that 
permits proper display of the styles but also displays as many as possible on the screen.

Drop down lists

The drop down lists are useful for displaying style names as well as for selecting styles 
that may not be available on a button or even some that may not be available form a 
drop menu. However, the drop down lists can be hidden to add more room for style 
buttons. Use this check box to show/hide the drop down lists for all style types.

Width of Style Bar

You can adjust the width of the entire style bar by simply dragging the right hand edge 
with the mouse.
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Customize: Styles
Use the Styles tab to add styles to the Style Bar.

To add a style button to the Style Bar
Locate the style in the Styles list box. Select a category on the left side and locate the 
style on the right side. You can choose form all styles of a major style category, of if 
subcategories exist you can focus on styles of the subcategory.

Then simply drag the style to the location on the Style Bar where you want it to be 
positioned.

Notice that a style button cannot be duplicated on the style bar and style buttons of a 
type can only be positioned within the appropriate section of the Style Bar. For 
example, you can only place a label style button in the Labels section and only once.

If you add a style that is already on the Style Bar, the button will be moved from the 
old position to the new position rather than being duplicated. If the style button is 
already located on the Style Bar it will become highlighted as you drag it.
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Customize: Options
Use the Options tab x to select options related to customizing toolbars. 

Add style selection controls to right of Collapse/Expand Style Bar button when style 
bar is not visible

When you collapse the Style Bar and this option is checked, three controls will be 
added to the toolbar to replace the capability of the Style Bar. These three controls are 
the style drop-down menu buttons for the three types of diagram objects. The controls 
will appear immediately to the right of the Collapse/Expand button. When the style bar 
is restored, these controls will be removed. With this option, you can use the Collapse/
Expand Style Bar button to switch between the standard user interface and a more 
compact user interface that is still fully capable.

Toolbar Icons

Adjust the size of the toolbar icons. Small icons are standard Windows 16x16 icons as 
appear in Vista menus. Medium icons are 24x24 (default and recommended). Large 
icons are 32x32 for greater visibility.
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Options
To view and modify program options, choose Options from the Tools menu. Options 
are organized by categories as described below.

Options: Start-up
The Start-up category includes options controlling the initial state of the program.

Open most recent file on start-up

When this option is checked. The most recently edited diagram will be opened 
automatically when you start the program.

Do not display splash screen on start-up

When this option is checked, the introductory splash screen will no longer be displayed 
each time you start the program.
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Options: Locality
The Locality category contains options related to your country or culture.

Measurements

Choose either English (inches) or Metrics (centimeters) as your measurement units. 
All measurements are displayed in these units.

Measurements such as line widths and font sizes are measured in points (abbreviated 
pts). There are 72 points to the inch. 
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Options: Workspace
The Workspace category contains options related to the program appearance and 
operation. Some miscellaneous workspace options are located in this category while 
others are organized into subcategories.

Limit workspace to page area

When this option is checked (the default), the off-page area surrounding the white page 
area of the diagram is decreased to simplify scrolling and navigating. The scrollable 
workspace extends if necessary to include any objects located outside the page area.

Display the full path in window captions

When this option is checked, window captions show the full path of the diagram rather 
than simply the diagram name. This option is useful when editing files with the same 
name but located in different folders or on different machines. If your path names are 
too long to be displayed you may need to uncheck this option.
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Options: View
The View category contains options to enable or disable certain optional user interface 
elements like toolbars and status bars.

Show status bar

Check this box to display the status bar, also known as a message bar, at the bottom of 
the screen. The status bar displays brief help and status information.

Show standard toolbar

Check this box to display the standard (top) toolbar. The toolbar contains important 
controls. We recommend it remain enabled.

Show property bar

Check this box to display the property bar. The property bar is located directly beneath 
the tool bar - it is the second button bar. The property bar is very useful for changing 
certain node, label, and path properties conveniently.

Show style bar

Check this box to display the style bar. The style bar is located on the left edge of the 
screen. It contains controls for selecting a new style for creating on object in your 
diagram. When you disable the style bar to free up screen space for viewing your 
diagram, three new compact controls (drop down menu buttons) appear in the property 
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bar to perform the function of selecting a style for creating the three types of diagram 
objects.

Show rulers

Check this box to display rulers on the top and left of the diagram views. Rulers help 
you lay out your diagram as it will appear on the printed page. They are also useful for 
providing an indication of the view’s location within your diagram and the current 
amount of magnification.

Show page boundaries

Check this box to turn on the display of page boundaries and margins. Page boundaries 
are determined by your print settings which you can adjust with print set-up. They 
reflect the current paper size, printer selection, page orientation, and so on. We 
recommend that you display page boundaries in most cases. They are required in order 
to perform certain features such as (obviously) Center on page. The time when they 
are not necessary or even particularly useful is when you are editing an embedded 
OLE diagram that really belongs to another document and therefore has no page layout 
information of its own.

Margins displayed are hard margins. They reflect the outer limit that you can print to 
on your selected printer - as opposed to spacing margins that you can set.

Show connection point indicators

Check this box to display small dots where connection points are located within a 
node. 

Show connection guide lines when connecting

Check this box to display guide lines horizontal and vertical to the cursor when 
creating paths. 
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Options: Tooltips
The Tooltips category contains options to enable or disable the display of tooltips (hint 
balloons.

Tooltips on style bar buttons

When checked, tooltip text balloons will appear when you hover over a style selection 
button on the style bar.

Tooltips on drop menu items

When checked, tooltip text balloons will appear when you hover over an item within 
certain drop menus. Tooltip information is included for style selection menus and 
color palette menus.

Tooltips on tool bars

When checked, helpful tooltip text balloons will appear when you hover over a toolbar 
button.
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Options: Grid
The Grid category contains options that affect the display and operation of the snap 
grid. Note that another set of grid options are saved for each diagram and therefore are 
controlled from the Diagram Properties screen instead.

Grid

Choose whether the visible grid appears as lines or dots. This is how the grid will 
appear if it is displayed. However, each diagram may choose to have a grid shown or 
not shown. See the Grid tab on the Diagram Properties screen.
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Options: Edit
The Edit category contains options related to editing diagrams. Some miscellaneous 
editing options are located here while others are organized into subcategories.

Create one node at a time

When you create a node and this option is checked, the new node automatically 
becomes selected and the mode changes back to select mode as soon as one node is 
created. To create another node, you have to press the node style button again and 
repeat the process. Without this option checked, you remain in create mode until you 
change modes yourself.

Create one path at a time

When you create a path and this option is checked, the new path automatically 
becomes selected and the mode changes back to select mode as soon as one path is 
created. To create another path, you have to press the path style button again and 
repeat the process. Without this option checked, you remain in connect mode until you 
change modes yourself.

Double-click edits label/node text

When this option is checked, double-clicking the mouse on a node in your diagram 
initiates text editing for that node. Otherwise double-clicking will pop up the node 
properties for that node.
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Snap nodes into flows

When this option is checked you can create and drag nodes onto a flow (a path) and it 
will become part of the flow (the path will enter and exit the node). 

Prompt to apply property edits to selected groups

When this option is checked (the default) and you apply a property change to a 
selection that includes a group, you will be asked whether the change should apply to 
grouped objects.If you answer and check the “Don’t ask again” box, it will remember 
your response until you return to uncheck this option.

Undoable navigation (scroll/pan/)

When this option is checked you can undo movement within your diagram such as 
scrolling and zooming in addition to edits. Otherwise, only actions that change the 
diagram will be undoable.

Remove paths when one or both ends deleted

When this option is checked (the default), paths are automatically deleted if you delete 
a node that either end is attached to.

Edit text automatically when creating a node

When this option is checked, each time you create a node in your diagram you are 
automatically entered into text mode to edit the text of the node.

Auto-label (label nodes as they are created)

When this option is checked and you create a new node AND that node’s style has 
auto-label text configured, a node label containing the auto-label text is automatically 
created below the new node.
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Options: Import
The Import category contains options affecting the import of graphic images into 
diagams.

Calculate fitted bounds for imported graphics

When this option is checked and you import (or drag-and-drop) a graphic image into 
your diagram, a bounding shape is fitted in the shape of the content of the graphic 
rather than simply a rectangle of the same size as the graphic. The fitted shape is used 
to determine the clickable select area of the node and to attach line ends right up to the 
image on all sides. 

We recommend this option be enabled. However, for some complex or detailed 
images, the approximation of the bounding shape may not be appropriate. In such 
cases you might want to uncheck this option while importing the graphic.

Non-fitted bounds Fitted bounds
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Scale imported graphics by

You can choose to scale all graphics that you import or drag-and-drop into your 
diagram. For example, if you set this to 200%, graphic images will be imported at 
twice their original size.

Options: Snap labels
The Snap labels category contains options affecting whether different types of text 
labels snap automatically into place, attaching to other objects when dragged or 
created near the “slot” areas of each type of label.

Snap labels to flow label slots

When this option is checked you can create and drag labels onto flow label slot areas 
and they will become flow labels. Flow label slot areas are located on either side of the 
point where a path attaches to a node. If this option is not checked, then the only way 
to create a flow label is to right click on the flow point and use the Add Flow Label 
feature.

Snap labels to in-line path label slots

When this option is checked you can create and drag labels onto in-line path label slot 
areas and they will become in-line path labels. In-line path label slot areas are 
anywhere in which the center of the label lies on the path. If this option is not checked, 
then the only way to create an in-line path label is to right click on the path and use the 
Add In-line Path Label Here feature.
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Snap labels to path label slots (lateral)

When this option is checked you can create and drag labels onto lateral path label slot 
areas and they will become lateral path labels. Lateral path label slot areas lie along the 
length of a path slightly above or below the path. If this option is not checked, then the 
only way to create a lateral path label is to right click on the path and use the Add 
Lateral Path Label Here feature.

Snap labels to node label slots

When this option is checked you can create and drag labels onto node label slot areas 
and they will become node labels. Node label slot areas are located in nine positions 
surrounding a node. If this option is not checked, then you can create a node label by 
selecting a node and a label and using the Attach Label to Node feature, or by using 
the auto-label style property.

Snap labels to node label primary position only

This option matters only when the Snap labels to node label slots option is set. If this 
option is set as well, labels will only snap to the single node label slot defined as the 
Primary Position in the Diagram Properties dialog box (Labels tab).

Options: Snap labels
The Snap labels category contains options affecting whether different types of text 
labels snap automatically into place, attaching to other objects when dragged or 
created near the “slot” areas of each type of label.
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Snap labels to flow label slots

When this option is checked you can create and drag labels onto flow label slot areas 
and they will become flow labels. Flow label slot areas are located on either side of the 
point where a path attaches to a node. If this option is not checked, then the only way 
to create a flow label is to right click on the flow point and use the Add Flow Label 
feature.

Snap labels to in-line path label slots

When this option is checked you can create and drag labels onto in-line path label slot 
areas and they will become in-line path labels. In-line path label slot areas are 
anywhere in which the center of the label lies on the path. If this option is not checked, 
then the only way to create an in-line path label is to right click on the path and use the 
Add In-line Path Label Here feature.

Snap labels to path label slots (lateral)

When this option is checked you can create and drag labels onto lateral path label slot 
areas and they will become lateral path labels. Lateral path label slot areas lie along the 
length of a path slightly above or below the path. If this option is not checked, then the 
only way to create a lateral path label is to right click on the path and use the Add 
Lateral Path Label Here feature.

Snap labels to node label slots

When this option is checked you can create and drag labels onto node label slot areas 
and they will become node labels. Node label slot areas are located in nine positions 
surrounding a node. If this option is not checked, then you can create a node label by 
selecting a node and a label and using the Attach Label to Node feature, or by using 
the auto-label style property.

Snap labels to node label primary position only

This option matters only when the Snap labels to node label slots option is set. If this 
option is set as well, labels will only snap to the single node label slot defined as the 
Primary Position in the Diagram Properties dialog box (Labels tab).
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Options: Arcs
The Fields category contains options controlling the editing of arcs.

Stretch method 

Select a method for stretching arcs, such as when dragging one end. The method 
controls how the arc shape changes as the end is moved. One method is to keep the 
original shape, another is to keep the original height, and another is to keep the original 
line length. Keep shape has the disadvantage that some arcs, especially those 
exceeding a half circle, can grow unmanageably large very easily. Keep length has the 
disadvantage that when stretching an arc it can quickly stretch into a straight line and 
will then require further adjustments. Keep height is the default because it provides a 
good compromise. Stretching to open or close a full circle loop is a special case 
compatible with any stretch method.
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Options: Copy node properties
The copy node properties category allows you to select which properties are included 
when using the Copy Properties feature between nodes.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 245 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



246 Chapter 16: Tools
Options: Copy label properties
The copy label properties category allows you to select which properties are included 
when using the Copy Properties feature between labels.
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Options: Copy path properties
The copy path properties category allows you to select which properties are included 
when using the Copy Properties feature between labels.
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Options: Zoom
The Zoom category contains options controlling the zoom features.

Set intervals

Although you can always to any magnification you choose, you can also set up six 
preferred magnifications for convenient use. These are the percentages that appear in 
the main menu and are used as stopping points when you press the plus and minus 
buttons on the tool bar or when you press the plus or minus keys on the keypad.

Enter any intervals you prefer. The valid range is from 10% to 300% though the upper 
range may vary based on your display. 

Screen size 

Provide the exact measurement (use a ruler) of the actual picture on your monitor from 
the top to the bottom. The default is set for a standard fourteen inch monitor.

The program needs to know this measurement so that it knows what 100% means. If 
you have this value set correctly and is set to 100%, you can actually measure the 
object on the screen and it will match its true size. This only affects the display, printed 
size is always correct.

Zoom step 

Set the step interval when zooming in or out using the Zoom-in key (keypad plus), 
Zoom-out key (keypad minus) or mouse wheel (with Ctrl pressed).
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Options: Colors
The Colors category contains options that affect the color of the display and the color 
palette used to select colors for diagram elements.

Page

The page color is the color of the background area of your diagram that falls within the 
boundaries of the page. You can choose any color you like. Because most paper is 
white, choosing white will most accurately represent the printed result.

Off page

The off page color is the color of the background area of your diagram that falls 
outside the boundaries of the page. You will usually want to avoid this area when you 
create your diagram.

Margins

Choose a color for the margins that is visible on top of the page color. The margins are 
drawn as dashed lines surrounding the edges of the page. If you select a color that 
cannot be drawn solid, Windows draws the margins in the nearest solid color.

Grid

Choose a color for the grid that is visible on top of the page color and the off page 
color. The grid color only applies if the grid is drawn as lines. If it is drawn as dots, the 
dots are always black. If you select a color that cannot be drawn solid, Windows draws 
the grid in the nearest solid color.
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Handles

The handles are the small squares that appear on the corners and edges of objects that 
you select. The color you choose is purely a personal preference. 

Reshape

Choose the color for reshape handles. 

Connection Points

Connection point indicators are small circles drawn only on the screen to identify the 
location of connection points within nodes. The color you choose is purely a personal 
preference. 

Restore Defaults

Press the Restore Defaults button to return all of the colors to their preset values.

Palette

Select from any of the pre-defined color palettes. The color palette provides a choice 
of colors available in color selection drop menus, in addition to the sixteen user-
defined colors saved with every diagram. Selecting a different palette will not 
immediately affect any colors in your diagram.

Options: Save
The Save category contains options for auto-save and auto-backup.
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Create backup file (.BAK) of previous revision whenever you save a diagram

When this box is checked, every time you save a diagram, the previous revision of the 
diagram is saved as a.BAK file in the same folder as the diagram file. For example, if 
you open the diagram MYCHART.EDG, edit it and save it, MYCHART.EDG will 
contain the latest changes you made and MYCHART.BAK will contain 
MYCHART.EDG as it was before you made any changes. If you later decide that you 
want to revert to the previous version, just open the .BAK file and Save As the original 
file name (such as MYCHART.EDG). Remember that each time you intentionally 
save your diagram, the.BAK file is updated. This includes any time that you save your 
diagram except for Autosaves (see below).

Autosave all open diagrams periodically

When this box is checked, the program will automatically save your diagrams every so 
often based on the value of “minutes between autosaves” which can be from 2 to 60. 
This feature is useful to minimize loss of data from power outages, computer crashes, 
or program bugs.

Autosave saves your diagram to disk as if you performed the Save All feature, that is to 
say that the file is written back to the same .EDG file that was opened. You don’t need 
to do anything special to regain your most recent diagram after a system failure. We 
recommend that if you use the Autosave feature you also use the backup feature so that 
if the Autosave feature accidentally saves changes that you didn’t like you can always 
go back to the version you last saved intentionally.
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CHAPTER
17 MANAGING FILES AND WINDOWS

A number of features are available from the File menu to perform file-level or system 
operations. These features allow you to load files (diagrams), save files, print files, and so 
on. This chapter describes each of these features and the features that manage the windows 
in which files are displayed.

Multiple Document Interface
This program supports the Microsoft Windows Multiple Document Interface standard also 
known by the abbreviation MDI. As a multiple document interface, this program allows 
you to open a number of different documents (in our case diagrams) simultaneously in 
different windows and to open multiple windows that view different parts of the same 
document. The MDI model is very powerful for working with several diagrams at once or 
for managing large or complex diagrams.

Whenever you create a new diagram or open an existing diagram as described in this 
chapter, a new window is created from which to view the diagram. You can have several 
such windows at a time. You can also create additional views of loaded diagrams and use 
the window arrangement commands to minimize, maximize, cascade, and tile all of the 
windows.

Managing Windows
You can use the following commands found in the Window menu to manage the 
arrangement of diagram windows. 

Cascade

Choose this command to arrange all of the non-minimized diagram windows so that they 
overlap one another and are offset slightly by the upper-right corners.

Tile

Choose this command to arrange all of the non-minimized diagram windows so that they 
are side-by-side filling the entire program area.

Arrange icons

Choose this command to automatically arrange the icons of all minimized windows.
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Creating a New Diagram
When you create a new diagram, you begin from one of the existing diagram 
templates that contain predefined node, path, and label styles. You can use one of the 
templates provided with the software or you can choose on that you saved yourself. 
When you choose NEW from the FILE menu, the following dialog box appears:

To create a new diagram from a diagram template
1. Choose New from the File menu.
2. Select a diagram template file (in the Template folder) from the Choose a 

Diagram Template dialog box. 
3. To conveniently set some initial options like object size and fonts, check the box 

indicating that wish to use the New Diagram Wizard to configure the diagram.
4. Click Open to create a diagram from the selected template.
5. If you chose to use the Wizard to configure the file, the New Diagram Wizard will 

appear (see the following section).
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 254 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



New Diagram Wizard 255
New Diagram Wizard
The final step when creating a new diagram is using the New Diagram Wizard to 
conveniently select options for the diagram. The wizard appears after you have chosen 
the template for your new diagram. Use the wizard to select options from those that are 
available for the template you have chosen. Possible options include color scheme, 
diagram size, font, font size, and so on. 

Template Variants
The first options that the wizard presents are known as variants, predefined template 
variations that provide choices of color schemes, diagram sizes, and so on. When you 
are viewing variants, a preview will help display your choice. Variants are carefully 
crafted by diagram designers to provide functional and attractive diagrams. They are 
available for many of the common diagram types.

Color Scheme

Choose a predefined initial color scheme (if available) and click Next. The colors are 
chosen to be attractive and clear when printed. The colors visible on your monitor can 
be darker or lighter than those that are printed, so it is possible for some color schemes 
to be less than ideal for the screen. Lighter color schemes are usually the best all 
around. The color scheme you choose will be remembered when you create future 
diagrams using the same template.
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Diagram Size

Choose a predefined diagram size to control how large or small the objects in your 
diagram appear. The predefined sizes are designed to be clearest when printed. The 
smallest size is just large enough to read comfortably. Larger sizes are easier to read 
but limit the amount of information you can fit on a page. It is possible to adjust sizes 
later, but setting sizes later for each style is far more difficult. The size you choose will 
be remembered when you create future diagrams using the same template.

Effects
An additional screen of the New Diagram Wizard permits you to add some optional 
shadow and fill effects to the new diagram. Choose from among the presets available 
for drop shadows and gradient fills. 
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Template Overrides
Additional wizard options are available for all diagram templates. These options 
appear on the final page of the diagram wizard and currently control text appearance 
and formatting.

Font

You may choose to select a special font for your diagram. If you leave this “<As Is>” it 
will use the fonts as they are defined in the diagram template. Templates are defined 
with a common font that can be assumed to be present on every computer, usually 
Arial or Times. You can choose a custom font here with one step. If you choose to 
change the diagram font using the wizard, the new font will be used everywhere in the 
diagram unless you change it later for particular styles or objects. For example, if you 
saved a custom template using many different fonts but select a font from the wizard 
rather than “<As Is>”, the wizard-selected font will be substituted for all of your 
custom fonts in the new diagram.

Font Size

You may choose slightly larger or smaller font sizes in your diagram than are defined 
in the diagram template. If you leave this field “<As Is>” the font sizes used are those 
chosen to be optimal by the designer of the template. However, if you have a diagram 
that requires especially large or small text you can adjust it here. Note that small 
increments (a point size or two) are usually enough. Also note that if you choose a font 
size increment other than “<As Is>”, ALL font sizes in the new diagram will adjust 
accordingly.
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Line Spacing

By default text lines are single spaced. However, you may choose to space lines closer 
together to squeeze more text per shape, or further apart for easier reading. Several 
options are available. These can easily be changed later from within the Diagram 
Properties dialog box.

Wrap

Most diagram templates are defined such that shapes automatically expand when you 
type more text than can fit on a line within the confines of the shape. If you prefer to 
use automatic word wrap, check this box.

Creating Custom Templates
When you create a new diagram, you start from a diagram template that contains an 
initial set of styles and diagram properties. In addition to the templates that come with 
the program, you can create custom templates to save diagram types you design.

Templates are similar to saved diagram files. The only difference is that when you 
open them as a template (the New command) any actual objects saved in the diagram 
are ignored. When you create a new diagram by choosing New from the File menu, 
you can choose any diagram template located in the Template folder. Therefore, all 
you have to do to create your own diagram template is to copy a diagram to this folder. 
In fact, you can open any existing diagram using the New command and it will be used 
as a template to create a blank copy of a new untitled diagram.

However, to further simplify the process of saving the diagram you are working on as 
a template for future diagrams, the program has a Save Template feature.

Save Template

The Save Template feature saves the open diagram as a template for use as the starting 
point for new diagrams. Once you save a diagram as a template, it will be available as 
a new diagram type the next time you use the New command.

To create a custom diagram template
1. Create a custom diagram with all of your own styles and diagram properties.
2. Choose Save Template from the File menu.
3. Select a file name for your template. We recommend that you save templates with 

your own name rather than updating the original templates. This will insure that 
they don’t get over-written the next time you upgrade.

4. If you do update an existing template, you will be asked whether to keep the 
existing preview from the old file. This is often a good idea. The alternative is to 
include diagram objects in your file so that a new preview will be generated.
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5. The next time you create a new diagram, you can choose your custom template as 
the starting point.

Opening an Existing Diagram
All of the following methods open an existing file and create a new window to view 
the diagram. The Open File dialog box looks like this:

To open a diagram that was previously saved
1. Choose Open from the File menu. 
2. Select the file that contains the diagram. You can select multiple files to open 

simultaneously by holding down the shift and control keys and clicking on 
additional files.

If the file is one of the four that you most recently used, you can open it more 
conveniently.

To open a recently used diagram
Choose the diagram by filename from the File menu.

To open a file by dragging and dropping from the File Manager or 
Explorer
In the Windows File Manager or Explorer, select a single diagram file or a number of 
files and drag them on top of the program icon or the running program. Release the 
mouse button and the diagrams will be opened and ready for editing.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 259 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



260 Chapter 17: Managing Files and Windows
Opening an Additional View of a Diagram

To open a new window for an open diagram
1. If you have multiple diagrams open, make sure the one that you want another 

view of is active.
2. From the Window menu, choose New Window.
A new window will be created with an identical view of the diagram. You can now 
scroll, zoom, and edit the same diagram through two independent views. You can even 
drag objects from one view of the diagram to another, something that you cannot do 
between views of different diagrams.

Saving a Diagram

To save changes to a diagram
If the diagram already has a file name and you want to save your changes back to the 
same file, simply choose Save from the File menu.

To save changes to all open diagrams
You can choose Save All from the File menu to save all your open files to disk with 
one command.

To save a diagram to a file
If the diagram is new and has never been saved to a file, or to save a diagram to a 
different file, choose Save As from the File menu and select the file name.

NOTE: Autosave and autobackup also affect how files are saved, backed up, and 
recovered.

Reverting to the Last Saved Version
At any time while editing a diagram you can choose to revert back to the last saved 
version of the file. Doing so will abandon all of the changes you have made since 
opening the file, or the last time you saved it. You will be prompted to confirm that 
you really do want to revert the file.

NOTE: Use this feature with caution. It cannot be undone! Be especially careful if 
you have multiple open files, that you revert the right one. If you have any 
hesitancy, we suggest you avoid using this feature altogether.
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To revert to the last saved version of a diagram
1. Choose Revert from the File menu. There is no shortcut key intentionally.
2. Read the warning carefully to be sure you are reverting the correct diagram and 

click OK to confirm.
Once reverted, the changes you made since the last save are permanently lost and there 
is no way to recover them. A safer alternative is to Save As to a different filename, 
then re-open the original file using File Open. You will then have the option of 
recovering your changes by simply re-opening the Save As file.

Saving as an HTML Web Page
You can save a diagram as an HTML web page. The HTML source consists of a 
number of files within a destination folder that you upload to your web server to make 
your diagram visible (and optionally navigable) to anyone with a web browser. If your 
diagram contains multiple sheets, only the active sheet is exported.

To save a diagram as a simple web page in HTML
Choose Save HTML from the File menu. Use the Save HTML dialog box to select 
options:
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Folder

Select a folder where generated files should be stored. Multiple files will be generated 
in this folder so it is best to select a new folder or an existing empty folder. The files 
that are generated are named for the diagram file for which they correspond. For 
example, if you open MYFILE.EDG and save it as HTML, the generated files might 
be MYFILE.HTM for the web page and MYFILE.JPG for the image.

Template

Select a template file to define the format of the resulting HTML page. The template 
file is required. You can use either the Default.htm supplied with the software or a file 
of your own creation (see  Creating an HTML Template on page 264). 

Scale

Use this control to select image size as a percentage of “true” size. The true size is the 
size that is shown by the rulers within your diagram. 

Format

Use this control to select a graphic image format. Select from JPG (JPEG), GIF 
(Graphics Interchange Format), or PNG. GIF is limited to 256 colors which may cause 
your diagram colors to be altered. JPG, on the other hand, handles 24-bit color and is 
more highly compressed. The amount of compression of a JPG image is controlled by 
the 'Quality' setting below. When JPG output is highly compressed (low quality), the 
image will become increasingly blurred or jagged. This is especially true around the 
edges of text. For truest color and the least distortion, use JPG at 100% quality. PNG 
combines the 24-bit color of JPG with good compression and typically less distortion 
than JPG.

Quality

This option is available only for JPEG images. Use this control to select a quality level 
for JPEG images. The quality can range from 10 (lowest) to 100 (highest). Highest 
quality images best represent the original but they are also require the largest file size. 
The default is 85% which produces a reasonable file size but a very good image.

Background

Select a background color for the image. Don’t confuse this color with the page color 
(set in Tools Options) that controls the appearance of your diagram workspace.

Anti-alias (smooth)

Check this option to apply anti-aliasing (smoothing) to the generated web graphics. 
Anti-aliasing removes the jagged lines and drop-outs that result from rendering a 
diagram on a low resolution bitmap. It is especially superior when scaling down the 
diagram under 100% and when creating bitmaps for display on the screen, such as web 
page graphics. Anti-aliasing is available only when creating the web page with full 
color bitmap formats (JPG and PNG but not GIF). 
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Include links - Diagrams (as web pages)

Check this option to include links from the image to hyperlinked diagrams (as an 
HTML image map), and to generate the linked diagrams as web pages. For example, if 
your diagram contains hyperlinks from symbols to other diagrams and this option is 
not checked, only one web page and one image will be created. However, if you check 
this option, the hyperlinks will be included in the original page as HTML links. Also 
the hyperlinked diagram will be saved as a web page in this same folder, as well as all 
other diagrams that it is linked to and so on. By checking this option, you can save a 
hierarchy of hyperlinked diagrams as an equivalent hierarchy of linked web pages.

Include links - Web URLS

Check this option to include links to web URL hyperlinks in your diagram as HTML 
links in the saved web page (as an HTML image map). A web URL hyperlink is one 
that you have linked to a external web page or other resources on the internet. 

Include links - Documents

Check this option to include links to documents in your diagram as HTML links in the 
saved web page (as an HTML image map). A hyperlink is considered a document if it 
is linked to anything other than another diagram or a web URL. Normally a document 
is a file located on your computer such as a spreadsheet that you want to open when a 
user clicks on a symbol in a diagram. When you check this option and your diagram 
contains document links, a copy of the document is added to the save folder to later be 
uploaded to your server with the rest of the web page files.

File Extension

Select a file extension for the web page (HTML) files. The default is “htm”.

The web page will consist of (at least) two files, an HTML file and an image file 

referenced from within the HTML file. Upload all the files that were created to the 
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same folder on your web server or adjust them as needed. Click on View Web Page to 
inspect the result by opening the main HTML page in your browser. Note the your web 
page will not be visible to others until you upload the files to a web server.

Creating an HTML Template
When saving your diagram as an HTML web page from the Save HTML screen, a 
template file is required that defines how the HTML page will be composed. A default 
file named Default.htm located in the HTML folder is provided for simple cases. 
However you can also create your own custom HTML template to control exactly how 
your exported HTML pages appear.

It's best not to simply edit the Default.htm file because then you will lose your changes 
next time you upgrade the software. Instead, you can create your own template file, 
perhaps by simply copying Default.htm and editing it with an ordinary text editor. You 
may locate your custom templates in the HTML folder where Default.htm is located.

Substitution Macros
You can include substitution macros in your template file and they will be replaced by 
values determined by the software as the HTML gets created. For example, you can 
designate exactly where in your template the diagram content should be inserted, or 
you can choose to insert the date and time, or you could use the name of the file

as the title. Macros are simply short text strings beginning with a macro delimiter 
(dollar sign). Following is a list of supported macros. See Default.htm for example 
usage.

$PATHNAME
Substitute the full path of the diagram file such as "c:\folder\filename.edg".

$FILENAME
Substitute the full file name of the diagram file such as "filename.edg".

$FILENAMENOEXT
Substitute the file name of the diagram file excluding the file extension such as 
"filename".

$DATELONG
Substitute the long format date such as "January 14, 2007".

$DATESHORT
Substitute the short format date such as "01/14/07".
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$DATEABBREV
Substitute the abbreviated date such as "14-JAN-07".

$TIMESTAMP
Substitute a time/date time stamp in a format suited to the locale such as "01/14/07 
12:34:09AM".

$TIME
Substitute the time of day such as "12:15 PM".

$GENERATOR
Substitute the program name and version number (of this program) that is generating 
the HTML code such as "Pacestar UML Diagrammer v5.08.1830".

$CONTENT
Substitute the diagram content. This macro is the only one that MUST be included in 
the template. It should located within the <body> block and on a line of its own. It will 
be replaced by an <img> block in the case of a simple diagram without any included 
internal links, or by a combination of an <img> and a <map> block in the case of a 
more complex diagram.

Style Class
You cannot customize the composition of the content (<img> and optional <map> 
blocks) that are substituted for $CONTENT. However, the <img> block will contain a 
CSS (Cascading Style Sheet) class designator in the form class="pacestardiagram". 
You can therefore include a style definition such as "img.pacestardiagram" either in 
the head of the template or in an externally included css file. This will allow you to use 
the template file to more precisely control the appearance of the diagram image. For 
example, you could add a border around the image. See Default.htm for a very simple 
example.
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Page Setup
The page setup area helps you layout your diagram for printing and display. You can 
control paper size, page orientation, and postering. You can change the page layout at 
any point. However, to minimize the amount of re-organizing of your diagram, it’s 
usually best to setup the page layout before constructing your diagram.

Poster layouts
An important concept to understand when setting up your page layout is postering. 
When the page defined for a diagram is larger than the paper size set for your printer, 
the diagram will be divided into multiple pages for the purpose of printing. Therefore 
you can choose a larger page size than can be printed on your printer simply by 
increasing the page height and width and leaving the poster grid (rows and columns) 
set to one. The division into multiple pages is highly dependent on the printer, even if 
the paper size is unchanged. Therefore the use of a large page size with rows and 
columns set to one is best for diagrams that are not designed with the locations of page 
divisions in mind. For example, this would be best for laying out a large continuous 
complex diagram such as the one shown below on the left.

You may also choose to layout your diagram as an actual poster. To do so, choose a 
standard paper size that will be available on any printer to which the diagram will be 
printed in the future (such as letter size), and then increase rows and/or columns as 
necessary to create a grid of such pages to comprise your poster layout. The page size 
you choose when rows and columns are larger than one must fit onto the paper size 
you print to! Use this technique when the layout of your diagram is specifically 
divided into multiple pages and the position of the page divisions within your diagram 
must be maintained when printing. For example, if you design a complex diagram with 
multiple pages in mind, such as shown below on the right, use a standard paper size 
and increase rows and columns as needed to add pages. This will assure that the page 
divisions shown in the diagramming screen will accurately reflect paper boundaries 
when printed on different printers (if at all possible).
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Choose Page Setup from the File menu. Use the Page Setup dialog box to change the 
page layout:

Paper Size

Select a page size from the standard page sizes available. The sizes listed are not 
necessarily all available on your current printer. If you intend to use poster layout 
(more than one row or column), be sure to choose a page size that matches a paper size 
available on your printer and on any printer you anticipate printing on in the future.

Width and Height

The height and width boxes display the exact size of the paper you have selected. 
These are for display purpose only.

Poster

If your diagram is too large to fit on one sheet of paper that your printer can print, you 
may choose to use postering to spread your design onto a grid of pages. Choose the 
number of rows and columns of pages for your diagram. (the maximum number is 
limited to a total of about 62 inches by 62 inches depending on the paper size). Select 
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“Print crop marks” to print guides in the corners of each printed page indicating where 
they should be cut in order to be joined into a continuous poster.

Margins

Margins are displayed to show the extents of the printable portion of the page. The 
margins are for display purposes only. Use the margins to guide where on the page you 
place objects. Objects placed outside the margins will be truncated or not print at all.

Minimum (stitching margin)

Use this control to set the minimum size of margins. This is also the margin width used 
for stitching together multiple pages when the diagram cannot be printed on a single 
page. 

Choose the minimum margin carefully. The value should be at least as large as the 
smallest margin supported by any printer you anticipate using. If you select too small a 
minimum, you run the risk when printing a multi-page diagram, that the page break 
locations and possibly the combined page size will be different for each printer. In that 
case, changing the printer set-up may cause your diagram’s page layout to change and 
possibly require manual adjustment of the contents. A diagram’s page layout will 
remain consistent unless it is required to be adjusted for a printer setting that cannot 
support the minimum margin. Note that for diagrams that span multiple printed pages, 
a layout change may be necessary based on the value of the minimum margin alone 
even if the four margins you set are all valid for the printer.

Portrait and Landscape

Use the portrait and landscape controls to choose page orientation. There’s no need to 
rotate objects to print width-wise or “landscape” on a page - this is done automatically 
when the page is printed.

Sheets
All of the above pertains to a single sheet in a diagram. A diagram may have multiple 
sheets each set up identically as described above. 

The printed page 

Crop marks at each corner. 
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Printing
Printing diagrams is similar to printing in any other Windows program. 

To print a diagram
1. Use Print Setup to make sure that your printer is set up properly with the correct 

paper and so on. You do not need to set-up your printer each time you print.
2. Choose Print from the File menu.
3. Choose the options you want in the Print dialog box then press OK.
When you print a diagram that has more than one page, you can select a range of pages 
to print rather than printing the whole diagram. Page numbering is from left to right 
and top to bottom. The following illustration shows page numbering for a two row by 
three column poster.

A diagram can also have multiple sheets. Each sheet may be divided as above. Page 
numbering continues as shown, repeating for each sheet. The Print screen also contains 
an option to print only the current sheet.

To print all open diagrams
You can choose Print All from the File menu to print all your open diagrams with one 
command.

Object Linking and Embedding (OLE)
This program supports Microsoft’s Object Linking and Embedding specification 
version 2.0. OLE (oh-lay) as it is commonly called, makes it simple and convenient to 
insert or embed diagrams within documents created by other applications which can 
serve as OLE containers. 

Microsoft Word™ is one example of a very popular application that exploits the ability 
to be an OLE container. Throughout this section, we’ll refer to Word as a typical OLE 
container application. But don’t forget that there are MANY such applications on the 
market and all will work more or less the same with this program’s OLE features. 

Using OLE, you can embed diagrams directly inside Word documents such that they 
become a part of the document, are saved within the document file, and nevertheless 
can later still be edited. In addition, you can choose to store only a reference called a 

1 2 3

4 5 6
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link to a diagram file within Word. With a link, you can simply edit the diagram file 
and the changes will automatically appear in the Word document. Linking and 
embedding together provide the capability to use diagrams anywhere that a diagram 
would be convenient without the hassle of having to store and maintain the diagram 
elsewhere at the same time.

This program acts as an OLE Server, not as a container like Word. It is a full server as 
opposed to a mini-server because it can also run stand-alone as a normal application.

OLE embedding diagrams
A diagram can be embedded into a document created by an application like Microsoft 
Word™. When a diagram is embedded in a document, it becomes part of the document 
but remains a complete diagram that can later be edited and updated. 

To insert a new diagram into a Word (or similar) document
1. From Microsoft Word, choose Object from the Insert menu.
2. Choose the Create New tab.
3. From the types list, choose UML Diagram.
4. Follow the procedure to create a new diagram (see  Creating a New Diagram on 

page 254).
5. When the diagram is complete, choose Exit & Return to Document from the File 

menu.
6. Resize the resulting diagram if you like.

To insert a copy of an existing diagram into a Word (or similar) document
1. From Microsoft Word, choose Object from the Insert menu.
2. Choose the Create From File tab.
3. Select the name of the diagram file.
4. Resize the resulting diagram if you choose.

To embed a portion of a diagram into a Word document
1. Open any diagram file.
2. Select the portion of the diagram that you’d like to embed in the Word document 

(see  Selecting and Deselecting Objects on page 27).
3. Choose Copy or Cut from the Edit menu.
4. In Word, choose Paste from the Edit menu.
5. Resize the resulting diagram if you like.
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OLE linking to diagrams
A diagram can be linked to a document created by an application like Microsoft 
Word™. When a diagram is linked in a document, it remains a separate diagram file 
and a reference or link is saved in the document. If you later make changes to the 
diagram, those changes will be reflected automatically in the document that contains 
the link.

To insert a link to a diagram into a Word document
1. Create a diagram in the usual way (see  Creating a New Diagram on page 254).
2. Save the diagram to a file.
3. In Word, choose Object from the Insert menu.
4. Choose the Create from File tab.
5. Check the Link to File box.
6. Select the name of the diagram file.
7. Resize the resulting diagram if you choose.
When an OLE document contains links to diagrams or other OLE objects, those 
objects must remain in place when the document is used. If you delete a diagram that is 
referenced from an OLE document, the reference will not know where to find the 
diagram. Likewise, if you copy the document that contains the link, you should also 
copy the linked diagrams so that the links remain valid.

Exiting 

To exit 
1. Choose Exit from the File menu.

Other standard Windows methods of exiting programs work also, such as pressing 
ALT-F4 or choosing Close from the System menu.

2. If your diagram contains changes that have not been saved, you will be prompted 
to save them before exiting.
 Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide

Page 271 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



272 Chapter 17: Managing Files and Windows
Pacestar UML Diagrammer User’s Guide

EDGE Diagrammer User’s Guide - Beta Version

Page 272 of 272

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.man



273
Index
A
active container 80, 162
active containers 64
add flow label 138
add node label 134
add path label here 131
adding a page 45
adding a sheet 45
aligning nodes 56
ANSI code 144
antialias 216
apply color scheme 216
arc 95
arc stretch method 244, 245, 246, 247
arcs 244, 245, 246, 247
aspect ratio 80, 123, 162
associations 132
attach label to node 135
attach method 88

centers 88
click point 88
freeform 88

attaching
flow labels 138
node labels 135
nodes to flows 66
path labels 131
specialty labels 128

auto backup 229
auto save 229
auto-label 136
auto-label (paths) 195
Autosave 251
autoscroll 41

B
back 28
back hyperlink 210
back one 29

background 203
background color

exported bitmaps 216
backspace 143, 146
backups 229
BAK files 251
beginning of line 143, 146
beginning of text 143, 146
beveled 105
bind to style 70, 119, 153, 175
blend 81, 163
border (node property) 153
border color 70, 153
borders (of paths) 108, 192

C
categories 51
center on grid when snap 78, 123, 160, 178
center on page 58
center stationary when resizing horizontally 79, 123, 

161, 179
center stationary when resizing vertically 79, 123, 

161, 179
centers (attach method) 88
centimeters 231
changing node size 53
changing the active page 46
changing the active sheet 46
chevrons 144
clearing 30
click point (attach method) 88
click select 28
clicking 13
clipboard 30, 32, 33, 34
close 271
color palette 250
color scheme 216
colors

custom 39
fill color 40
for tinting graphics 40, 214
for transparency 40

combo box 21
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commands (notation) 9
common style properties 149, 152
compartment 139
connect cursor 13
connect mode 25, 89
connect to another path 92
connect two nodes 91
connection point cursor 13
connection point mode 59
connection point tool 59
connection points

deleting 59
editing 59
moving 59
options 60
setting 59
temporary 88
use connection points option 88

containers 80, 162
active 64, 80, 162
keep objects together 64, 80, 162

context menu 14
copy properties 33, 245, 246, 247
copy-and-paste 32, 33
copying 31, 32
copying text 144
corner radius 221
corners (of path) 105
create mode 49
create one connector at a time 238
create one figure at a time 238
creating

flow labels 138
new diagram 254
node labels 134
nodes 49
nodes in flows 65
path labels 131
paths 89
specialty labels 127
unattached paths 91

crossovers 109, 194
CTRL key

connecting 91
creating nodes in flows 66
dragging a node 66
duplicating objects 32
freeform specialty labels 128

cursors 13
curvature (of path) 105
curved paths 94
custom diagram colors 39
custom template 258
custom zoom intervals 43
customize 224

style bar 224
toolbars 224

cut 270
cut-and-paste 32, 33
cutting objects 30
cutting text 144

D
date and time 146
decimal tab stops 84, 124, 167, 180
default tabs 85, 125, 167, 181
Default.htm 264
define label styles dialog box 171
define node styles dialog box 149
define path styles dialog box 185
delete key 143, 146
deleting 30

junctions 97
nodes from flows 67
objects 30
path labels 132
style 151, 173, 186
text 144

deleting a page 46
deleting a sheet 46
description (of style) 152, 174, 188
deselecting 27

deselect all 28
detach label 132
detaching

flow labels 138
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labels 128
node labels 136
nodes from flows 67
path labels 132
specialty labels 128

diagram
components 16
definition 14

diagram objects 16
diagram properties 218
diagram template 18, 254, 258
distributing evenly 57
document linking 207
dotted grid 237
drag scrolling 41
dragging 14, 35
drop menu 14, 20, 49, 50, 89
drop shadow 70, 153
duplicating 32

labels 32
nodes 32
paths 32

duplicating objects 32

E
edges snap to grid 78, 79, 123, 160, 161, 179
edit boxes 15
editing 27
editing text 141
elliptical gradient 81, 163
embedding diagrams 270
EMF 211
end of line 143, 146
end of text 143, 146
english 231
Enhanced metafiles 211
entire page (zoom) 42
ESC 143, 146
exiting 271
expand node 77, 122, 159, 163, 178
extending a text selection 142
extending selection 28

F
fields 146
file menu 253
file operations 253
fill 81, 163
fill color 40, 70, 153
find 36
find dialog box 36
find text 36
flipping paths 99
flow 109, 194
flow labels 112, 137

add flow label 138
attaching 138
creating 138
definition 17
detaching 138
illustration 17
slots 137

flow point 17, 112, 137
flow symbols 102, 106, 190
flows 65

attaching nodes within 66
creating nodes within 65
deleting nodes 67
detaching nodes 67

follow hyperlink 209
foreground 203
forward hyperlink 210
freeform 128

attach method 88
creating nodes in flows 66
creating paths 91
dragging a node 66
specialty labels 128

front 28
front one 29
full server (OLE) 270

G
gallery 52, 71

node symbols 168
terminators 193
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gradient fill 81, 163
graphic from clipboard 71
graphic from file 71
graphics

importing from files 211
pasting from clipboard 32

grid 23, 237
grid lines 237
groups 199, 239

aligning 201
breaking apart 200
centering on page 201
changing properties of members 201
connecting 202
creating 199
editing text 202
following hyperlinks 202
order of members 199
re-establishing 200
regroup 200
resizing 202
scaling 202
spacing evenly 201
ungrouping 200
ungrouping all 200

guided orthogonal paths 101
guillemets 144

H
handles 27
hard carriage returns 147
height (node property) 70, 119
height and width to grid when snap 78, 123, 160, 

178, 179
home 143, 146
hook-ups (for node labels) 134
HTML

saving as,exporting 261
HTML template 262, 264
hyperlinks 207

back 210
following 209
forward 210

open 209
opening 209
removing 208
setting for node 208
setting to URL 209
to file 271
to web page 209

I
importing

metafiles 211
importing graphics 211
inches 231
incremental zooming 44, 45, 46
in-line path labels 129
Insert Graphic 212
insert key 143, 146
insert symbol 52
inserting a node 52
inserting field text 146
inserting time and date 146
invalid characters 143, 146

J
jogs 99, 109, 194
joins 105
jumps (see jogs) 99
junctions 92

adding 97
creating 92
definition 17
deleting 30, 97
dragging 92
illustration 17

K
keep height (arcs) 244, 245, 246, 247
keep length (arcs) 244, 245, 246, 247
keep shape (arcs) 244, 245, 246, 247
keep sized to text 57
keyboard 143
keys 9
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L
label styles 18, 171
labels 111

copying 31
cutting 30
definition 17
deleting 30
detaching 128
dragging 35
editing text 141
illustration 17
moving 35
pasting 32, 33
rotating 140
selecting text 142
specialty labels 126
text 139

landscape 268
lasso cursor 13
lasso select 27
lateral path labels 130
layers 203
left 13
left (node property) 69, 104, 118
left and right edges snap to grid 78, 123, 160, 179
line too long 77, 122, 159, 178
linear gradient 81, 163
link to file 271
linking diagrams 207
linking to diagrams (OLE) 271
linking to documents 207

M
macros (HTML) 264
magnification 43
make same size 56
manual orthogonal paths 101
margins 268
MDI 253
measurements 15, 231
memo 86, 126
memotips 86, 126
menu bar 19

menus 9
message bar 19
metafiles 31

importing 211
metrics 231
Microsoft Word 269
mitered 105
model node 56
modes 20

connect mode 25, 89
connection point mode 59
node create mode 24
select mode 23
seltext mode 24
text mode 24
zoom mode 24, 42, 43

mouse
buttons 13
clicking 13
dragging 14
requirement 13

move cursor 13
moving 35

end of a path 98
nodes 55
path label 131
precise (nudge) 35
to the front or back 28

moving path labels 131
multiple document interface 253
multiple sheets 44, 45
multi-segment path 92

N
naming a page 46
naming a sheet 46
new 254
new node style dialog box 150, 172, 186
new style 150, 172, 186
node create mode 24
node labels 112, 132

add node label 134
as auto-labels 136
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attaching 135
creating 134
definition 17
detaching 136
hook-ups 134
illustration 17
re-positioning 135
slots 133

node properties 67
node properties dialog box 67
node style combo box 49
node style drop menu 49
node styles 18, 149
node symbol gallery 52, 71
nodes 49

adding text 140
aligning 56
centering on page 58
copying 31
creating 49
cutting 30
definition 16, 49
deleting 30
dragging 35, 55
duplicating 32
editing text 141
flows 65
illustration 16
inserting from gallery 52
making same size 56
moving 35, 55
moving precisely 35
nudging 35
pasting 32, 33
properties 67
selecting text 142
size 53
sizing 56
sizing to text 56
spacing evenly 57
styles 149
text 139

notes (notation) 9

nudge 35

O
object linking and embedding 269
object styles 17
objects 16
OLE 269

container 269
cut 270
embedding diagrams 270
full server 270
linking to diagrams 271
mini-server 270
paste 270
server 270

open 259
open hyperlink 209
opening an existing diagram 259
orthogonal 104
orthogonal paths 100

guided 101
manual 101

P
page layout 266
page orientation 266
page setup 266
page width (zoom) 42
pages

adding 45
changing 46
deleting 46
naming 46

palette 250
paper size 266
paragraph styles 17
paste properties, properties

copying 33
pasting 30, 32, 33, 270

graphics 32
paste as 33
text 33, 144

path labels 112, 129
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add path label here 131
attaching 131
copying 31
creating 131
cutting 30
definition 17, 139
deleting 30, 132
detaching 132
dragging 131
editing text 141
illustration 17, 139
in-line 129
lateral 130
moving 131
slots 129, 130
text 139

path styles 18, 185
paths

borders 108, 192
color 105, 189
connect to paths 92
copying 31
corners 105
creating 89
curved 94
cutting 30
definition 17, 87
deleting 30
flipping 99
guided orthogonal 101
illustration 17, 87
joins 105
manual orthogonal 101
moving 35
moving an end 98
orthogonal 100
pasting 32, 33
rounded 94
segments 92
smoothed 94
splitting 99
unattached 91

percentage zoom 43

pivot cursor 13
point measurements 15
points 232
portrait 268
poster 267
precise moving 35, 55
preserve aspect ratio 80, 123, 162
primary position 221, 242, 243
print 269

print all 269
properties 67

copying 245, 246, 247
node 67
overview 18
pasting 33

property bar 22, 52, 91, 115
illustration 19

Q
quality

JPG images 215
quality of JPG 262
quick copy 32
quit editing text 143, 146
quitting 271

R
Reapplying a label style 182
Reapplying a node style 170
Reapplying a path style 197
recover 229
remove hyperlink 208
rename styles 151, 172, 186
replace 36, 37
replace dialog box 37
replace text 36
re-positioning node labels 135
reshape 60
reshape cursor 13
resize cursor 13
resizing nodes 53
restore 229
revert 229, 260
Pacestar UML Diagrammer  User’s Guide

Pacestar UML Diagrammer  User’s Guide

Page 279 of 281

Last Modified August 7, 2009 1:09 pm

Filename: S:\UFLOW\DOC\wedge21.ix



280
right click menu 14
rotating text 140
rounded 105
rounded paths 94, 221
rulers 19

S
same size 56
save

save all 260
template 258

saving HTML web page 261
screen size 248
scroll bars 19, 41
search 36
segments 92, 99
select all 28
select cursor 13
select mode 23
selected objects (zoom) 42
selecting 27

click select 28
extending 28
lasso 27
select all 28
text 142

seltext mode 24
shading 81, 163
shadow 153
sheet bar 19
sheets 44, 45

adding 45
deleting 46
naming 46

shift key 56, 88
size of nodes 53
size to text 56
sizing nodes 56
sizing nodes to text 56
slots 127

flow labels 137
node labels 133
path labels 129, 130

smoothed paths 94
snap figures into flows option 239
snap gravity 88
snap grid 23
snap labels to flow label slots option 127, 138
snap labels to node label slots option 127, 134
snap labels to path label slots option 127, 131
snipping paths 98
soft carriage returns 147
space evenly 57
specialty labels 111, 126

attaching 128
creating 127
default text 128
detaching 128
flow labels 137
freeform 128
node labels 132
path labels 129
slots 127

split cursor 13
splitting paths 99
stamp (paths) 196
standard sizes 15
status bar 19
stetch method 244, 245, 246, 247
style bar 19, 20

customize 224
style bar buttons 21, 49, 154, 175
style combo box 21
style drop menu 20
style properties

common 149, 152
styles

creating new 150, 172, 186
definition 17
deleting 151, 173, 186
descriptions 152, 174, 188
labels 171
node 149
path 185

substitution macros (HTML) 264
symbols 167
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T
tab 143, 146
tabs 84, 124, 166, 180
template 258

saving 258
template - HTML, custom HTML 262, 264
terminator 87
terminator gallery 193
terminators 191, 193
text 139

adding to nodes 140
copying 144
cutting 144
deleting 144
editing 141
keyboard usage 143
pasting 144
rotating 140
selecting 142

text balloons 236
text color 70, 119, 153, 175
text cursor 13, 115
text fields 146
text mode 24
time and date 146
tinting 40, 214
title bar 19
too many lines 77, 122, 159
tool bar 19, 21
toolbar

customize 224
tooltip 21, 22
tooltips 86, 126, 236
top (node property) 70, 118
top and bottom edges snap to grid 79, 123, 161, 179
transparent symbols 40

U
unattached paths 91
undo 33

navigation 239
Ungroup All 200
URL (hyperlinks) 209

use connection points option 88

V
valid characters 143, 146
vertical text 140
vertices (path junctions) 92
visible grid 23

W
web page 261
web page (hyperlinks) 209
width (node property) 70, 119
Windows

clipboard 30, 32, 33, 34
metafiles 31

Windows metafiles 211
WMF 211
workspace 19

property bar 19

Z
zoom 42

all objects 42
directly to area 44, 45, 46, 47
entire page 42
incremental 44, 45, 46
intervals 43
page 44, 45, 46, 47
page width 42
rectangle 44, 45, 46, 47
selected objects 42

zoom cursor 13
zoom mode 24, 42, 43
zoom-in 42
zoom-out 42
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